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Preface

This preface contains the following topics:

• Preface

• About This Guide

• How This Guide Is Organized

• Documentation Conventions

Using the Documentation
The following table lists the tasks and concepts that are described in the iPlanet
Application Server manuals and Release Notes. If you are trying to accomplish a
specific task or learn more about a specific concept, refer to the appropriate
manual.

Note that the printed manuals are also available online in PDF and HTML format,
at: http://docs.sun.com/db?p=prod/s1appsrv.

For information about See the following Shipped with

Late-breaking information about the
software and the documentation

Release Notes Available on the
iPlanet Web site at
http://docs.sun
.com/db?p=prod/
s1appsrv
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Installing iPlanet Application Server and
its various components (Web Connector
plug-in, iPlanet Application Server
Administrator), and configuring the
sample applications

Installation Guide iPlanet Application
Server 6.5

Creating iPlanet Application Server 6.5
applications that follow the open Java
standards model (Servlets, EJBs, JSPs,
and JDBC), by performing the following
tasks:

• Creating the presentation and
execution layers of an application

• Placing discrete pieces of business
logic and entities into Enterprise Java
Bean (EJB) components

• Using JDBC to communicate with
databases

• Using iterative testing, debugging,
and application fine-tuning
procedures to generate applications
that execute correctly and quickly

Developer’s Guide
(Java)

iPlanet Application
Server 6.5

For information about See the following Shipped with
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Administering one or more application
servers using the iPlanet Application
Server Administrator Tool to perform
the following tasks:

• Monitoring and logging server
activity

• Implementing security for iPlanet
Application Server

• Enabling high availability of server
resources

• Configuring web-connector plugin

• Administering database connectivity

• Administering transactions

• Configuring multiple servers

• Administering multiple-server
applications

• Load balancing servers

• Managing distributed data
synchronization

• Setting up iPlanet Application Server
for development

Administrator’s Guide iPlanet Application
Server 6.5

Migrating your applications to the new
iPlanet Application Server 6.5
programming model from the Netscape
Application Server version 2.1,
including a sample migration of an
Online Bank application provided with
iPlanet Application Server

Migration Guide iPlanet Application
Server 6.5

Using the public classes and interfaces,
and their methods in the iPlanet
Application Server class library to write
C++ applications

Server Foundation
Class Reference (C++)

Order separately

For information about See the following Shipped with
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About This Guide
The Administrator’s Guide guide leads you through the tasks that you perform as
the administrator of one or more iPlanet Application Server machines. This guide
assumes that you have installed iPlanet Application Server on at least one machine.
For information about installing iPlanet Application Server, refer to the Installation
Guide.

You perform most of the administration tasks with iPlanet Application Server
Administration Tool, a GUI-based tool for server and application administration.
This tool is described in About iPlanet Application Server Administration Tool
(iASAT).

How This Guide Is Organized
This guide is divided into three parts. If you are new to administering an iPlanet
Application Server machine, begin with Part I, Getting Started for an overview of
how to start the server and Administration Tool. If you are already familiar with
administering application servers, skim Part I, before going on to Part II,
Administering a Single iPlanet Application Server.

If you are administering more than one application server, continue to Part III,
Administering Multiple iPlanet Application Servers, for additional,
multiple-server enterprise specific information.

Part I: Getting Started
The first part of the Administrator’s Guide describes the environment of iPlanet
Application Server.

The following chapter is included in this part:

• Chapter 1, “Performing Basic Administrative Tasks describes how to get
started with iPlanet Application Server Administration Tool, as well as the
basic iPlanet Application Server configuration tasks that you can perform.
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Part II: Administering a Single iPlanet Application
Server
The second part of the Administrator’s Guide describes server and application
administration procedures for a single iPlanet Application Server machine.

The following chapters are included in this part:

• Chapter 2, “Monitoring Server Activity describes the monitoring service that
allows you to chart various attributes of the Executive, Java, and C++ server
processes.

• Chapter 3, “Configuring SNMP to Monitor iPlanet Application Server with
Third-Party Tools describes how to configure Simple Network Management
Protocol (SNMP) so you can monitor iPlanet Application Server with a
third-party SNMP management tool.

• Chapter 4, “Logging Server Messages describes the message-logging service
provided by iPlanet Application Server.

• Chapter 5, “Securing iPlanet Application Server describes how to set up users
and groups to provide security for your applications.

• Chapter 6, “Enabling High Availability of Server Resources describes how you
can increase application performance.

• Chapter 7, “Configuring the Web Connector Plug-In describes the web
connector plug-in, which sends users’ requests to applications residing on
iPlanet Application Server.

• Chapter 8, “Administering Database Connectivity describes how to configure
data access drivers and apply settings to database connectivity parameters.

• Chapter 9, “Administering Transactions describes the tasks and conceptual
information necessary for administering transactions using iPlanet Application
Server Administration Tool.

• Chapter 10, “Enabling Support For Corba-Based Clients describes how to
configure RMI/IIOP ORB for Corba elements, using the existing JavaSoft ORB
and a third-party ORB called ORBIX2000.

• Chapter 11, “Administering Message Driven Beans describes how to configure
a JMS Provider and administer Message Driven Beans support.
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Part III: Administering Multiple iPlanet
Application Servers
The third part of the Administrator’s Guide describes how to administer multiple
iPlanet Application Server machines. More in-depth administration procedures
and concepts that apply to a multiple-server enterprise have been included. These
procedures focus solely on multiple-server administration, and are used along
with the single-server procedures described in Part II.

The following chapters are included in this part:

• Chapter 12, “Configuring Multiple Servers describes how to configure the web
connector plug-in, distributed data synchronization, and multicast
communication for multiple iPlanet Application Server machines, using
iPlanet Application Server Administration Tool.

• Chapter 13, “Administering Multi-Server Applications describes how to
maintain multiple iPlanet Application Server machines at the same time using
iPlanet Application Server Administration Tool.

• Chapter 14, “Balancing User-Request Loads describes load balancing, which
optimizes the ability of each iPlanet Application Server machine to process
users’ requests by keeping those requests balanced among several application
servers.

• Chapter 15, “Managing Distributed Data Synchronization describes how to
group iPlanet Application Server machines into data synchronization clusters.

• Chapter 16, “Setting Up iPlanet Application Server for Development describes
how to set up iPlanet Application Server for the purpose of developing
applications. This section would be of special interest to developers.

• Appendix A, “Troubleshooting contains troubleshooting information about
your iPlanet Application Server machine.

Documentation Conventions
This guide uses the following documentation conventions:
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Table  1

Conventions Description

File and directory paths Windows: Directory path names are separated using
Backslashes. For example, Images\Screens\ser.gif.

Solaris: The directory paths are separated using forward
slashes. For example, Images/Screens/ser.gif.

Menu options Second level menu options are separated by the ‘greater than’
symbol (>). For example, invoking an application from the
Start menu in Windows is described this way:

From the Start menu, choose Programs>iPlanet Application
Server 6.5. Then select iPlanet Administration Tool.

URLs This guide uses URLs of the form:

http://server.domain:port/path/file.html

Where,

• server is the name of server on which you run your
application

• domain is your Internet domain name

• path is the directory structure on the server

• file is an individual filename.

Note: Italicized items in URLs are placeholders.

Fonts The monospace font is used for:

• sample code and code listings

• API and language elements (such as function names and
class names)

• file names, path names, directory names, and HTML tags.
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URLs This guide uses URLs of the form:

http://server.domain:port/path/file.html

Where,

• server is the name of server on which you run your
application

• domain is your Internet domain name

• path is the directory structure on the server

• file is an individual filename.

Note: Italicized items in URLs are placeholders.

Fonts The monospace font is used for:

• sample code and code listings

• API and language elements (such as function names and
class names)

• file names, path names, directory names, and HTML tags.

Italic type is used for:

• book titles

• variables and placeholders
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Part 1

Getting Started

Chapter 1, “Performing Basic Administrative Tasks
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Chapter 1

Performing Basic Administrative
Tasks

This chapter describes how to administer iPlanet Application Server, using iPlanet
Application Server Administration Tool (iASAT), iPlanet Registry Editor and
command line tools.

This chapter also covers the basic iPlanet Application Server configuration tasks
you can perform using iPlanet Application Server Administration Tool (iASAT),
various command line tools and iPlanet Registry Editor.

The basic administrative and configuration tasks that you can perform using
iASAT, command-line tools and iPlanet Registry Editor are divided into the
following topics:

• About iPlanet Application Server Administration Tool (iASAT)

• Performing Administrative Tasks Using iASAT

• About Command-Line Tools

• Using Command-Line Tools

• Performing Administrative Tasks Using Command-Line Tools

• Environment Variable Setting on Solaris

• About iPlanet Registry Editor

• Configuring Multiple LDAP Domains
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About iPlanet Application Server Administration
Tool (iASAT)

iPlanet Application Server Administration Tool (iASAT) is a stand-alone Java
application with a graphical user interface that allows you to administer one or
more instances of iPlanet Application Server. iPlanet Application Server
administration involves performance-related tasks such as adjusting database
connection threads and load-balancing parameters. Server administrators must
also separately configure components that the application server uses, including
the web server.

You also use iASAT to administer application components. You can group, enable
and partition Application components using iASAT, to achieve better performance.
Application components, the core of an iPlanet Application Server application, are
contained in code and stored on the application server. Enterprise Java Beans
(EJBs), servlets, JavaServer Pages (JSPs), and AppLogic objects are all application
components. For more information about each of these, refer to the Developer’s
Guide.

Administrative tasks are performed using iASAT. When iASAT is opened to the
default General window, the toolbar, main window with left and right panels, and
the menu bar are shown as illustrated in the following figure:
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The left panel of the main window displays all iPlanet Application Servers
registered with iASAT. The right panel displays individual features of the
registered iPlanet Application Servers.

To Start iASAT
To administer one or more iPlanet Application Server machines, start iASAT using
one of the following ways:

• On Windows: From the Start menu, choose Programs> iPlanet Application

Server 6.5> iPlanet Application Server Administration Tool.

• On a Solaris system: Open a Terminal window and navigate to the path
<iASInstallDir>/ias/bin/ and type the following at the command prompt:

ksvradmin &
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Performing Administrative Tasks Using iASAT
This section describes the concepts and tasks associated with using iASAT. The
following topics are included in this section:

• To Register an iPlanet Application Server

• To Unregister an iPlanet Application Server

• To Start and Stop a Server Using iASAT

To Register an iPlanet Application Server
Registering an iPlanet Application Server adds that server to the scope of the
Administration Tool. This is best done after you add a server or a group of servers
to the enterprise’s network.

When you install iPlanet Application Server, the local host is automatically
registered with iASAT.

To register an iPlanet Application Server machine, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. From the File menu, click New>Server.

The New iPlanet Application Server dialog box appears.

NOTE iPlanet Application Server must be registered with iASAT, before
you can administer it.



Performing Administrative Tasks Using iASAT

Chapter 1 Performing Basic Administrative Tasks 25

3. Complete one of the following:

❍ In the Name text box, specify the name of the server.

This is an arbitrary name you use to distinguish one application server
from another. For example, Prod-Node-A. More application servers can be
configured, such as, Prod-Node-B, Dev-Node, etc.

❍ Click Local Host to register a server running on your local machine.

This automatically enters a server name and your machine name.

4. In the Host text box, specify the host name of the server.

This is the DNS name of your server machine. You can also use an IP address.

5. In the Port text box, specify the port number of the Administration Server. In a
default installation, this port is set to 10817.

6. If you are registering your local host, in the User Name and Password text
boxes, specify the user name and password you entered during installation of
the server or when modifying the Users and Groups.

If the server that you are registering is not the local host, then you need to
provide the user name and login password of the machine you want to add.
For example, to register a machine called Solo that is available on your
network, you need to provide the user name and password of Solo in the User
Name and Password text boxes.

7. (Optional) To always connect to this server and display it in the
Administration Tool window, select the Connect to This Server
Automatically Next Time checkbox.

8. Click OK to register the server.

To Unregister an iPlanet Application Server
When an application server is no longer available, you can remove it from the
Administration Tool.

To unregistered, or delete an iPlanet Application Server instance, perform the
following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, double-click All Registered

Servers.
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A list of all registered application servers is displayed.

3. Select the server you want to delete.

4. From the Edit menu, choose Delete.

The selected server is removed from the scope of iASAT.

To Start and Stop a Server Using iASAT
You can choose automatic server start-up when you install iPlanet Application
Server. Thereafter, iPlanet Application Server starts automatically on system
start-up. However, if you want to manually stop and start iPlanet Application
Server, you can do so from iASAT by performing the following tasks:

1. Click the General menu on the iASAT toolbar to open the General window.

2. In the left pane of the General window, select the server you want to start.

3. In the right pane of the General window, click Start Server.

To stop a server, select the server you want to stop and click Stop Server from
the right pane of the General window.

About Command-Line Tools
iPlanet Application Server comes with various command-line tools and
executables, that can be run from the command-line prompt (Windows) and the
shell prompt (Solaris).

Using command-line tools, you can perform a variety of tasks, right from basic
configuration to deploying an application.

To get a complete description of any command-line tool, type command -help at
the command prompt. For example, to get a complete list of all the options
available in the iascontrol command, type iascontrol-help at the command
prompt.

NOTE You can expand the servers in the hierarchical tree only when they
are running.
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Using Command-Line Tools
For ease of use, most of the command-line tools have been integrated with the
iPlanet Application Server Administration Tool (iASAT) and the iPlanet
Application Server Deployment Tool (iASAT.

The options available with iPlanet Application Server’s command-line tools are
different for Windows and Solaris platforms.

On Solaris, even though iASAT and iASAT are available, you can use
command-line tools extensively. As you can have multiple instances of iPlanet
Application Server on Solaris, it becomes necessary at times to modify the
attributes of only one particular instance using command-line tools from the
installation directory of a specific instance.

On Windows, command-line tools are in the form of executable (.exe) files.

Command-line tools are located in the iASInstallDir/ias/bin path, on both Solaris
and Windows systems.

The following section describes iPlanet Application Server using command-line
tools.

Performing Administrative Tasks Using
Command-Line Tools
In this section, the procedure for stopping and starting iPlanet Application Server
using command-line tools is discussed.

iascontrol
You can stop or start a server using command line tools, on both Windows and
Solaris systems by performing the following tasks:

• On Windows, choose Run from the Start menu.

• Type-in iascontrol in the Run field.

• On Solaris systems, navigate to iASInstallDir\ias\bin\ directory.

Run the following script:

iascontrol subcommand -instance <instance> -user <user> -password
<password> -host <host> -port <port> -eng <engineId>



Using Command-Line Tools

28 iPlanet Application Server Administrator’s Guide • October 2002

where subcommand can be one of the following:

The following parameters apply:

start Starts an application server instance. If you execute this
command from the local host, it also starts the
Administration Server (KAS), if not already started.

stop Stops the engines of an application server. The
administration server is not stopped.

kill Forces immediate, non-graceful termination of all
application server processes that are running on the
local host, as well as the iPlanet Application Server
Administration Server (KAS).

instance  Name of the server instance that you want to stop or
start. The server instance must be registered in iASAT.

user Name of the user that is authorized to start, stop or kill
the server instance. The user must be registered with
iASAT

password The password associated with the user

host The hostname or IP address of the server instance you
want to start, stop or kill

port The port number of the application server’s
administrative server. Port 10817 is the default

eng The Id of the engine you want to start or stop. Using the
eng option, you can stop specific engines associated
with an instance of iPlanet Application Server. If the
eng option is not used, then all the engines associated
with the required server will be stopped.

When you use this command Even though the server
engines are shutdown gracefully, AS continues to
operate.

You can obtain the engine ID you want to control, from
the following key in iPlanet Registry:

Software/iPlanet/Application
Server/6.5/CCSO/Eng
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Example iascontrol start

1. Starting a specific instance of iPlanet Application Server engine:

iascontrol start -instance <instance> -user <user> -password
<password> -host <host> -port <port> [-eng <engineid>]

This command starts engines of the specified instance. In the case of a local
instance of iPlanet Application Server, KAS is started if not already running.

2. Starting an engine within a specified instance of iPlanet Application Server.

iascontrol start -eng 1

This command starts the specified engines and KAS (if not already started) on
your local host.

3. Starting an engine associated with a specified instance.

iascontrol start -instance prodnode1 -eng 2

This command starts the engines associated with the instance specified. In the
given example, the specified instance is called prodnode1.

4. Starting an engine associated with a specific instance on the local host.

iascontrol start -user admin1 -password admin -host prodserver
-port 10817 -eng 1

This command starts the engines associated with instance on host prodserver.
KAS must already be started and listening on specified Port.

Example iascontrol stop

1. Stopping the engines of a specified instance.

iascontrol stop [-instance <instance> [-user <user> -password
<password>] [-host <host> -port <port>] ] [-eng <engineid>]

This command stops the engines of the specified instance. Engines are
shutdown gracefully. However, KAS continues to run.

NOTE  KAS must be running on the specified instance before running
this command.
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2. Stopping specific engines on the local host.

iascontrol stop -eng 1

This command stops specified engines on the local host. However, KAS
continues to run.

3. Stopping a specific instance of iPlanet Application Server.

iascontrol stop -instance prodnode1 -eng 2

This command stops the specified engines associated with an instance called
prodnode1. However, KAS continues to run.

4. Stopping specified engines associated with an instance on the local host.

iascontrol stop -user admin1 -password admin -host prodserver -port
10817 [-eng 2]

This command stops engines associated with an instance on the local host.
However, KAS continues to operate.

4. The command to stop an iPlanet Application Server instance should look like
this:

iascontrol stop -instance prodnode1 -user admin1 -password admin
-host prodserver -port 10817

You will see one of these codes displayed on your terminal window when you
execute any of the given commands.

0 - completed successfully.

1 - could not contact one or more of the specified servers.

2 - authentication/authorization failed against one or more of the specified servers.

NOTE You need to register an iPlanet Application Server using iASAT,
before you can use any of the given commands on it.

If your User ID (the ID which you provided while installing iPlanet
Application Server) is longer than 8 characters, the -stop and -kill

commands do not work as expected.
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Environment Variable Setting on Solaris
On the Solaris platform, the common environment variable settings are recorded in
a single script file, iasenv.ksh. The iasenv.ksh script records the common
environment variable settings, such as CLASSPATH, GX_ROOTDIR and
LD_LIBRARY_PATH.

Therefore, These settings are no longer set in each of the scripts located under the
ias/bin or ias/jms/bin directory.

The iasenv.ksh script is located in the <iASInstallDir>/ias/env directory.

NOTE • If any of your current applications are reading environment
information for kjs, kxs, etc, they need to be modified to read
from iasenv.ksh.

• If you face backward compatibility issues, you can define the
required variables within iasenv.ksh instead of modifying the
individual scripts, such as kxs and kjs.

If the same values are present in both iasenv.ksh script and
other scripts which refer to iasenv.ksh (such as kjs), then
depending on the location of the definition of that variable
within these scripts, either iasenv.ksh script setting would be
considered (for example, when the variable is defined before the
invocation of iasenv.ksh script within, say kjs) or the setting that
is defined within the other script would be taken into account
(for example, when the variable is defined after the invocation
of iasenv.ksh script within kjs).

CAUTION We recommend that you do not change the values in the
iasenv.ksh script unless absolutely necessary.
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About iPlanet Registry Editor
The iPlanet Registry Editor, kregedit, is a stand-alone GUI tool that can display
and edit registry information for iPlanet Application Server. The editor is installed
with each instance of iPlanet Application Server and is similar in appearance and
function to the registry editor installed on Windows. The iPlanet registry editor
displays values that are stored both in your local machine’s registry and your
directory Server.

Using the iPlanet registry editor, you can effectively manage the entries that form
the backend resource for the various functions and processes of iPlanet Application
Server. You can add keys, modify key values, and delete redundant keys.
kregedit has a comprehensive Find/Replace option using which, you find and
replace multiple occurrences of the same value in the application server’s registry.

To Start kregedit
To start kregedit, perform the following tasks:

1. On Solaris, go to iASInstallDir/ias/bin and type kregedit at the command
line to launch iPlanet Registry Editor.

1. On Windows, click Start>Run. Type kregedit and click OK.

The following window appears:

NOTE As Solaris supports multiple instances of iPlanet Application Server,
each instance has its own registry. Ensure that you start kregedit
from where the instance you want is installed.
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Performing Administrative Tasks Using iPlanet
Registry Editor
The iPlanet Application Server Administration Tool and Deployment Tool create
back-end entries in iPlanet Registry when required. However, you may at times
need to manually create or edit specific configurations in the application server’s
registry.

For more information on the various keys and their values, see iPlanet Application
Server Registry Guide.

Many of these configuration tasks are described in several chapters in this guide. In
this chapter, the following basic configuration tasks that you can perform using
kregedit are discussed:

The following sections describe how to perform basic administrative tasks using
kregedit:

• To Add a Value To iPlanet Registry

• To Modify a Value in iPlanet Registry

• To Find and Replace Values in iPlanet Registry

• To Update the Installation Key
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• To Change the IP Address

To Add a Value To iPlanet Registry
iPlanet Registry contains several keys, each representing a folder. The values that
are contained in these keys are accessed by various tools and servers such as the
Administration Tool, Deployment Tool, Web-connector Plug-in and Directory
Server.

To add a key to iPlanet Registry, perform the following tasks:

1. Select the key under which you want to create a new key.

2. Click Edit>Add Key. Provide a name for the key and click OK.

3. To add a value to this key, select the key and from the Edit menu, choose Add
Value. The Add Value dialog box appears as shown below:

4. In the Name field, specify a name for the value.

Example 1: If you are creating a value that will point to an application path,
type AppPath.

Example 2: If you are specifying the number of auto starts for a server, type
AutoStart.
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5. In the Value field, provide a value for the key, as required.

If you are specifying a class path, as indicated in example 1 above, type in the
class path, that looks similar to the following example:

c:\iplanet\ias6\ias.

If you are specifying the number of auto starts for a server, as given in example
2 above, type a number, for example, 1.

6. In the Type field, select either String or Integer, based on the type of the value
you have specified.

For example, if the value is a class path, select String from the Type drop-down
list.

If the value is a number that indicates, for example, the number of auto restarts
specified for a server, select Integer from the Type drop-down list.

7. Click OK to register the value in iPlanet Registry.

To Modify a Value in iPlanet Registry
To modify a value in iPlanet Registry, perform the following tasks:

1. Select the value that you want to modify.

2. Double-click the entry or click Edit>Modify Value. The following dialog box
appears:

3. Modify the value and click OK.

NOTE In the Modify Value dialog box, you can modify only the value
specified for the key. You can’t modify the type of value, which
could be either String or Integer. If you want to modify the value
type specification, you need to delete the value and add it again.
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To delete a value from the registry, select the value and press Delete or click
Edit>Delete. You will see a dialog box asking for delete confirmation. Click
Yes to confirm the action.

To Find and Replace Values in iPlanet Registry
You can find and replace values in iPlanet Registry, using the Find/Replace menu
option. You can find and replace a value that occurs within a particular sub-tree or
replace all the occurrences of that value in the entire registry.

To find and replace a value in iPlanet Registry, perform the following tasks:

1. From the Edit menu, choose Find/Replace.

2. In the Find text field, specify the value that you want to find in Iplanet
Registry. If you want to change only a part of the value, specify only that part.
For example, if you want to replace iPlanet.com with Sun.com, you can type
just iPlanet.

3. In the Replace with field, specify the value with which you want to replace the
existing value. For example, to replace iPlanet. com with Sun.com, type just
Sun. The rest of the value will automatically be retained.

4. Click String, if the value you are searching for is a string, such as a classpath.

5. Click Integer, if the value you are searching for is an integer, such as 1.

CAUTION Once a value is deleted, it cannot be recovered.
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6. Mark the Case Sensitive text box, to search for occurrence(s) of the required
item that conform to the format of your find input.

7. Mark the Confirm before Replacing checkbox, if you want to be prompted for
confirmation before the required value is replaced in iPlanet Registry. When
you choose this option, you will be asked for confirmation before the any value
is replaced in iPlanet Registry.

8. Mark the Find/Replace in Entire Registry checkbox, to find and replace all
occurrences of the required value in the entire registry. Marking this checkbox
ensures that the find/replace function is not restricted to a single tree or
sub-tree.

9. Click OK to begin the find/replace action.

When the find/replace action is complete, you will see a confirmation dialog
showing the search results and replacements made. This dialog will give you a
complete list of all the replacements that were made, along with complete tree
structure of the keys whose values were replaced.

To Update the Installation Key
If you installed iPlanet Application Server with an evaluation license, the server
stops running at the end of the evaluation period. You will need to update the
installation key if you have extended the evaluation period or purchased the
server. Updating the installation key saves you from having to reinstall the server
software and reconfigure the environment.

To reset the installation key, perform the following tasks:

1. Shutdown iPlanet Application Server.

NOTE iPlanet Registry holds a lot of critical information on which the
various engines and processes depend. It is strongly
recommended that you choose this option before confirming the
find/replace action.

NOTE If you do not mark this checkbox, only the selected sub-tree will
be searched for the required value.
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2. Open iPlanet Registry Editor.

(See About iPlanet Registry Editor.)

The following window appears:

3. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCS0\ENG

4. Double-click the Key String value and enter the new Installation Key value.
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5. Click OK.

6. Close the registry editor.

7. Restart iPlanet Application Server.

To Change the IP Address
When the IP Address of a machine on which iPlanet Application Server has been
installed changes, such as when the machine is moved or has been assigned to a
different network, you need to replace the old IP Address with the new IP Address.

You need to replace the IP Address in the local iPlanet Registry of each instance of
iPlanet Application Server. This is to let the network know the current IP Address
of your machine.

If you have installed iPlanet Console 5.0 on your machine, you need to let the other
machines on the network know from where the iPlanet Console Administration
Server can be accessed.

The procedure for changing the IP Address is described in the following sections:

• To Modify IP Address in the Local iPlanet Registry

• To Update IP Address of iPlanet Console Administration Server

To Modify IP Address in the Local iPlanet Registry
You can update the new IP Address in iPlanet registry using iPlanet Registry
Editor, kregedit. When you do this, the IP Address is updated in both the local
registry and in the Directory Server that stores your machine’s configuration.

NOTE If iPlanet Console Administration Server is not installed on your
machine, you can ignore the second section.
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To change the IP address in iPlanet registry, perform the following tasks:

1. Start iPlanet Registry Editor

(See About iPlanet Registry Editor.)

2. Select the following key:

SOFTWARE\iPlanet

This is the root key. You need to select this key, to update all occurrences of the
old IP Address, in the entire registry

.

3. From the Edit menu, choose Change IP Address in sub-tree.

The Change IP Address in sub-tree dialog box appears:

NOTE Multiple instances of iPlanet Application Server are supported on
Solaris machines. If you have installed multiple instances of iPlanet
Application Server, you need to replace the old IP Address with the
new IP Address in the iPlanet Registry of each instance.
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4. In the Old IP text field, enter the old IP Address.

5. In the New IP text field, enter the new IP Address.

6. Click OK to save your changes.

To Update IP Address of iPlanet Console
Administration Server
iPlanet Console 6.5 performs common server administration functions such as
stopping and starting servers, installing new server instances, and managing user
and group information through the LDAP services of Directory Server. Using
iPlanet Console, you can manage remote instances of Directory Server that might
exist on your network.

NOTE The IP Address you enter must be of this format:
129.29.191.128. Each sequence of digits must be separated
with a dot.

NOTE • If you enter the IP address along with the Port number (for
example, 129.29.191.128:10818), in the Change IP
Address in sub-tree dialog box, only the IP Address will be
extracted, validated and replaced in iPlanet Registry.

• To ensure that all occurrences of the old IP Address have
been replaced in the registry, use the Find/Replace option
from the Edit menu. Note that though this option checks for
the correctness of the IP Address format, it does not validate
the IP Address before replacing it in iPlanet Registry.
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iPlanet Console comes with its own Administration Server, which is used
internally by iPlanet Console. If iPlanet Console is installed on your machine, you
need to ensure that all the machines in your network know the correct
nsserveraddress (iPlanet Console Administration Server’s IP Address) and the
nsadminaccessaddress (the IP Address of the machine from which the iPlanet
Console Administration Server can be accessed).

The nsserveraddress for the iPlanet Console Administration server is stored in
two locations; Directory Server and the local configuration file of iPlanet Console.

The nsadminaccessaddress is stored only in the local configuration file of iPlanet
Console.

The following sections describe how you can change the nsserveraddress and the
nsadminaccessaddress:

• To Modify IP Address in Directory Server

• To Modify IP Address in Local Configuration File

To Modify IP Address in Directory Server
To change the nsserveraddress in Directory Server, perform the following tasks:

1. Go to <iASInstallDir>/slapd-<hostname> and run the following script:

db2ldif

This script generates an LDIF (LDAP Data Interchangeable Format) file, whose
preliminary filename will bear the stamp of the date and time it was generated,
in the YYYY-MM-DD format. For example, an LDIF file generated on 3rd June
2001 at 14 hours, 2 minutes and 38 seconds will look like this:

2001_06_03_140238.ldif.

2. Go to <iASInstallDir>/slapd-<hostname>/ldif and locate the LDIF file
with the latest date and time stamp.

3. Open the LDIF file (using any text editor) and search for the nsserveraddress
entry. Replace the old IP Address with the new one. Note that you will need to
search for all occurrences of the old IP Address and replace with the new one,
to ensure that the change is complete.

4. Stop the Directory Server, by performing the following tasks:

On Windows:

a. From the Start menu, choose Settings>Control Panel.

b. Double-click the Services icon
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c. In the Services window, select iPlanet Directory Server.

d. Click Stop to stop the server.

On Solaris:

a. Navigate to the <iASInstallDir>/slapd-<hostname> path.

b. Run the following script:

stop-slapd

The Directory Server stops.

5. The next step is to write the LDIF file to the Directory Server. To do this, go to
<iASInstallDir>/slapd-<hostname> and run the following script:

ldif2db -i ldif/<path>/<filename>.ldif

When you run this script, the changes made to the file are recorded in
Directory Server.

6. Start the Directory Server.

To start Directory Server, follow the procedure described in Step 4 above. For
Windows, click Start in the Services window to start the server. For Solaris, run
the script start-slapd to start the server.

To Modify IP Address in Local Configuration File
To change the IP Address in the local configuration file(s) of the iPlanet Console
Administration Server, perform the following tasks:

1. Go to <iASInstallDir>/admin-serv/config and open the local.conf file,
using any text editor.

NOTE You need to provide the absolute path of the LDIF file in
which you changed the nsserveraddress value.

NOTE Check the log files that are stored in the following path, to make
sure that all occurrences of the old IP Address have been
replaced in the Directory Server:

<iASInstallDir>/slapd-<hostname>/logs
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2. Locate nsserveraddress entries and change the IP Address value in them.
The entries will look like this:
configuration.nsserveraddress.129.158.228.63.

3. Locate nsadminaccessaddress entries if any and change the IP Address value.
The entries will look like this:
configuration.nsadminaccessaddress.129.158.228.63.

4. Stop and start the iPlanet Console Administration Server, by performing the
following tasks

On Windows:

a. Go to <iASInstallDir>/ and double-click the stop-admin executable to
stop the server.

b. Double-click the start-admin executable to start the server.

On Solaris

a. Go to <iASInstallDir/> and run the stop-admin script to start the
server.

b. To start the server, run the start-admin script from the same path.

Configuring Multiple LDAP Domains
iPlanet Application Server supports multiple LDAP domain names, based on the
Nortel LDAP schema.

A user can now use different domain names such as, john.doe@acme.com, to log
on to an application. Each domain name that a user is associated with is entered
into the directory server.

NOTE • If multiple instances of iPlanet Application Server have
been installed on a single host (supported only on Solaris
machines), a local configuration file is present for each
instance. When the IP Address changes, you need to
update the required entries in the local configuration file
for each instance of iPlanet Application Server.

• If you have installed multiple instances of iPlanet
Application Server on your machine, you need to stop
and start the iPlanet Administration Server for each
instance, for the changes to take effect.
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To use multiple domains, you need to add the new domain name(s) to iPlanet
registry and create the corresponding backend entries in the directory server. This
can be done on both Solaris and Windows.

This section includes the following topics:

• To Add a Domain Name to iPlanet Registry.

• To Configure a New Domain Name in Directory Server

To Add a Domain Name to iPlanet Registry.
To add a domain name to iPlanet registry, perform the following tasks:

1. Open the iPlanet Registry Editor.

(See About iPlanet Registry Editor.)

2. Open the following key:

Software/iPlanet/Application Server/6.5/Principal

3. Create a subkey using a new domain name, for example, iPlanet.

4. Select the new domain name and from the Edit menu, choose Edit>Add
Value.

The Add Value dialog box appears, as shown in the figure:

5. In the Name text field, provide a name for the value, for example, Backend.
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6. In the Value field, specify a value, for example, LDAPBackend2.

The value you specify here must find a corresponding value of the same name
in the directory server.

For more information, refer to “To Configure a New Domain Name in
Directory Server.

7. Click OK to register the value in iPlanet Registry.

You now need to create a second value for the domain subkey, as described in
the following steps.

8. Select the new domain key, and choose Add Value from the Edit menu.

9. In the Add Value dialog box, provide a name, for example, Repository.

10. Specify a value, for example, 1. Select Integer from the Type drop-down list.

You have now defined a new domain name in iPlanet Registry. When you
complete the process of defining a new domain name in iPlanet Registry, your
entries must look like the following example:
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To Configure a New Domain Name in Directory Server
After you define the new domain name in iPlanet Registry, you need to configure
the domain name in Directory Server. The domain name entries in iPlanet Registry
will point to the entries that you create in Directory Server.

To configure the new domain name in Directory Server, perform the following
tasks:

1. In iPlanet registry, open the key Software/iPlanet/Application

Server/GDS/Backends/LDAP/

2. Create a subkey with the same value that you specified under
Software/iPlanet/Application Server/6.5/Principal, i.e,
LDAPBackend1.

3. Create a value for this subkey, which defines the attributes of the Common
Name (cn) that is defined in Directory Server. For example:
root=cn=global,cn=iasconfig,cn=iAScluster,O=NetscapeRoot.

4. Create a new subkey under the key LDAPBackend1, for example 0.

5. Create the following values for the subkey 0.

❍ GroupPath = ou=Groups, o=<new domain>

❍ Host = <hostname>

❍ Password = <encrypted password>.

❍ Port = <Directory Server Port>. The default port is 389.

❍ User = cn=Directory Manager

❍ UserPath = ou=People, O=<new domain>

This procedure configures the back-end entries for the new domain name in the
Directory Server.

NOTE You need an encrypted password when you login using your new
domain name, through which you are identified by Directory
Server. You can generate an encrypted password by running the
following script:

<iASInstallDir>/ias/bin/kencrypt2 <text to be encrypted>

This script creates an encrypted password out of the alpha-numeric
string that you provide. Your password can comprise as many
characters that you want.
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Chapter 2

Monitoring Server Activity

This chapter describes the monitoring service provided by iASAT. This service
allows you to chart various attributes of the Executive, Java, C++ and Bridge server
processes.

The following topics are included in this chapter:

• Monitoring iPlanet Application Server

• Receiving Event Notification

Monitoring iPlanet Application Server
iPlanet Application Server Administration Tool (iASAT) provides a monitoring
service that lets you chart the activity of the Executive, Java, C++ and Bridge
servers that make up iPlanet Application Server. You can also log the information
to a file. By graphically representing this server activity or recording the data in a
file, you can track and review the performance of an application server or group of
servers and make adjustments to improve performance. For example, if you add
more memory to the application server or deploy a new application, you may want
to monitor the performance of the application server to see the impact of these
changes.

iPlanet Application Server’s monitoring service polls the application server at
designated intervals. This saves server resources because the server updates the
information being monitored at the specified interval instead of updating it
continuously. You can specify this interval in the Monitoring window. For
information about setting the interval time, see To Change a Process Data Plot.
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The monitoring window “pops out” from the Administration Tool when you click
a process to monitor. This detached window enables you to monitor server activity
in a separate window while continuing to perform other administrative tasks using
the Administration Tool.

This section describes the following topics:

• Monitoring Process Attributes

• To Log Process Data to a File

• To Change a Process Data Plot

• To Remove a Process Data Plot

Monitoring Process Attributes
The server activity, or attributes, you can chart varies according to which server, or
process, you are monitoring.

The Executive Server (KXS) process is responsible for managing and hosting the
system-level services, such as the load-balancing service, and for delegating
requests to one of the application processes, either the Java server, or C++ server
depending on the language in which the application component is written.

You can chart the following attributes of the Executive Server process:

Table 2-1 Executive Server Monitoring Attributes

Executive Server
Process Attribute (KXS)

Description

CPU load The amount of load on the CPU on which this Executive Server
process is running, as calculated by the load balancing service.

Disk input and output The rate of Read and Write operations issued by the system on
which this Executive Server is running, as calculated by the load
balancing service.

Memory thrash The number of pages read from or written to the hard disk drive
to resolve memory references to pages that were not in memory at
the time of the reference.

Requests queued The total number of requests in an internally maintained queue.
An actual count of pending requests in an engine can be
monitored using the Requests Waiting parameter.

This internal queue status is meant for analysis by Sun
engineers.
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Cached results Number of entries stored in the result cache.

Average execution
time

Average amount of time for the Executive Server process to
execute a request.

Requests/interval Number of new requests received since the last polling.

Total requests Total number of requests the process has received starting up
(This value is reset to 0 upon server or process start-up.). For the
executive process, this corresponds to the total number of
requests the server has executed across all server processes.

Current requests The number of requests currently being processed by the server;
includes all requests dispatched and being processed in the
KJS/KCS engines.

Requests Waiting Number of queued requests waiting to be serviced.

Requests ready The total number of requests which are in ready state to be
processed in the internally maintained queue of engine. An
actual count of pending requests in an engine can be monitored
using Requests Waiting parameter.

This internal queue status is meant for analysis by Sun
engineers.

Current Requests
Threads

Number of request threads allocated by the process (includes
both idle threads and threads actively processing requests).
Note that this number cannot exceed Maximum Threads, or fall
below Minimum Threads configured for this process. These
values are set in the General window.

Requests Threads
Waiting

Number of requests threads available to execute new incoming
requests. This number will be a subset of the Current Requests
Threads monitoring attribute.

Total Threads Number of threads being used by the process.

Bytes sent/interval Number of new bytes sent since the last polling.

Bytes
received/interval

Number of new bytes received since the last polling.

Current Sessions Number of current sessions being handled.

Table 2-1 Executive Server Monitoring Attributes (Continued)

Executive Server
Process Attribute (KXS)

Description
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The Java Server (KJS) and C++ Server (KCS) processes are responsible for hosting
application elements, depending on the language in which the element is written.
The Java Server hosts application components written in Java, and the C++ Server
hosts components written in C++. In addition, the Corba Executive Server (CXS) or
Bridge process allows for independent Java clients (Rich Clients) to communicate
directly to Enterprise JavaBeans hosted on a Java Server. For more information
about Rich Client, see the Developer’s Guide (Java).

You can chart the following attributes of the Java, C++ and Bridge Server
processes:

NOTE If you monitor CPU load, disk input and output, or memory thrash,
you must specify the intervals at which the statistics for these
process attributes are updated. To set the intervals, select Load
Balancing. Choose User Defined Criteria Load Balancing, then click
the Advanced Settings tab.

Table 2-2 Java, C++ and IIOP Bridge Server Monitoring Attributes

Java/C++ and Bridge Server
Processes (KJS, KCS and CXS)
Monitoring Attributes

Description

Average execution time Average amount of time for the process to execute a
request.

Requests/interval Number of new requests received since within the
interval.

Total requests Total number of requests the process has received since
the last start-up. This value is reset to zero upon server
or process start-up.

Current Requests The number of requests currently being processed by
this process.

Requests Waiting Number of queued requests waiting to be serviced.

Requests Ready The total number of requests which are in ready state to
be processed in the internally maintained queue of
engine. An actual count of pending requests in an
engine can be monitored using Requests Waiting
parameter.

This internal queue status is meant for analysis by Sun
engineers.
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For each process, you can chart one or more attributes. You can also
simultaneously chart the attributes of several application servers, if you have a
multiple-server enterprise.

To Monitor Process Attributes
To monitor process attributes, perform the following tasks:

1. On the iASAT toolbar, click Monitor to open the Monitor window.

2. In the left pane of the Monitor window, click the process whose attributes you
want to chart, as shown in the following figure:

Current Requests Threads Number of request threads allocated by the process
(includes both idle threads and threads actively
processing requests). Note that this number cannot
exceed Maximum Threads, or fall below Minimum
Threads configured for this process. These values are set
in the General window.

Request Threads Waiting Number of requests threads available to execute new
incoming requests. This number will be a subset of the
Current Requests Threads monitoring attribute.

Active data connections Number of currently active data connections.

Cached data connections Number of currently cached data connections.

Queries/interval Number of queries executed within the interval.

Trans committed/interval Number of transactions committed within the interval.

Trans rolledback/interval Number of transactions rolled back within the interval.

Total Threads Number of threads being used by the process.

Bytes sent/interval Number of new bytes sent since the last polling.

Bytes received/interval Number of new bytes received since the last polling.

Table 2-2 Java, C++ and IIOP Bridge Server Monitoring Attributes (Continued)

Java/C++ and Bridge Server
Processes (KJS, KCS and CXS)
Monitoring Attributes

Description
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A separate monitoring panel pops out of iASAT, as shown in the following
figure:

3. In the right pane of the monitoring window in iASAT, click Add Plot located at
the bottom of the window.

The Add Plot dialog opens for you to specify the attributes to monitor for the
highlighted process.
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4. In the Attribute drop-down list, select the attribute to chart.

5. From the Scale drop-down list, choose the ratio (scale) at which to plot the
attribute.

Values range from 10:1 to 1:1,000,000. A scale of 10 to 1 (10:1) indicates
that 10 units will be plotted on the Process Monitor window for each attribute
count.

6. From the Color drop-down list, choose a color to represent the process
attribute on the chart.

7. Repeat steps 2 through 6 for each process or attribute you want to chart.

Each process attribute that you choose to chart is displayed in the Monitor
window.

8. In the Time Interval drop-down list, select the interval at which you want to
update the Monitor Plot window.

This setting applies to all process attributes displayed in the Monitor window.
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To Log Process Data to a File
Once you begin monitoring a process attribute, you can send data collected by the
monitoring service to a file.

To log process data to a file, perform the following steps:

1. On the iASAT toolbar, click Monitor to open the Monitor window.

2. In the left pane of the Monitor window, click the process whose data you want
to chart.

3. In the right pane of the Monitor window, click Options.

The following dialog box appears:

4. Click the Log to File checkbox to enable the logging service.

5. In the File Name text field, enter the name of the file where data is to be
written.

6. Click OK to save your changes.

To Change a Process Data Plot
Once an attribute data plot is specified for a process (KCS, KJS, and KXS), you can
adjust the plot using the Attribute, Color, and Scale drop-down boxes.

To change the way a process attribute is plotted, perform the following steps:

1. On the iASAT toolbar, click Monitor to open the Monitor window.

2. In the right pane of the window, select a process row, whose attributes you
want to change.

3. To change an attribute, click the Attribute column and choose a new attribute
to plot from the drop-down list.
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4. Similarly, click the Color and Scale columns to change how the attribute will be
plotted.

To Remove a Process Data Plot
If you no longer want to plot an attribute for a process, you can remove it from the
plot.

To remove a process plot, perform the following steps:

1. Click Monitor on the iASAT toolbar to open the Monitor window.

2. In the left pane of the Monitor window, choose a process, to display the
process rows in the right pane.

3. In the right pane of the Monitor window, select a process whose attribute you
want to remove.

4. Click Remove Plot.

The attribute is removed from the Monitor window.

Receiving Event Notification
Event notification is useful when you cannot actively monitor an iPlanet
Application Server. This passive monitoring system is activated only in critical
circumstances, such as when a process has failed.

You can set the system to alert one or more concerned parties through email when
a critical situation arises by supplying the email addresses of those you want to
alert. In addition, you can specify a script that will run automatically when certain
events occur.

This section includes the following topics:

• About Events

• To Configure Email Notification for an Event

• To Specify an Event-Invoked Script
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About Events
You can specify an individual to notify or a script to run for the following critical
events:

• Executive Sever (KXS) goes down

• Java Server (KJS) goes down

• C++ Server (KCS) goes down

• Process auto restarts exceeded

• Abnormal Cluster is detected

This section includes details for the following topics:

• What Do I Do When a Server Goes Down?

• What Do I Do When Restarts Are Exceeded?

• What Do I Do When an Abnormal Cluster is Detected?

What Do I Do When a Server Goes Down?
If one or more of the Executive Server, Java Server, or C++ Server processes go
down, the Administrative Server attempts to restart each process. If the process
cannot be restarted by the Administrative Server, the application stops running
and can result in lost transactions.

Recurring failures are usually attributed to problems within the application code,
but other failures can also happen. Regardless of what causes a process to fail, it is
useful to be notified immediately.

If the process restarts, investigate the cause of the failure to determine whether
adjustments can be made to prevent future failures. If the process does not restart,
look at the log to find the cause of the failure.

What Do I Do When Restarts Are Exceeded?
You can also be notified when the Administrative Server has exceeded the number
of times it has been set to restart a process. The maximum engine restarts value is
set on the Server tab of the General window.

Increase the Administrative Server restart option, if it is low, and determine the
cause of the process failure.
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What Do I Do When an Abnormal Cluster is Detected?
You can also be notified when an abnormal cluster condition has been detected.
Within a normal operating cluster there is one sync primary iPlanet Application
Server that is the primary data store, with which all other cluster members
communicate for the latest distributed data information. An abnormal cluster is
where a dual-primary or a no-primary condition has been detected.

Mark the Restart in case of abnormal cluster checkbox on the Cluster tab of the
General window. iPlanet Application Server will re-start an appropriate process so
that one (and only one) sync primary is present in the cluster. For more
information about clusters, see “Managing Distributed Data Synchronization,” on
page 291.

To Configure Email Notification for an Event
To send an email notification for an event, perform the following steps:

1. On the iASAT toolbar, click Events to open the Events window.

2. From the left pane of the Events window, select the server for which you want
to configure events.

3. From the right pane of the Events window, select the event or events for which
you want to be notified by clicking the corresponding checkbox as shown in
the following figure:
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4. In the Email Addresses field, specify the email address or addresses of the
persons you want to send notification. To use multiple email addresses,
separate each email address with a semi-colon(;).

5. In the Mail Server field, specify the mail server through which the notification
is sent. Use the following format:

mail.company.com

6. To see the most recent events that might have been sent out for this server,
click Poll for Events.

The Poll for Event dialog box appears displaying a list of the recent events for
the selected server.

NOTE When you click Poll for Events, events are consumed (that is, the
events that you see are no longer included in the next set of
events that are displayed).
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7. Click Apply Changes to save your changes.

To Specify an Event-Invoked Script
You can configure the event notification service to run a script. The script might
page the system administrator, bringing the problem to the administrator’s
attention, or perform any other automated task that will help keep the system
running smoothly when faced with a critical event.

When a script runs, it passes an argument to indicate what type of event has
occurred. For instance, the following command indicates that a Java Server (KJS)
process has crashed:

/script location/ crash kjs

To configure the event notification service to run a script in response to an event,
perform the following steps:

1. On the iASAT toolbar, click Events to open the Events window.

2. From the left pane of the Events window, select the server for which you want
to configure events.

3. In the right pane of the Events window, mark the checkboxes against the
events for which you want to invoke a script.

4. In the Script field, specify the path of the script to run. For example:

/mydir/scripts/myscript.pl

5. Click Apply Changes to save your changes.
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Chapter 3

Configuring SNMP to Monitor
iPlanet Application Server with

Third-Party Tools

This chapter describes how to configure Simple Network Management Protocol
(SNMP) so that you can monitor iPlanet Application Server with third-party SNMP
management tools.

The following topics are included in this chapter:

• About SNMP

• Enabling SNMP Statistics Collection

• About the Management Information Base (MIB)

• Setting Up the Master Agent and SubAgents

About SNMP
SNMP is a protocol used to exchange data about network activity. With SNMP,
data travels between your application server and a workstation where network
management software is installed. From this workstation, you can remotely
monitor your network and exchange information about network activity between
servers. For example, using an application like HP OpenView, you can monitor
which iPlanet Application Server machines are running, as well as the number and
type of error messages your application servers receive.

NOTE SNMP support for iPlanet Application Server is not available on
Windows platforms.
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Your network management workstation exchanges information with the
application servers in your enterprise through two types of agents: the subagent
and the master agent. The subagent gathers information about an application
server and passes that information to the master agent. The master agent
exchanges information between the various subagents and the network
management workstation. The master agent runs on the same host machine as the
subagents with which it communicates.

Figure 3-1 SNMP Agent Support Architecture

Enabling SNMP Statistics Collection
The iPlanet Application Server SNMP subagent does not report SNMP statistics to
the network management workstation unless you enable statistics collection. If
statistics collection is not enabled, the subagent cannot be started.
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If the SNMP data collection process (snmpcoll), is not running, check the iPlanet
Administration Console to see whether the SNMP enable flag is on. For more
information, see Managing Servers with iPlanet Console at
http://docs.iplanet.com/

If you disable the startup server, this collection process is also disabled.

To enable data collection, perform the following steps:

1. Click General on the iPlanet Application Server Administration Tool (iASAT)
toolbar to open the General window.

2. In the right pane of the General window, click the SNMP tab.

3. Mark the Enable SNMP Administration and Monitoring check box.

This step enables the SNMP subagent to publish statistics about the application
server to the master agent.

4. Mark the Enable SNMP Debug checkbox, to log error messages if there is a
problem with connecting to the master agent.

5. Specify an interval in the Connection Attempt interval text field.

This is the time interval in which the subagent will attempt to connect to the
master agent.

NOTE If the network management workstation experiences difficulty
obtaining SNMP statistics, check the server log information located
at the following path:

<iASInstallDir>/<mail-instanceName>/log/default/

NOTE You will have to re-start the iPlanet Application Server server for
these settings to take affect.
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About the Management Information Base (MIB)
iPlanet Application Server stores variables pertaining to network management in a
tree-like hierarchy known as the server’s management information base (MIB).
iPlanet Application Server reports significant events to the network management
workstation by sending messages containing these variables. The network
management workstation can also query the server’s MIB for data or can remotely
change variables stored in the MIB.

This section includes the following topics:

• Formatting MIB Entries

• Making MIB Available on SNMP Third-Party Management Software

Formatting MIB Entries
The MIB file contains the definitions for managed objects, or variables, that store
network information for the server. Each variable definition includes the variable
name, its data type and read/write access level, a brief description, and a
permanent object identifier.

This sample entry shows the definition for the nsmailEntityDescr variable:

This definition contains the following information:

• Object Type: gives the name of the variable, in this case, iasKesMaxThread.

nasKesMaxThread OBJECT-TYPE     / object type

SYNTAX      INTEGER (SIZE (1..512))      / syntax

ACCESS      read-write      / read/write access
level

STATUS      mandatory      / status

DESCRIPTION                / description
"The maximum number of threads used to serve requests."

::= { kes 4 }  / object identifier
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• Syntax: gives the abstract data type of the variable object type in ASN.1
notation. For example, the Syntax of the nasKesMaxThread variable is INTEGER
(SIZE (1..512)).

• Access: gives the required access level to the variable. Possible access levels are
read-only, read-write, write-only, or not-accessible.

• Status: tells whether the element is mandatory, optional, or obsolete.

• Description: text description of the element, enclosed in quotes. For example,
the description of the nasKesMaxThread variable is “The maximum number of
threads used to serve requests.”

• Object Identifier: assigned name that serves as a permanent identifier for each
managed object in the MIB name tree in its name space. Objects in SNMP are
hierarchical; the object identifier is a sequence of labels that represents the
object in the hierarchy. For example, nasKesMaxThread is identified as kes 4.

This means that it has the label 4 in the subtree kes.

Note that kes, in turn, has the label 4 in the kesTable subtree.

Making MIB Available on SNMP Third-Party
Management Software
Refer to the SNMP management software for detailed procedures for making the
MIB available. In general, you have to copy the iPlanet Application Server MIB to
the Network Management machine and then load it into the SNMP management
software’s MIB database.

You can find the iPlanet Application Server MIB database in the following location:

<iASInstallDir>/plugins/snmp/

Setting Up the Master Agent and SubAgents
The SNMP Master agent is native to your Solaris operating system. Master agent
operation is defined in an agent configuration file called CONFIG. You can edit the
CONFIG file manually.

NOTE This procedure assumes that you are running Solaris 2.6 with
recommended patches. It also assumes that iPlanet Web Server is
installed.
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This section includes the following topics:

• To Configure the Master SNMP Agent

• To Start the SNMP Master Agent

• To Verify SNMP Configuration

To Configure the Master SNMP Agent
To configure the master SNMP agent, perform the following steps:

1. Log in as root.

2. Check to see if there is a Solaris SNMP daemon (snmpdx) running on port 161.

If an SNMP daemon is running, make sure you know how to restart it and
which MIB trees it supports. Then kill its process.

3. Edit the Solaris SNMP daemon start-up file s76snmpdx in /etc/rc3.d to
modify the port to which the daemon listens.

In the start section, replace the line

/usr/lib/snmp/snmpdx -y -c /etc/snmp/conf

or

/usr/lib/snmpdx -p 161 -y -c /etc/snmpconf

with

/usr/lib/snmp/snmpdx -p 1161 -y -c /etc/snmp/conf

You have changed the port to which the daemon listens from 161 to 1161.

4. Edit the CONFIG file located in <iASInstallDir>/ias/snmp in the server root
directory.

The CONFIG file defines the community and the manager that the master agent
will work with. The manager value should be a valid system name or an IP
address. The following is an example of a basic CONFIG file:
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5. (Optional) Define sysContact and SysLocation variables in the CONFIG file.

You can edit the CONFIG file to add initial values for sysContact and
sysLocation which specify the sysContact and sysLocation MIB-II
variables. Note that the strings for sysContact and sysLocation in this
example are enclosed in quotes. Any string that contains spaces, line breaks,
tabs, and so on must be in quotes. You can also specify the value in
hexadecimal notation.

In this sample CONFIG file, sysContract and sysLocation variables are
defined:

The encapsulator forwards requests from the master agent to the Solaris agent that
now listens on port 1161.

6. Edit the file CONFIG_SAGT, modifying the following lines:

Agent at 1161 with Community Public

COMMUNITY public

ALLOW ALL OPERATIONS

MANAGER your_manager_station_name

SEND ALL TRAPS TO PORT 162
WITH COMMUNITY public

COMMUNITY public

ALLOW ALL OPERATIONS

MANAGER nms2

SEND ALL TRAPS TO PORT 162
WITH COMMUNITY public

INITIAL sysLocation "Server room 501 East Middlefield
Road Mountain View, CA 94043 USA"

INITIAL sysContact "John Doe email: <jdoe@iPlanet.com>"
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This configures the subagent to serve the Solaris agent on port 1161.

Subtrees <list of oids>

This configures the SNMP subtrees served by the Solaris agent.

Forward All Traps

This ensures that all traps sent by the Solaris agent are forwarded to the master
agent.

To Start the SNMP Master Agent
Once you have installed the SNMP master agent, you can start it manually or by
using iPlanet Console.

To start the master agent manually, enter the following at the command prompt:

# magt CONFIG INIT &

The INIT file is a nonvolatile file that contains information from the MIB-II system
group, including system location and contact information. If INIT doesn't already
exist, starting the master agent for the first time will create it. An invalid manager
name in the CONFIG file will cause the master agent start up to fail.

To automatically start the master agent when you start the server, perform the
following steps:

1. Edit the files ias/snmp/k75snmpmagt and ias/snmp/S75snmpmagt.

2. Change $GX_ROOTDIR to the iPlanet Application Server installation directory
path if this variable is not yet defined in the root’s environment.

3. Copy k75snmpmagt to /etc/rc2.d and s75snmpmagt to /etc/rc3.d.

To start a master agent manually on a nonstandard port, use one of two methods:

• Method 1: In the CONFIG file, specify a transport mapping for each interface
over which the master agent listens for SNMP requests from managers.
Transport mappings allow the master agent to accept connections at the
standard port and at a nonstandard port. The master agent can also accept

NOTE INIT contains information about the local system. This file is
created the first time you start the master agent. You should not
copy this file across machines.
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SNMP traffic at a nonstandard port. The maximum number of concurrent
SNMP is limited by your target system's limits on the number of open sockets
or file descriptors per process. The following is an example of a transport
mapping entry:

After editing the CONFIG file manually, you should start the master agent
manually by typing the following at the command prompt:

# magt CONFIG INIT&

• Method 2: Edit the /etc/services file to allow the master agent to accept
connections at the standard port as well as at a nonstandard port.

To Verify SNMP Configuration
After you have performed the procedures outlined in this chapter, you can verify
SNMP setup.

To verify SNMP, perform the following:

1. Stop iPlanet Application Server. For more information on starting and
stopping iPlanet Application Server, see “To Start and Stop a Server Using
iASAT,” on page 26.

Also make sure that all iPlanet Application Server processes (KAS, KXS, KJS
and KCS) are stopped.

2. Verify that Directory Server is running. If it is not running start Directory
Server, by executing the following command:

<iASInstallDir>/slapd-<hostname>/start-slapd

3. Verify that iPlanet Web Server (iWS) (e.g. https-servername) is running. If it is
not running start it as follows:

/usr/iplanet/suitespot/https-solsystem/start

where solsystem is the server name.

TRANSPORT extraordinary SNMP

OVER UDP SOCKET

AT PORT 11161
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4. Verify that the Solaris SNMP agent (snmpdx) is running using the UNIX ps
command as follows:

ps -ef | grep snmpd

If it is not running, start it with:

/etc/rc3.d/S76snmpclx start

5. Verify that the iPlanet Application Server Master Agent (magt) and
encapsulator/proxy subagent (sagt) are running using the UNIX ps command
as follows:

ps -ef | grep magt

ps -ef | grep sagt

If they are not running, start them with:

/etc/rc3.d/S75snmpmagt start

6. Start iPlanet Application Server.

7. Use your third-party SNMP management software’s MIB browser or test
utility (for example, snmpwalk) to confirm that SNMP data is being collected.
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Chapter 4

Logging Server Messages

This chapter describes the message-logging service provided by iPlanet
Application Server.

The following topics are included in this chapter:

• About the Logging Service

• About Logging Application Events

• About Logging HTTP Requests

• About Logging DSync Messages

About the Logging Service
Use the message-logging service of iPlanet Application Server to log server
messages. The logging service is configured through the iPlanet Application Server
Administration Tool’s Logging menu.

When you enable logging, iPlanet Application Server records messages generated
by application-level and system-level services. These messages describe the events
that occur while a service is running.

This section contains the following topics:

• To Determine Types of Messages to Log

• How Log Messages Are Formatted

• Monitoring iPlanet Application Server Log Files
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To Determine Types of Messages to Log
You can log any of the three types of messages generated by iPlanet Application
Server services. Each type is described in the following table:

With the logging service, you can record error messages, error and warning
messages, or all messages. To choose which type of messages to log, perform the
following tasks:

1. Click Logging on the iPlanet Application Server Administration Tool (iASAT)
toolbar to open the Logging window.

2. In the left pane of the Logging window, select the iPlanet Application Server
node for which you want to specify log settings.

3. In the right pane of the Logging window, click the Server tab. The following
dialog box appears:

Table 4-1 Log Message Types

Message type Description When it might appear

Information message Describes the processing of a
request or normal service
activity, such as a status update.

When no problems arise.

Warning message Describes a noncritical problem
that might be an indication of a
larger problem.

When a service encounters a
temporary problem, such as
when it is unable to connect
to a process.

Error message Describes a critical failure of the
service, from which recovery is
not likely.

When a service encounters a
critical problem, such as a
pipe closure.
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4. Mark the Enable Server Event Log checkbox, to enable event logging.

5. In the General pane, from the Message Type drop-down box, select one of
these; Errors, Errors and Warnings, All Messages.

6. In the Maximum Entries text field, specify the maximum number of entries that
can exist before data is written to the log.

7. In the Write Interval field, enter the amount of time (in seconds) that elapses
before data is written to the log.

These settings apply to all the three services that can be logged: application,
HTTP and DSync.

How Log Messages Are Formatted
Every log message has the following four components:

• Date and time the message was created.
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• Message type, such as information, warning, or error.

• Service or application component ID.

• Message text.

When a log message is sent to the text-based destination logs, it is formatted as
follows:

[Date and time of message] Message type: Service ID: Message text

For example, the following messages sent to an ASCII text file illustrate message
format:

[01/18/00 11:11:12:0] info (1): GMS-017: server shutdown (host
0xc0a801ae, port 10818, group 'iAS') - updated host database

[01/18/00 11:11:18:2] warning (1): GMS-019: duplicate server (host
0xc0a8017f, port 10818) recognized, please contact iPlanet
Communications for additional licenses

Monitoring iPlanet Application Server Log Files
This section describes how application server logs can be viewed, on Windows and
Solaris systems. Reviewing log files is often helpful when troubleshooting
application and server configuration problems. The following sections describe in
detail how you can monitor iPlanet Application Server logs on both Windows and
Solaris systems.

This section includes the following topics:

• To Monitor Application Server Logs On Solaris

• To Monitor Application Server Logs on Windows

To Monitor Application Server Logs On Solaris
On Solaris, you can view iPlanet Application Server logs by using a command line
tool. Using this tool, you can selectively view the messages you want. For example,
you can view messages generated during a specific period, or view only the first
few messages in a file.

To monitor iPlanet Application Server logs on Solaris, perform the following tasks:

1. Navigate to the following path:

<iasinstsall>ias/logs
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2. Type tail - and the filename of the log file that you want to view. For
example, to view KJS logs, type tail -kjs.

To stop the command execution, press CTRL+C.

.

To Monitor Application Server Logs on Windows
To enable display of application server logs on NT, perform the following tasks:

1. From the Start menu, select Settings>Control Panel

2. Double-click the Services icon. The Services window appears, as shown in the
following figure:

3. Select iPlanet Application Server 6.5.

4. Click Startup. The Service window appears, as shown below:

NOTE Open a terminal window and type man tail for a complete list of
all the options you can try with the tail command.
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5. Mark the Allow Service to Interact with Desktop checkbox, as shown in the
figure.

6. Click OK to close the window.

7. In the Services window, click Stop to stop iPlanet Application Server.

8. Click Start to start iPlanet Application Server again.

When you do this, you will see iPlanet Application Server logs messages displayed
in DOS windows. Each physical process in iPlanet Application Server will be
displayed in a separate window. For example, you can see KAS logs, KJS logs and
KCS logs in separate windows.

To Enable Vertical Scroll Bars In The Output Windows
The log messages that you view on the DOS windows will scroll continuously. To
You can enable vertical scroll bars in the output windows, and scroll backwards
and forwards to view the messages you want. To enable vertical scroll bars in DOS
windows, perform the following tasks:

1. Click the DOS icon at the upper-left corner of the output window.

2. Choose Properties. The Properties window appears, as shown in the following
figure:
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3. Select the Layout tab.

4. Set the Screen Buffer Size Height to 200 or more.

5. Click OK to register your changes. A confirmation window appears, as shown
below:

6. To enable scroll bars on all DOS windows, mark the Save Properties for future
windows with same title radio button.

About Logging Application Events
Message logging is useful for tracking and debugging application errors. By using
the log( ) method, application developers can send messages to the same log
destination that the server administrator configures for iPlanet Application Server
services.
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For example, if an application encounters a problem in a segment of code, you can
log the associated error message. Informational messages about the application’s
status, rather than error messages, are also useful.

The administrative services of iPlanet Application Server run in the Administration
Server process (KAS). This Administration Server enables remote administration of
servers and applications. KAS also supports other services, such as application
partitioning, event logging, request monitoring, and dynamic configuration of key
server settings. Clients that access administrative services include iASAT, directory
server and third party SNMP agents.

Some of the events that are monitored and logged by KAS are listed below:

• Server login and logout details.

• Initialization status, startup, shutdown, enabling and disabling of server and
engines.

• Issues related to KAS, SNMP, Transaction Manager and engines.

• Issues related to iPlanet Application Server installation.

• Deployment actions and errors during deployment.

• Errors that may occur when retrieving configuration parameters for LDAP,
databases, database clients, transactions, resource manager, logging, load
balancing, engines and KAS.

Logs pertaining to administration and deployment are stored in the
Administration Server, known as KAS. The other servers that store message and
event logs are KJS (Java Server), KCS (C++ Server) KXS (Executive Server). KAS
starts the other three servers and monitors their activities.

This section contains the following topics:

• Determining the Logging Destination

• Managing Log Files

Determining the Logging Destination
You can configure the logging service to record server and application messages in
any or all of the destinations described in the following table:
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When you enable logging, the logging service automatically sends messages to the
process consoles on Windows and Solaris platforms, as long as those consoles are
open and console logging is enabled. On Windows, the logging service also sends
messages to the application log. Logging to a process console does not record the
messages. You cannot retrieve the messages once they scroll off of the screen.

Table 4-2 Message Logging Destinations

Log destination Description When to use

Process Consoles iPlanet Application Server
process consoles display log
messages as they are
generated.

This is the default. If logging is
enabled and the server is enabled for
automatic startup (UNIX) or
interaction with the desktop (NT),
the consoles open and display the log
messages. To disable this feature,
deselect the Log to Console
checkbox.

Application log The default application log
file. For Windows NT, this
can be viewed through the
Event Viewer.

This is the default. Warning and
information messages are not logged
to the application log. The
application log provides a more
comprehensive record of the server
and application error messages.

All messages are sorted by their
timestamp.

ASCII text file An ASCII text file, which
you must create and
specify.

Use when you want a more
permanent record of the server and
application messages. All messages
are sorted by their timestamp.

Database table A database table which you
must create and specify.

This is the most versatile logging
destination. Use when you want to
sort, group, and create reports of the
logged messages.
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To Specify Log Destination
To enable the logging service and specify the destination of the log messages,
perform the following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.

2. Select the iPlanet Application Server instance for which you want to specify log
settings.

3. In the right pane of the Logging window, click the Server Event tab.

4. In the Server Event tab, select Enable Server Event Log checkbox.

5. In the Log Target box, choose the type of logging to enable, by marking the
required checkboxes:

❍ Log to a Database

All messages/errors will be stored in a database-format file.

❍ Log to Console

All messages/errors will be displayed in the console window for that
particular process.

❍ Log Errors Windows NT Application Log

This option is applicable on Windows only. The messages/errors can be
viewed in the Event Viewer. To start Event Viewer, go to Start > Programs
> Administrative Tools > Event Viewer.

❍ Log to File

All messages/errors will be logged to the specified file.

NOTE iPlanet Application Server uses a log buffer to store messages before
they are written to the application log, an ASCII file, and/or
database logs. If a log is updated continuously, the time taken for
this effort will negatively affect the performance of the application
server.

This buffer limits the use of resources by storing messages, till a log
is updated. The buffer is written to the destination when either the
buffer interval times out or the number of entries in the buffer
exceeds the maximum number allowed.
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The log file is created when you enable the Log to a File option. For
more information, see To Log to a File.

For more information about managing log files, see “Managing Log Files,” on
page 87.

This section contains the following topics:

• Logging to a Database

• Logging to a Console

• Logging Server Events to a File

Logging to a Database
To log application server messages to a database, you need to create an event log
database table. The following table describes the four field names and lists each
field’s data type.

NOTE To enable KAS Audit logs to output to a file on Windows, set
the IAS_KASLOGFILE environment variable to 1. By default it
is set to 0. For more information, see “To Log to a File on
Windows,” on page 86.

NOTE On both Windows and Solaris systems, you can use supplied
scripts that automatically set-up the eventlog and httplog tables.

The scripts are located in the directory
<iASInstallDir>/ias/ias-Samples/dblog/src/schema, and are
named Log_db2.sql, Log_ifmx.sql, Log_mssql.sql,
Log_ora.sql, and Log_syb.sql.

Choose the script that is appropriate for the database you’re using.

Table 4-3 Logging to a Database Table

Database field name Description Data type

evttime Date and time the message was created Date/Time

evttype Message type, such as information,
warning, or error

Number

evtcategory Service or application component ID Number
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The logging service maps the message components to the database fields listed in
the table. You must use these exact field or column names in your database table.

To Log to a Database
To log to a database, perform following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.

2. In the left pane of the Logging window, select the iAS node for which you want
to specify log settings.

3. In the right pane of the Logging window, click the Server Event tab.

4. In the Server Event tab, mark the Enable Server Event Log checkbox.

5. In the Log Target box, click the Log to Database checkbox, as shown in the
following figure:

evtstring Message text Text

evtid Event ID Number

Table 4-3 Logging to a Database Table

Database field name Description Data type
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Specify the data source, the database name, the table name, and the user name
and password necessary for accessing the database.

6. In the General box, from the Message Type drop-down box, select Errors,
Errors and Warnings, or All Messages.

7. Click Apply Changes to save your changes to iASAT.

Logging to a Console
Enable the Log to Console checkbox when you want to see the log output as they
are generated. The log messages are displayed in a console window on your
monitor.

To Log to Console
To log information to a file, perform the following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.
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2. Click Server Event.

3. Select the Enable Server Event Log checkbox.

4. In the Log Target section, select Log to Console.

5. In the General box, from the Message Type drop-down box, select Errors,
Errors and Warnings, or All Messages.

6. Click Apply Changes to save your changes to iASAT.

Logging Server Events to a File
To record all KAS messages in a log file, you should enable KAS logs to be saved as
a file.

When you enable logging to file using the iPlanet Application Server
Administration Tool, messages pertaining to KJS, KXS and CJS are logged.
However, as KAS manages all the server engines and other administrative aspects,
the messages that are generated can be voluminous.

On Solaris, all KAS messages are logged to file, by default. On the Windows
platform, you need to manually enable logging of KAS messages to a file. For more
information, see “To Log to a File on Windows,” on page 86.

To Log to a File
iASAT’s monitoring service allows you to log information about server activity to a
file.

To log information to a file, perform the following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.

2. In the left pane of the Logging window, click the Server Event tab.

3. In the Server Event tab, mark the Enable Server Event Log checkbox.

4. In the Log Target pane, mark the Log to File checkbox.

5. In the Log to File text field, enter the name of the log file.

6. In the General box, from the Message Type drop-down box, select Errors,
Errors and Warnings, or All Messages.

7. Click Apply Changes to save your changes to iASAT.

To Log to a File on Windows
To enable KAS logging to file on the Windows platform, do as follows:
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1. Open Control Panel and double-click the System icon.

2. Navigate to the Environment tab.

3. Locate the IAS_KASLOGFILE variable, in the System Variables list.

4. Change the default value to 1 and click Set.

KAS log messages are logged in the file KAS.log which can be found in the
following path:

<iASInstallDir>/ias6/ias/logs/

Managing Log Files
Log files can be rotated when a set period ends. For example, you can specify that
your log files are rotated every 10 days, or every Wednesday, so that only the
current logs exist in the log file. Since log files are stamped with the time and date
on which they are created, log file rotation helps organize them into manageable
units.

If you choose to record server messages in an ASCII file, you can enable log file
rotation to regulate the entries periodically.

To Rotate Log Files
To configure log file rotation, perform the following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.

2. Select the iPlanet Application Server node for which you want to specify log
settings. The following figure appears:
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3. In the right pane of the Logging window, click the Server Event tab.

4. In the Server Event tab, select the Enable Server Event Log checkbox.

5. Mark the Log to File checkbox.

6. Choose Yes from the Enable File Rotation drop-down list.

7. Select the interval at which log files are to be rotated, from the Rotation Interval
drop-down list. You can also enter a string to indicate when the log file is
rotated.

For instance, the following string indicates logging to a new file begins at 1:00
AM every Monday, as well as on the fifteenth of each month:
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The following string indicates logging to a new file begins at 2:00 AM, 5:00
AM, 6:00 AM, and 7 AM every Friday:

8. In the General pane, from the Message Type drop-down box, select Errors,
Errors and Warnings, or All Messages.

9. Click Apply Changes to save your changes to iASAT.

About Logging HTTP Requests
Web server requests are monitored by the Web Connector Plug-in. The plug-in
sends requests to your iPlanet Application Server instance, where they are
processed. By logging web server requests, you can track request patterns and
other important request information.

This section includes the following topics:
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• How Web Requests Are Logged

• To Log Web Server Requests

How Web Requests Are Logged
A web server request is divided into components. These components are
standardized HTTP variables used by the web server to manage web requests.
iPlanet Application Server includes a subset of these HTTP variables for you to log.
You can add variables to the list if you need to log additional information.

Each HTTP variable must be mapped to a database field name within a table that
you create. For instance, to log the length of the content of a web server request,
map the CONTENT_LENGTH variable to a database field named, for example,
content_length and defined as a text data type. The default HTTP variables
used by iPlanet Application Server and their database data types are listed in the
following table. Use this table to help you create the database table for logging web
requests.

NOTE On both Windows and Solaris systems, you can use supplied
scripts that automatically set up the HTTP log and event log tables.
See To Log to a Database, for more information.

Table 4-4 HTTP Variables and Database Data Types

Default HTTP variables Default database field name Data type

Not applicable logtime Date/Time

CONTENT_LENGTH content_length Number

CONTENT_TYPE content_type Text

HTTP_ACCEPT accept Text

HTTP_CONNECTION connection Text

HTTP_HOST host Text

HTTP_REFERER referer Text

HTTP_USER_AGENT user_agent Text

PATH_INFO uri Text

REMOTE_ADDR ip Text
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You can rename all the database field names except the logtime fieldname in the
database table. The logging service maps that time that the message was created to
the logtime database field.

The fields from the database table are automatically mapped to web server
variables in the registry.

You must have a web server communication plug-in module such as NSAPI or
ISAPI installed and properly configured.

To Log Web Server Requests
Before you can log web server requests, you must create a database table to hold
the request messages. For more information about creating this table, see How Web
Requests Are Logged.

To log web server requests, perform the following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.

2. From the left pane of the Logging window, select the iPlanet Application
Server responsible for logging web server requests.

If you have more than one instance of iPlanet Application Server, you can
specify one server to log all web server requests.

3. In the right pane of the logging window, click the HTTP tab.

The following window appears:

REQUEST_METHOD method Text

SERVER_PROTOCOL protocol Text

Table 4-4 HTTP Variables and Database Data Types

Default HTTP variables Default database field name Data type
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4. Enter httplog in the Data Source field.

5. Provide the information you use to connect to the database in the Database
field. For example, this would be the Oracle SID for an Oracle database.

6. In the Table Name field, enter httplog.

7. Provide the user name and password with which you connect to the database.

8. Enter a number in the Maximum Entries field. This number represents the
greatest number of entries that can exist before data is written to the log.

9. Specify the required value in the Write Interval text field.

This number represents the amount of time that lapses before data is written to
the log.

10. Click Apply Settings to save your changes.

About Logging DSync Messages
iPlanet Application Server supports Distributed Data Synchronization (DSync)
across multiple iPlanet Application Server for partitioned and distributed
applications. DSync provides cluster management and data synchronization across
iPlanet Application Server processes. iASAT provides for logging of DSync
messages.
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For more information about distributed data synchronization, see About
Distributed Data Synchronization.

This section includes the following topics:

• How DSync Messages Are Logged

• To Log DSync Messages

How DSync Messages Are Logged
DSync provides a component based architecture that allows you to choose which
components you want to log. All DSync debug messages appear in KXS, KCS, and
KJS log files. DSync debug components are the following:

❍ Module: Provides data management and appends other DSync
components to the log file. When enabled, the methods executed by DSync
are logged.

❍ Failover: Provides cluster membership management. When enabled,
interactions between servers and how roles change due to failure of
servers/engines/network connection are logged.

❍ Token: Provides distributed lock management features. When enabled,
interactions between servers for read/write tokens associated with DSync
nodes are logged.

❍ Timeout: Provides life cycle management of DSync nodes per timeout
specification. When enabled, nodes that are deleted due to timeout are
logged.

❍  Messenger: Provides message communication between iPlanet
Application Server servers. When enabled, messages that are created, sent,
received and processed are logged.

In addition, you can dump cluster and DSync node data into
iasdsync-cluster-XXX.log and iasdsync-node-XXX.log files respectively,
where XXX represents the port number of an engine.

Format of the Cluster Dump Files
Each iasdsync-cluster-XXX.log file consists of the following sections:

• Cluster

• Message queue
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The cluster information reports how an engine views the current Dsync cluster as
follows:

****************************

*DSync Cluster State

***************************

Host: 0xd00c3643

Port: 10818

Role: SyncPrimary

Current Engine’s order #:1

SyncPrimary: this engine

Is connect to primary? NO

Changing primary? NO

Max number of SyncBackup#=1

SyncLocal[1]:0xd00c3643:10821

SyncLocal[2]: 0xd00c3643:10822

The message queue information displays the list of messages that are in the DSync
queues as follows:

****************************************

*DSync RecvQueue for GXP_DSYNC protocol

****************************************

Message[1]: GXDSYNC_MSG_RECLAIM_RDTOKEN(/dsync41test/K/5)from
0xd00c3643:10818

...

Format of the DSync Node Dump Files
Each iasdsync-node-XXX.log consists of the following sections:

• Message queue

• Node Data

• Timeout Manager

The message queue information displays the list of messages that are in the DSync
queues as follows:

****************************************
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*DSync RecvQueue for GXP_DSYNC protocol

****************************************

Message[1]: GXDSYNC_MSG_RECLAIM_RDTOKEN(/dsync41test/K/5)from
0xd00c3643:10818

...

The node data section displays the collection of nodes stored in an engine as
follows:

****************************

*DSync Token State

***************************

[1] ID:/

Status: without Read or Write Token

Scope: GLOBAL

[2} ID:/dsync41test

Status: without Read or Write Token

Scope: GLOBAL

Owner Thread: 0xf6f040 (Id=0xf78d50)

Standard wait queue[1] thread 0xf88670 (Id=0xf883a0)

Standard wait queue[1] thread 0xf89d60 (Id=0xf89a90)

Child[0]:B

Child[1]:A

Child[2]:D

Child[3]:C

Attribute[NextPath]:N

[3]..

The timeout manager section displays the set of nodes that are managed by DSync
timeout manager in the current engine as follows:

****************************************

*Timeout Manager State

****************************************
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Entry[0]: ID=/dsync41test/S/4, expired 6 seconds ago

Entry[1]: ID=/dsync41test/U/4, expired 4 seconds ago

Entry[2]: ID=/dsync41test/W/4, expired 3 seconds ago

Entry[3]: ID=/dsync41test/V/4, expired 3 seconds ago

Entry[4]: ID=/dsync41test/X/4, expired 3 seconds ago

Entry[5]: ID=/dsync41test/D/5, expired 2 seconds ago

Entry[6]: ID=/dsync41test/Z/4, expired 2 seconds ago

Entry[7]: ID=/dsync41test/A/5, expired 1 seconds ago

Entry[8]: ID=/dsync41test/B/5, 0 seconds till expiration

Entry[9]: ID=/dsync41test/C/5, 0 seconds till expiration

Entry[10]: ID=/dsync41test/E/5, 0 seconds till expiration

Entry[11]: ID=/dsync41test/F/5, 1 seconds till expiration

Entry[12]: ID=/dsync41test/H/5, 2 seconds till expiration

To Log DSync Messages
To log DSync debug messages, perform the following tasks:

1. Click Logging on the iASAT toolbar to open the Logging window.

2. From the left pane of the Logging window, select the iPlanet Application
Server responsible for logging DSync messages.

3. In the right pane of the logging window, click the DSync tab.

The following window appears:
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4. Specify the DSync components you want to log. See Format of the DSync Node
Dump Files for more information on DSync components that you log.

When specifying DSYNC components, you do not have to shutdown and
restart iPlanet Application Server for changes to take affect.

5. (Optional) Click Dump Cluster Info to dump DSync state cluster information
to a iasdsync-cluster-XXX.log file where XXX is the port number of an
engine.

For information about the format of this log file, see Format of the Cluster
Dump Files.

6. (Optional) Click Dump Node Info to dump DSync state node information to a
iasdsync-node-XXX.log file where XXX is the port number of an engine.

For information about the format of this log file, see Format of the DSync Node
Dump Files.



About Logging DSync Messages

98 iPlanet Application Server Administrator’s Guide • October 2002



99

Chapter 5

Securing iPlanet Application Server

This chapter describes how to implement iPlanet Application Server security.

The following topics are included in this chapter:

• About Security

• Storing and Managing Users and Groups

• Setting Authorization to Access Application Components

• Enabling Encryption Between Web Server And Application Server

• Using Firewalls for Security

• Configuring Firewalls With iPlanet Application Server

About Security
Implementing application security is a joint effort between the application
developers and the server administrator; application developers are responsible for
determining the level of security to implement and implementing that level into
their applications; the administrator is responsible for managing the users and
groups who use the application.

The administrator is also responsible for managing authorization to application
components within an application. For Java applications using J2EE standard
components, authorization is implemented via roles. Roles are created during
deployment time using the iPlanet Application Server Deployment Tool and
administered using the iPlanet Application Server Administration Tool (For more
information about the Deployment Tool see the online Help system that is
provided with the tool.). For C++ applications, authorization is implemented via
access control lists that are stored in LDAP and managed using iASAT.
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This chapter explains how to set up users and groups and then how they are used
to secure applications. It also describes how user entries are stored in iPlanet
Directory Server and managed using iPlanet Console and LDIF. The following
topics are described in this section:

• Limitations of This Document

• What Is LDAP?

• What Is iPlanet Console?

Limitations of This Document
This chapter provides descriptions of the basic start-up tasks you must perform
when setting up Directory Server in association with your instance of iPlanet
Application Server, as well as how to use iPlanet Console to manage users and
groups. See iPlanet Directory Server and iPlanet Console documentation for
detailed instructions and descriptions of these products.

You can find Directory Server documentation installed with your instance of
iPlanet Application Server in the following location:

iASInstallDir/manual/en/slapd/

iPlanet Console documentation is available on iPlanet’s web site in the following
location:

http://docs.iplanet.com/docs/manuals/console.html

What Is LDAP?
Every instance of iPlanet Application Server uses Directory Server to store shared
server information, including information about users and groups. Directory
Server supports Lightweight Directory Access Protocol (LDAP) versions 2 and 3.
LDAP is an open directory access protocol that runs over TCP/IP. It is scalable to a
global size and millions of entries. Using Directory Server, you can store all of your
enterprise’s information in a single, centralized repository of directory information
that any application server can access via the network.

iPlanet Directory Server is installed with each instance of iPlanet Application
Server.

The types of Directory Servers that can be configured for iPlanet Application
Server are as listed below:
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Master LDAP Server. The LDAP server that maintains the master data.

Consumer LDAP Server. The LDAP server that contains a copy of the data that is
maintained by the master LDAP server. Multiple consumer LDAP servers can be
configured for iPlanet Application Server.

Primary LDAP Server. The first LDAP server that is configured to iPlanet
Application Server, for configuration information.

Backup LDAP Server. The second LDAP server that is configured to iPlanet
Application Server. iPlanet Application Server connects to this server if the
primary LDAP server fails. Multiple backup LDAP servers can be configured for
iPlanet Application Server.

What Is iPlanet Console?
iPlanet Console is a stand-alone Java application. It finds all resources and
applications registered in Directory Server, and displays them in a graphical
interface. iPlanet Console functions independently of any server, and you can use it
from any computer or workstation connected to your enterprise.

iPlanet Console is installed with each instance of iPlanet Application Server. You
use iPlanet Console to manage users and groups for iPlanet Application Server.
You can also use iPlanet Console to launch the iPlanet Application Server
Administration Tool, but only for local instances of iPlanet Application Server --
that is, instances of iPlanet Application Server installed on the same machine as
iPlanet Console. You must launch remote instances of iPlanet Application Server
from the command line or from the Windows NT start menu.

Storing and Managing Users and Groups
The information you specify for each user and group you create is stored in the
Directory Server. The information held in Directory Server is shared between all
application servers when you have multiple servers supporting an application.

This section provides information for the following topics:

• Implementing Security

• Using iPlanet Console to Add Entries to Directory Server

• Modifying Database Entries Using iPlanet Console
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• Using LDIF to Add Entries to Directory Server

• Creating Entries Programmatically

Implementing Security
If access to an application consists of authenticating a user’s user name and
password, the user name and password must be stored in the Directory Server.

An application starts the user authentication process by calling the application
component—usually a servlet—responsible for user authentication. The user’s
login privileges are then verified against the list of users stored in Directory Server.

The authentication process verifies access to an application based on a user’s name
and password. To implement authentication, you must create a user profile, which
holds the user name and password, for all users of an application. This procedure
is described in Using iPlanet Console to Add Entries to Directory Server.

Once a user is successfully authenticated, access to specific application components
implementation depends on the type of application: Java application using J2EE
standard components or C++ applications.

Authorization for J2EE Applications
Access to application components responsible for application security is based on
declarative role information defined in the deployment descriptor XML file.
Security can also be defined programmatically during development by using
security APIs such as isCallerInRole() provided by J2EE. See iPlanet Application
Server Developer’s Guide for more information.

Authorization for C++ Applications
Access to application components responsible for application security is managed
declaratively using access control lists provided in the iPlanet Application Server
Administration Tool. Security can also be defined programmatically during
development by using the LDAP JDK included with each installation of iPlanet
Application Server. See iPlanet Application Server Developer’s Guide for more
information.

NOTE There are types of authentication other than verification of user
name and password. For example, some applications authenticate a
user through a certificate.
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Using iPlanet Console to Add Entries to
Directory Server
You use iPlanet Console to create user entries and group entries to iPlanet
Directory Server. A user entry contains information about an individual person or
object in the directory. A group consists of all users who share a common attribute.
For example, all users in a particular department might belong to the same group.

What Is a Distinguished Name (DN)?
Each of the users and groups in your enterprise is represented in Directory Server
by a distinguished name (DN). A DN is a text string that contains identifying
attributes. You use DNs whenever you make changes in the directory's users and
groups database. For example, you need to specify DN information each time you
create or modify directory entries, set up access controls, and set up user accounts
for applications such as mail or publishing. The users and groups interface of
iPlanet Console helps you create or modify DNs.

For example, this might be a typical DN for an employee of iPlanet
Communications Corporation:

uid=doe,e=doe@iplanet.com,cn=John Doe,o=Sun Microsystems,c=US

The abbreviations before each equal sign in this example have the following
meanings:

• uid: user ID

• e: email address

• cn: the user's common name

• o: organization

• c: country

DNs may include a variety of name-value pairs. They are used to identify both
certificate subjects and entries in directories that support LDAP.

SSL Authentication and Distinguished Names
The iPlanet Application Server’s SSL Mutual Authentication uses the
Distinguished Names which are found within the X509 SSL client certificates. Once
the application server has been presented with a valid client certificate, it examines
the Subject DN contained within it looking for a candidate field to use in
authenticating the client.
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iPlanet Application Server looks for the following fields in order of uniqueness and
searches the Directory Server entries for one whose uid field matches the value
from the certificate attribute chosen:

User Ids
1. uid

2. oid.2.3.4.45

3. 0.9.2342.19200300.100.1.1

Email Addresses
4. emailaddress

5. email

6. e

Common Name
7. cn

To Create User Entries Using iPlanet Console
User security is best suited for applications that have a small number of known
users. You must create a user profile for each user who accesses the application.

You must be a Directory Server administrator or a user with the necessary
permissions to create a user.

To create a new user entry in iPlanet Directory Server using iPlanet Console,
perform the following steps:

1. On Windows Systems.

From the Windows Start menu, click Programs>iPlanet Server Products>

Select iPlanet Console 5.0.

On Solaris Systems.

Navigate to the iASInstallDir path, and type the following command:

./startconsole.

The iPlanet Console login dialog box appears:
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2. In the User ID text field, provide the user name that was specified during
iPlanet Application Server installation.

3. In the Password field, type in the password that you provided for the iPlanet
Console Administration Server, during iPlanet Application Server installation.
iPlanet Console’s main window appears, as shown in the following figure:

For more information on creating users and groups, see the documentation
included with iPlanet Console 5.0.
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Modifying Database Entries Using iPlanet
Console
Before you can modify user or group data, you must first use the Users and Groups
Search function to locate the user or group entry in the user directory. You can then
select operations from the menu toolbar to change the entry. The operations you
perform apply to all users in the Search list.

See iPlanet Console documentation for more information.

Using LDIF to Add Entries to Directory Server
Directory Server uses the LDAP Data Interchange Format (LDIF) to describe a
directory and directory entries in text format. LDIF is commonly used to initially
build a directory database or to add large numbers of entries to the directory all at
once. You can also add or edit entries using the ldapmodify command along with
the appropriate LDIF update statements.

To add entries to the database using LDIF, first define the entries in an LDIF file,
then import the LDIF file from Directory Server.

Formatting LDIF Entries
LDIF consists of one or more directory entries separated by a blank line. Each LDIF
entry consists of an optional entry ID, a required distinguished name, one or more
object classes, and multiple attribute definitions.

The basic form of a directory entry represented in LDIF is:

dn: distinguished name

objectClass: object class

objectClass: object class

...

attribute type[;subtype]:attribute value

attribute type[;subtype]:attribute value

...
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You must supply the DN and at least one object class definition. In addition, you
must include any attributes required by the object classes that you define for the
entry. All other attributes and object classes are optional. You can specify object
classes and attributes in any order. The space after the colon is also optional. For
information on standard object classes and attributes, refer to the iPlanet Directory
Server documentation at:
http://docs.iplanet.com/docs/manuals/directory.html

Modifying Database Entries Using ldapmodify
You use the ldapmodify command-line utility to modify entries in an existing
Directory Server database. ldapmodify opens a connection to the specified server
using the distinguished name and password you supply, and modifies the entries
based on LDIF update statements contained in a specified file. Because ldapmodify
uses LDIF update statements, ldapmodify can do everything that ldapdelete can
do. Most of Directory Server's command-line utilities are stored in a single location.
You can find them in the following directory:

<iASInstallDir>/bin/slapd/server

The command line tools ldapdelete, ldapmodify, and ldapsearch—are stored in
the following directory:

<iASInstallDir>/shared/bin

The following is an example of the command used to add a user to an LDIF file:

ldapmodify -h myserverhost -p 389 -D “Directory Manager” -w admin -a
-f MyUsersFile

Creating Entries Programmatically
You can also create entries programmatically within an application using the
LDAP JDK included with each installation of iPlanet Application Server. See the
Developer’s Guide (Java) for more information.

Setting Authorization to Access Application
Components

Authorization to access application components depends upon the type of
application:
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• For Java Applications (using J2EE standard components), authorization is set
via roles. See Setting Role-Based Authorization (for J2EE Applications).

• For C++ Applications, authorization is set by permissions in access control
lists. See Setting Access Control List Authorization (for C++ Applications).

This section includes the following topics:

• Setting Role-Based Authorization (for J2EE Applications)

• Setting Access Control List Authorization (for C++ Applications)

Setting Role-Based Authorization (for J2EE
Applications)
Roles for an application component are set globally for all application components
within a module. From the Administration Tool, you can add a role to an
application module and set the users and groups who belong to a role. Access is
granted to any application component within a module if the requestor is a
member of a pre-defined role.

If a user is not a member of a role, the application can direct the user to re-login,
prompt the user to exit the application, or direct the user to a different part of the
application.

Managing Roles for EJBs and Servlets
You need to use iPlanet Application Server Administration Tool (iASAT) to
manage the roles of deployed applications. When you manage roles, you can
specify groups to which users belong and add only groups to the role rather than
adding individual users as members to the role. This is useful if you are using
individual user-based security; you save the administration maintenance of
updating users in the role when users change.

For example, if you have created users for an web bank application and a user
closes all accounts, you need to remove that user only from the appropriate group
or groups, as opposed to removing the user from the groups and any roles.

To manage a role, perform the following steps:

NOTE Roles for servlets and EJBs are created in the deployment descriptor
XML files before deployment. See the online help that is provided
with the Deployment Tool for more information.
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1. On the iASAT toolbar, click Application to open the Application window.

2. In the left pane of the Application window, expand the iPlanet Application
Server instance where the application is deployed.

3. Open the application folder and highlight a servlet or EJB icon, as shown in the
following figure:

4. In the right pane of the Application window, click the roles tab to view the
roles and role members that have been defined for this EJB/servlet.

5. Highlight the role that you want to manage and click Edit Role, at the bottom
of the window.

The Edit Role dialog box opens showing you all the users and groups that are
currently members of this role.
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6. To add a group and a user to a role, complete the following:

a. To add a group to a role, in the Available Groups box, highlight one or
more groups and click the right-arrow button.

b. To add a user to a role, first highlight a group to which the user currently
belongs from the Available Groups list and then highlight the user(s) in the
Users in Group box. Finally click the right-arrow button to add the user to
the role.

7. To remove a group or user from a role, highlight the user(s) and or group(s) in
the Users/Groups in Role box and click the left-arrow.

Setting Access Control List Authorization (for
C++ Applications)
Access control lists (ACLs) allow you to set permissions for users and groups. A
permission relates to an action the user is allowed to perform, such as read or
write.

NOTE When you select multiple groups from the Available Groups box,
the users in the Available Users box are not displayed.
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iPlanet Application Server comes with default permissions, but you can also create
your own application-specific permissions and ACLs. The information in an ACL
is used by the application to verify the permissions of the current user or group for
an action the user attempts.

If a user does not have a certain permission, the application can direct the user to
re-login, prompt him to exit the application, or direct him to a different part of the
application.

Creating an Access Control List
You need to use iASAT to create and manage access control lists (ACLs). When
creating an ACL, you can create groups to which users belong and add only groups
to the ACL rather than adding individual users as members to the ACL. This is
useful if you are using individual user-based security; you save the administration
maintenance of updating users in the ACL when users change.

For example, if you have created users for an intranet application and a user leaves
the company, you need to remove that user only from the appropriate group or
groups, as opposed to removing the user from the groups and any ACLs.

To create an access control list, perform the following steps:

1. On the iASAT toolbar, click Security to open the Security window.

The following window appears:

2. Click New. The New Access Control List dialog box appears, as shown in the
following figure:
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3. In the Access Control List text field, enter a name for the ACL.

The name can be any word or words you choose to distinguish one ACL from
another.

4. To add a user or group to the ACL, click Add User or Group.

The Add User or Group dialog box appears.

5. Select the users and/or groups you want to add to the ACL.

You can filter the list of users that appears in the result set by entering a string
in the User Filter text box. For instance, to show only user IDs that begin with
“F,” enter F* in the User Filter text box, then click the icon next to the User
Filter text box. The user IDs matching your filter criteria appear in the list box
below. The User Filter applies only to users, not to groups.

6. Click OK.

7. To add a new permission to the ACL, click New Permission.
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The New Permission dialog box appears.

8. Provide a new permission action word.

A permission defines the level of access a user or group has to a particular
application or part of an application.

9. Click OK.

10. To set the appropriate permissions for the groups in the ACL, check each
permission for that group.

Modifying an Access Control List
You can modify the following ACL properties:

• add groups

• create new permissions

• edit permissions

You can also remove groups from the system.

To modify an access control list, perform the following steps:

1. On the iASAT toolbar, click Security to open the Security window.

The following window appears:
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2. Highlight the Access Control List that you want to modify.

3. Click Modify. The Modify Access Control List dialog box appears.

4. To add a new user or group, click Add User or Group. The Add User or Group
dialog box appears.
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5. Select the group or groups you want to add to the ACL.

You can filter the list of users that appear in the list by entering a string in the
User Filter text box. For instance, to show only user IDs that begin with “F,”
enter F* in the User Filter text box, then click the icon next to the User Filter
text box. The user IDs matching your filter criteria appear in the list box below.
The User Filter applies only to users, not to groups.

6. Click OK.

7. In the Modify Access Control List window, click New Permission to create a
new permission.

The New Permission dialog box appears.

8. Provide a new permission such as Read, Write, in the Permission text field and
click OK.

9. In the Modify Access Control List window, you can edit the permissions for a
group, by selecting or deselecting the checkboxes next to the permissions.

10. To remove a group, select that group and click Remove in the Modify Access
Control List window.
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Enabling Encryption Between Web Server And
Application Server

You can selectively encrypt the traffic between Web Server(s) and Application
Server(s). The Executive Server (KXS) manages the traffic between the servers. You
may need to enable encryption for components that require high security, such as
servlets that gather credit card information, login servlets, etc. Components are
encrypted using 128 bit keys and RSA BSafe 3.0 library, which ensures safe transfer
of information.

This section also describes how you can verify the encryption details in KXS logs
and how to create a cryptext key for encryption.

The following topics are included in this section:

• To Enable Encryption Between Web Server And Application Server

• To Verify The Encryption Log Messages

• To Enable Encryption For Each J2EE Component

To Enable Encryption Between Web Server And
Application Server
To enable encryption of traffic between Web Server(s) and Application Server(s),
perform the following steps:

1. Open iPlanet Registry Editor.

(See “About iPlanet Registry Editor,” on page 32)

2. Open the following key:

SOFWARE/iPlanet/Application Server/6.5/CCSO/Security/

3. You will see a value that looks like this; EnableEncryption=0. By default,
encryption is disabled. To enable encryption, modify this value to read
EnableEncryption=D (D stands for Domestic 128 bit data type string).
Encryption is now enabled.
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To Verify The Encryption Log Messages
To verify the encryption log messages in the KXS log file, perform the following
steps:

1. Open iPlanet Registry Editor.

(See “About iPlanet Registry Editor,” on page 32)

2. Open the following key:

SOFWARE/iPlanet/Application Server/6.5/CCSO/Security/

3. From the Edit menu, choose Add Value. The Add Value dialog box appears, as
shown in the following figure:

4. In the Name field, type LogEncryption.

5. In the Value field, type 1.

6. From the Type drop-down list, select Integer.

When you create this key, encryption log messages will be logged in the KXS logs.

To Enable Encryption For Each J2EE
Component
To enable encryption for individual J2EE components such as JSPs and Servlets
(encryption cannot be enabled for EJBs) perform the following steps:

1. Open the ias-web.xml file of the application for whose component you want
to enable encryption.

2. Search for and locate the servlet or JSP for which you want to enable
encryption.

3. Locate the <encrypt>false</encrypt> tag for the component. Change false to
true.
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4. Register the application using iasdeploy.

To verify that the encryption is enabled and working, open KXS logs and search for
messages that are similar to the following:

[11/Jan/2001 19:58:43:0] info: CRPT-001: Encrypting 2309 bytes,
keysize = 128 bits

[11/Jan/2001 19:58:43:5] info: NSAPICLI-012: plugin reqstart,
tickct: 1903570535

[11/Jan/2001 19:58/:43:5] info: NSAPICLI-009: plugin reqexit:
Os+.12995s. (198114 0537)

[11/Jan/2001 19:58:52:2] info: CRYPT-004: Decrypting 1897 bytes,
keysize = 128 bits

Note that if you enable encryption for a component, encryption will take place
even if it has been disabled in iPlanet Registry.

Using Firewalls for Security
iPlanet Application Servers are typically deployed together with web servers and
client databases applications. In this scenario, inter-process communication is of a
very high level and this makes and data integrity and security issues very
important. To ensure smooth and secure communication between application
servers, web servers and the client applications that run on application servers,
security components of the system are frequently separated by firewalls.

This section describes how you can effectively plan and deploy iPlanet Application
Servers in fire-wall protected environments. The following topics are described in
this section:

• Basics of Network Security

• iPlanet Application Server Architecture

• Inter-Process Communication Protocol

• Encrypting Data Channels

NOTE All the addresses and port numbers listed in this document are
default values. These may be changed during install, or later by
modifying values stored in the appropriate registries. If these are
changed, then the appropriate modifications will need to be applied
to firewall configuration parameters.
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Basics of Network Security
Private networks, such a company’s Local Area Network (LAN) are not directly
connected to public networks such as the Internet, but pass through a firewall
which is intended to control access. Access to public networks is controlled using
approved protocols on the approved port numbers of specific machines.

Types of Firewalls
There are many different types of firewalls, each with its own set of advantages
and disadvantages. Firewalls do not necessarily consist of simply one type of
machine, but typically involve other machines that may be present. These other
systems may configured to provide basic traffic routing, but may or may not be
configured to provide firewall functionality. The three main types of firewalls are
described in the following sections:

Routers
These are fast, and in the simpler versions, relatively cheap. At their most basic,
they sit between two networks, and relay connections between them.
Configuration parameters can be specified to allow or disallow connections to or
from individual IP Addresses or ranges of IP Addresses.

More complex versions of routers will inspect data to determine the security
protocol being used, and the port number to which the security protocol is
addressed. Control can be exercised on connections using specific protocols and
directed to specific ports (filters).

Routers can be machines built specifically for the task, or can be implemented
using a computer (typically running UNIX operating system) with multiple
network interfaces. The advantage of using a general purpose machine as a
dedicated router is that the router can also run proxy servers.

Proxy Servers
Proxy Servers are normally used in conjunction with some form of router to ensure
that data access can be only through the proxy server. A proxy server usually sits
on a machine that either straddles the firewall, or more frequently, sits behind a
primary router on a small, dedicated network often known as a De-Militarized
Zone (DMZ), with another router between the proxy server and the private
network. The proxy system is generally a very basic, stripped down system which
has few or no normal user applications, just programs which act as proxy servers
for various protocols.
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A proxy server is designed to act as a server to some client inside the private
network. For example an HTTP proxy server will behave as an HTTP server as far
as a web browser on the private network is concerned. The browser will connect to
the HTTP proxy server and send a request for a document. The HTTP proxy server
will then in turn act as a browser and will connect to the server from which the
document has been requested. The remote HTTP server is not aware of the proxy
server. When the HTTP proxy server gets the requested document, it scans the
document for viruses before passing it on to the users’ browser on the private
network. The actions that the HTTP proxy server performs before surrendering the
document to the browser can be specified in the HTTP proxy server. This enables
additional security and also ensures the quality and wholesomeness of
information.

Stateful Inspection Firewall
An increasingly popular form of firewall is a machine, which doesn’t simply route
information, but also inspects the contents of information packages. Using the
information obtained, higher level protocols can be determined. This can extend
right up to the level of application protocols. Once the communication protocols
have been established the system uses state tables to determine which operations
to allow until the protocol enters a new state.

For example, let us assume that an incoming telnet connection will be a TCP/IP
(Transmission Control Protocol/Internet Protocol) connection directed to port
number 23 on the destination machine. The telnet server will respond with the
number of a port, to which the telnet client should connect. The statefull inspection
firewall system will recognize the telnet opening state, and examine the returned
data for the port number to which the client should connect. When the host (the
machine that initiated the connection) directs the connection to the destination
port, the statefull inspection firewall system will allow the connection. Other
random connections to non-standard ports will normally be denied.

Statefull inspection firewalls are fast because not all data has to be examined. They
can be used for general purpose security, unlike proxy servers, which need to be
specifically created to handle a given protocol. Creating a proxy for a new protocol
can also take a significant amount of time. With a statefull inspection firewall
system, a new state table can be created quickly and easily, often by simply
monitoring the new protocol to determine appropriate state transitions and
actions.

The ensuing sections describe the architecture of iPlanet Application Server and
the how communication takes place within iPlanet Application Server.
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iPlanet Application Server Architecture
iPlanet Application Server is composed of several modules. The basic component is
the Executive Server (KXS) which creates the components of the application,
manages per session data, load monitoring and load-balancing with other
instances of iPlanet Application Server.

The application code runs in multi-threaded processes created by KXS. There are
two types of processes; the C++ Server (KCS) and the Java Server (KJS).

The system is managed through the Administration Server (KAS). The web server
may be installed on the same machine as iPlanet Application Server, but will
typically be installed on a separate machine.

The communication between the web server and iPlanet Application Server is
through a plug in, residing in the web server which communicates directly with
iPlanet Application Server. If multiple instances of iPlanet Application Server have
been installed, the plug in communicates with the iPlanet Application Server
selected by the load balancing system. In cases where the web server in use does
not have a plug in available, the communication module may be called as a CGI
(Common Gateway Interface) application, which establishes connection to iPlanet
Application Server. The use of the CGI model is less efficient, and normally used
only as a last resort.

The second method of communication is using OCL (Object Constraint Language),
which uses CORBA to locate the required services and communicate with them
through iPlanet Application Server. This is recommended only for the intranet
because of the lack of standardized security for IIOP (Internet Inter-Object
Protocol) connections.

The next section describes how a firewall is structured and how communication
takes place between servers, applications and security protocols.

Inter-Process Communication Protocol
Inter-process communication between servers, applications and security protocol
occurs in a number of ways. The communication links and protocols involved are
as given below:



Using Firewalls for Security

122 iPlanet Application Server Administrator’s Guide • October 2002

Ephemeral Ports
Ephemeral ports are the anonymous ports created in response to a request from a
client to a server. In UDP (User Datagram Protocol), these will be the port numbers
used for reply datagrams. For TCP/IP, these will be the port numbers for the
connection that a server creates in response to a request from a client.

Ephemeral ports can be any ports not currently in use, and not in the reserved
range (0–1023). It is common practice to allocate these ports from the range
(1024-5000). However, some systems, notably Solaris, now allocate ephemeral
port numbers that belong to a different range. Typically any port number greater
than 32768 can be allocated as an emphemeral port, going by the recognition that
for large systems with many connections the limited range of port numbers may
not be sufficient.

It is important to verify the values used and to ensure that the appropriate range or
ranges are enabled for ephemeral ports on any firewalls where ephemeral port
usage exists. Typically this will be > 32768 for modern Solaris systems and 1023 to
5000 for Windows systems.

Transmission Control Protocol/Internet Protocol (TCP/IP)
There are multiple TCP/IP connections carrying different types of traffic as listed
in the following table. The addresses and ports indicated in the table are default
values:

Most of these communication channels are used for more than one type of data
transfer. Data transfers are multiplexed over the same TCP/IP connection.

When a web server other than the web servers that support a plug in is used,
communication with KXS will be through small CGI applications.

Connection Traffic Port/Addr Purpose

Web Connector Plug-in to KXS Request data 10818 User I/O

KXS to KCS/KJS Internal data 10819 (*) Send requests

CGI to KXS Request data See Text User I/O

KCS/KJS to KXS Internal data 10818 Results/Admin

Admin UI to KAS Internal data 10817 Admin.

NOTE (*) Begins at this number and increases by for each KCS/KJS.
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The port used for communication between CGI to KXS is not fixed, but is allocated
as:

10819 + (number of KCS/JKS engines)

Therefore, if 4 KJS engines and one KCS engine are installed, the CGI port will be
configured at port number 10824, that is default CGI port number 10819+3, during
installation of iPlanet Application Server.

TCP/IP communication for web servers is allocated on port 80 or 443 depending
on the use of HTTP or HTTPS (Secure HTTP).

IP Multicast
In the case of multiple iPlanet Application Server instances, iPlanet Application
Server uses 2 IP multicast channels, which handle the following communication
tasks:

• IP multicast channel 1 communicates load balancing information between KXS
processes.

• IP multicast channel 2 communicates administration information and
commands between KAS processes.

It should be noted that traffic on the KXS channel can be heavy, and increases with
system load. Default addresses for KXS channels are given in the following table:

Table  5-1

MCast Address Port

KXS <-> KXS 228.8.18.71 9607

KAS <-> KAS 228.8.18.71 9608

NOTE The multiplexing of internal server data over a single TCP/IP
channel is sometimes referred to as the Kiva Communications
Protocol (KCP). This protocol is meant only for internal data
transfer.
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User Datagram Protocol (UDP)
The Web Connector Plug-in uses UDP. It uses the Ping protocol to verify that the
KXS process with which the Web Connector Plug-in is currently associated is still
alive. A thread running within the KXS responds to the ping. Response to a ping
indicates that the KXS is running. Lack of response indicates that failover should be
initiated. to switch to an alternate KXS. Default UDP ports are given in the
following table:

Where UDP is not permissible, the ping may be deactivated by modifying the Web
Connector Plug-in’s iPlanet Registry. To disable response to a ping request,
perform the following tasks:

1. Start iPlanet Registry

(See “About iPlanet Registry Editor,” on page 32)

2. Open the following key:

SOFTWARE/iPlanet/Application Server/6.5/CCS0/CONN/

3. Modify the DisableEcho key. Set the value to 1.

When you turn UDP pinging off, the currently selected iPlanet Application Server
may fail and this could cause a delay, until the TCP/IP connection times out. This
may take up to several minutes, depending upon TCP/IP configuration
parameters.

UDP Packet Port

Ping request 9610

Ping response Ephemeral

TIP To modify a value in iPlanet Registry, perform the following
steps:

a. Double-click the key name or select the key and choose
Modify Value from the Edit menu, to bring up the
Modify Value dialog box.

b. Enter the new value in the dialog box.

c. Click OK to register the change in iPlanet Registry.
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Note that if the network disables UDP, the ping must be disabled in the Web
Connector Plug-in registry for the Web Connector Plug-in to work. UDP ping is
used only by the web server plug in and not by the CGI interface.

The following table provides a summary of the protocols, addresses and purpose
of iPlanet Application Server components:

Encrypting Data Channels
You can encrypt communication that occurs between the Web Connector Plug-in
and KXS. When you do this, the same ports and addresses continue to be used, but
data transfers are encrypted. This is recommended on an absolute need-basis,
because of the overhead associated with data encryption using secure cyphers. See
“Enabling Encryption Between Web Server And Application Server.

Configuring Firewalls With iPlanet Application
Server

This section examines some common firewall configurations and the parameters to
be configured for correct functioning. These examples illustrate where firewalls
can reasonably be placed within a iPlanet Application Server implementation.

What Protocol Port/Addr Purpose

Web Connector Plug-in TCP/IP 10818 Web Connector
Plug-in to KXS

Web Connector
Plug-in/CGI

TCP/IP > 1024 Return connection

Web Connector Plug-in UDP/IP 9610 Keepalive ping

Web Connector Plug-in UDP/IP Ephemeral Ping return

KXS to KCS/KJS TCP/IP 10819 KXS to KCS/KJS

CGI to KXS TCP/IP Last KCS/KJS + 1 CGI apps. to KXS

KCS/KJS to KXS TCP/IP 10818 KCS/KJS to KXS

KXS IP Multicast 228.8.28.71:9607 KXS to KXS

KAS IP Multicast 228.8.18.71:9608 KAS to KAS

Admin UI to KAS TCP/IP 10817 Admin.
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Although it is possible to place a firewall between iPlanet Application Server
instances (an iPlanet Application Server instance being a KXS/KJS/KCS process
group) this is not recommended. If such a firewall is implemented it is essential
that it implements IGMP (Internet Group Management Protocol) to allow IP across
the firewall.

Although firewalls are not recommended between iPlanet Application Server
instances, the implementation of a fast, dedicated network for IP Multicast traffic
between iPlanet Application Server machines may be advisable in some
circumstances.

The iPlanet Application Server system is designed for networks running at LAN
speeds, so distributing iPlanet Application Server instances across a WAN (Wide
Area Network) may lead to performance problems.

Single Firewall
The simplest and most common firewall configuration is with a firewall between
the web server and the Internet.

A single firewall configuration is straightforward. The firewall needs to be
configured to allow HTTP connections to port 80 and/or HTTPS 443 as
appropriate. Return data is on a port above 1024, so these ports need to be opened
for outgoing (reply) connections.

The advantage of this configuration is simplicity. The biggest disadvantage is that
there is a single line of defense. Once the firewall is breached the only defense is the
security of each of the individual machines within the private network.

The table below summarizes the protocols and ports which need to be configured
to the firewall to permit correct functioning.

Sometimes, it may be required to run the web server outside the firewall.

Protocol Direction Port Reason

TCP/IP Incoming 80 HTTP requests

TCP/IP Incoming 443 HTTPS requests

TCP/IP Reply (out) >1024 HTTP(S) response
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This configuration exposes the web server machine to the Internet, which is not
recommended. As in the previous example, there is a single line of defense. The
external web server will typically have some level of trust within the protected
network, and so would be a prime target for harmful intent.

This firewall configuration needs to allow the Web Connector Plug-in TCP/IP data
connection and UDP ping connection, as described in the following table:

Double Firewall - the DMZ Configuration
This configuration is becoming more popular as many enterprises open up limited
access to their private networks to partners and customers via DMZs

The security provided by this configuration is much better than the single firewall
examples above. The double layer of protection combined with active monitoring
of activity at each firewall and within the DMZ will detect most attempts to
penetrate the internal network.

In this case the outer firewall will need to be configured as in the above example to
allow HTTP and HTTPS transactions. The inner firewall will need to be configured
to allow the web server plug in to communicate with the iPlanet Application
Server server(s) behind the firewall.

Protocol Direction Port Reason

TCP/IP Incoming 10818 Web to KXS

TCP/IP Incoming See note below CGI to KXS

TCP/IP Reply (out) > 1024 KXS to Web

UDP Incoming 9610 Web to KXS

UDP Reply (out) Ephemeral KXS to web

NOTE If a Web Connector Plug-in is not available for the web server in use,
CGI applications will be used to communicate with the KXS. The
CGI port allocated by default at installation time is: 10819 +
(number of KCS/KJS instances)
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The default port used by the web plug in to communicate with the KXS instances is
10818. Similarly, the UDP port used for the failover keepalive pings is 9610 by
default, changing this requires appropriate modification the firewall configuration.
The following table lists the default port numbers for both KXS ports and the UDP
ports:

Triple Firewall - DMZ With Database Protection
 In some corporate settings, databases reside on their own networks. This
configuration provides maximum security for what may be the most important
corporate asset; the data contained within the corporate database.

The firewall between the LAN and the database systems provides protection
against internal as well as external threats.

The connections to the databases use standard access mechanisms such as ODBC
(Open DataBase Connectivity), JDBC (Java DataBase Connectivity) and database
vendor supplied connector libraries. The connections to the database are not
different from any other application, and so the firewall configuration for the
database protection layer will conform to the standard settings required for access
to the specific database in use.

Protocol Direction Port Reason

TCP/IP Incoming 10818 Web to KXS

TCP/IP Reply (out) > 1024 KXS to Web

UDP Incoming 9610 Failover ping

UDP Outgoing Ephemeral Failover ping reply

TCP/IP Incoming 389 Web to LDAP
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NOTES FTP Access to web server

When an application is deployed, it will typically have a few HTML
pages that must be installed in the web server document hierarchy.
The installation of these pages is done manually, usually
transmitting the pages through FTP (File Transfer Protocol) to the
web server(s). When configuring any firewall between iPlanet
Application Server and its web server(s) care must be taken to allow
FTP (or some other means of copying files) from iPlanet Application
Server to the web server. This needs to be permitted only during
deployment of an application and can be disabled at other times.

Remote Administration

In order to run iPlanet Application Server Administration Tool
remotely, the network connection needs to allow TCP/IP on port
10817 for the connection between iASAT and KAS.
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Chapter 6

Enabling High Availability of Server
Resources

This chapter describes how to enable high availability of iPlanet Application Server
resources, to ensure effective system performance.

Increasing iPlanet Application Server resources such as the number of threads,
processes, and restart attempts can increase the performance of the applications
running on the server, and reduce the likelihood of application downtime.

You need to consider the resources of the iPlanet Application Server instance
before you plan on increasing server resources. For instance, if the iPlanet
Application Server instance is working at full capacity, adding to the load can
negatively affect the performance of an application. Likewise, assigning additional
threads to a process removes available threads from the system-wide thread pool,
limiting the system’s ability to process other thread-utilizing requests, such as
database access.

Directory Server stores the bulk of information on which iPlanet Application
Server’s usage depends. It is important, therefore, that this information is not lost,
if Directory Server fails due to some reason. To ensure high availability of a huge
volume of information and configuration data, it is necessary to configure a backup
Directory Server to take over when the primary Directory Server fails.

This chapter deals mainly with how you can effectively configure iPlanet
Application Server’s resources and ensure availability of data.

This chapter includes the following topics:

• About Adding and Tuning Server Processes

• Adjusting the Number of Threads for Processing Requests

• Specifying the Number of Requests for the Executive Process

• Setting Administration Server Options
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• Implementing a Multi-Process, Single-Threaded Environment

• Configuring Directory Server Failover

About Adding and Tuning Server Processes
You can add a Java Server (KJS) or C++ Server (KCS) process to increase high
availability. When you add one or two additional processes, an application is more
likely to respond to requests. For instance, if one process fails, the second or third
process can take its place, decreasing the period for which an application is
unavailable. This is particularly useful for applications that have known problems
which can cause a process to fail.

In addition, you can add a Bridge process to enable direct communication to
application components hosted by a KJS process on iPlanet Application Server,
using RMI/IIOP. When a request originates from a Corba-based client it is sent to
iPlanet Application Server through a Bridge process. This allows Corba-based
clients to communicate directly to application components on iPlanet Application
Server. For more information on adding a bridge process, see Chapter 10,
“Enabling Support For Corba-Based Clients”.

To Add and Tune Java and C++ Processes
You can add additional KJS processes for Java applications and KCS processes for
C++ applications. It may not be necessary to add more than two processes for
either type of application. If an application cannot run on one or two processes,
you could check for errors in the code, which can be addressed by the application
developer.

To add a Java or C++ process, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
instance where you want to add the KJS process.

3. From the File menu, click New>Process.

The New Process dialog box appears.
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4. From the Process Type drop-down list, choose KJS or KCS.

5. In the Port Number text box, specify an unused port number where the
additional process will run.

6. Click OK to add the new process.

7. If this process is to be used in a single-threaded environment, perform the
following tasks:

a. Select the required process in the left pane of the General window.

b. In the right pane of the window, set the Minimum and Maximum Threads
to 1.

8. Click Apply Changes to save your changes.

Adjusting the Number of Threads for Processing
Requests

Request threads handle user requests for application components. When iPlanet
Application Server receives a request, it assigns the request to a free thread. The
thread manages the system needs of the request. For example, if the request needs
to use a system resource that is currently busy, the thread waits until that resource
is free before allowing the request to use that resource.

You can specify the minimum and maximum number of threads that are reserved
for requests from applications. The thread pool is dynamically adjusted between
these two values. The minimum thread value you specify holds at least that many
threads in reserve for application requests. That number is increased up to the
maximum thread value you that you specify.
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Increasing the number of threads available to a process allows the process to
respond to more application requests simultaneously. You can add and adjust
threads for each process, or you can define the number of threads for all processes
under a server, at the server level.

By default, each process uses the threads assigned to iPlanet Application Server.
For example, if iPlanet Application Server uses a minimum of 8 threads and a
maximum of 64 threads, each individual process uses a minimum of 8 threads and
a maximum of 64 threads.

This section describes the following topics:

• To Adjust Threads at Server Level

• To Adjust Threads at Process Level

To Adjust Threads at Server Level
To adjust the number of request threads for all (KJS/KCS/KXS and IIOP) processes
for a server, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. From the left pane of the General window, select the server for which you want
to adjust the number of threads.

3. Click the Request Manager tab in the right pane of the General window.

4. In the Default Minimum Threads text box, specify the minimum number of
threads available for each process of the selected iPlanet Application Server.
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5. In the Default Maximum Threads text box, enter the maximum number of
threads available for each process on the selected iPlanet Application Server.

6. Click Apply Changes to save your changes.

To Adjust Threads at Process Level
You can also specify different thread settings for each process under a server. Note
that the numbers you specify for a process will be accepted as default for that
process. The process level setting overrides the server level setting.

To adjust the number of threads available for a process under a server, perform the
following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the server whose process you
want to edit. Expand the server to view its processes. Note that you can expand
a server’s hierarchical tree only when it is running.

3. Select the process whose number of threads you want to adjust.

4. Click the Request Manager tab, from the right pane of the General window.

5. Specify the minimum number of threads available for the selected process, in
the Minimum Threads text box.
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6. Specify the maximum number of threads available for that process, in the
Maximum Threads text box.

7. Click Apply Changes to save your changes.

Specifying the Number of Requests for the
Executive Process

The Web Connector Plug-in routes users requests aimed at iPlanet Application
Server applications, to the Executive process (KXS). These requests are logged to
the request queue in the Executive process.

You can perform the following tasks:

• Control the maximum number of threads the Web Connector Plug-in will use
to process requests. This prevents the request queue from receiving more
requests than it can process.

• Set the maximum number of requests that are logged to the request queue to
control the flow of requests. The maximum number is called the “high
watermark”.

• Set the number of requests in the queue in which logging will resume. This
number is called the “low watermark”.

NOTE Settings that are specified at process level override those set at the
server level.
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This section includes the following topics:

• To Control Request Flow at Server Level

• To Control Request Flow at Process Level

To Control Request Flow at Server Level
To control the flow of requests at the server level, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the server in which you want to
control request flow.

3. Click the Request Manager tab from the right pane of the General window.

4. Mark the Enable Request Flow Control checkbox to enable flow control.

5. In the Request Queue Low Water Mark text box specify the number of requests
that should be available in the queue, which will trigger request logging.

This number is only applicable after the maximum number of requests in the
queue has been reached. See the next step.

6. In the Request Queue High Water Mark text box specify the maximum number
of requests for the queue.

When this number is reached no more user’s requests will be accepted until the
request queue reduces to the number specified as the low watermark.



Specifying the Number of Requests for the Executive Process

138 iPlanet Application Server Administrator’s Guide • October 2002

7. Click Apply Changes to save your changes.

To Control Request Flow at Process Level
You can also customize the request flow for a process. Note that the numbers you
specify for a process will be accepted as default for that process. The process level
setting overrides the server level setting

To adjust the request flow for a process, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the server for which you want to
control request flow. Expand the server to view its processes.

3. Click the Request Manager tab in the right pane of the General window.

4. Click the Enable Request Flow Control checkbox to enable flow control.

5. In the Request Queue Low Water Mark text box enter the number of requests
in the queue in which logging will resume.

6. In the Request Queue High Water Mark text box enter the maximum number
of requests for the queue.

NOTE You can expand a server in the hierarchical tree only when it is
running.
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These setting override the default settings at the server level.

7. Click Apply Changes to save your changes.

Setting Administration Server Options
The Administration Server (KAS) manages all the administrative processes and
tasks within iPlanet Application Server. You can set several options for the
administrative server that will enable high availability of server resources. Setting
these options can increase the performance of applications running on a server and
attempt to reduce the likelihood of application downtime. You can set the
following options:

• To Specify EJB Container Parameters for Run Time

• To Specify Maximum Number of Engine Restarts

• To Enable Internationalization Support

• To Cache JavaServer Pages (JSP)

• To Specify Maximum Server and Engine Shutdown Time

To Specify EJB Container Parameters for Run
Time
iPlanet Application Server provides an EJB container that enables you to build
distributed applications using your own EJB components, and components from
other suppliers. When you configure iPlanet Application Server for your
enterprise, you must set the EJB container’s declarative parameters. These
parameters determine, for example, session timeout when an EJB is removed after
being inactive for a specified number of seconds. Set these parameters using the
editor in iASAT.

To access the editor, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

NOTE Settings that are specified at process level override those set at
the server level.
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2. In the right pane of the General window, click the EJB tab to open the EJB
container declarative parameters editor.

The following window appears:

The editor allows you to set the following values:

❍ Default Session Timeout

If an EJB is not accessed for the specified number of seconds, it is removed.
This applies to stateful session EJBs.

❍ Default Passivation Timeout

Time (in seconds) that elapses before the state of the EJB is written to disk.
This value must be less than the session timeout value.

❍ Metadata Cache Size

The metadata cache for EJBs, whose value is in number of EJBs.

❍ Implementation Cache Size

Maximum cache size is in number of EJBs.

❍ Timer Interval

How frequently (in seconds) the EJB pool checks to see if it should
passivate or remove an EJB.

❍ Failover Save Interval

How frequently (in seconds) the EJB state is saved. If the server fails, the
last saved state of the EJB can be restored. Data saved is available to all
engines in a cluster. This value is set on a per server basis and applies to
EJBs that were deployed with Failover option enabled (on the General tab
of the Deployment Tool EJB descriptor editor).
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3. Click Apply Changes to save your changes.

4. Restart iPlanet Application Server for the changes to take effect.

To Specify Maximum Number of Engine Restarts
When a process, such as Executive Server (KXS), Java Server (KJS), C++ Server
(KCS) or Corba Executive Server (CXS) fails, the Administrative Server restarts it.
You can set the restart option to either increase or decrease the number of times
that a process is restarted. Fault tolerance and application availability are increased
when all processes are running smoothly.

To adjust the restart option of the Administrative Server, perform the following
tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
instance whose Administrative Server restart option you want to adjust.

3. Open the Server tab from the right pane of the General window.

4. Specify the new restart value in the Maximum Engine Restarts text field.

5. Click Apply Changes to save your changes.
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To Enable Internationalization Support
You can enable iPlanet Application Server to support applications in languages
belonging to different geographic locations.

To enable internationalization, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
instance for which you want to enable internationalization.

3. Click the Server tab in the right pane of the General window.

4. Mark the Enable I18N Support check box.

5. Click Apply Changes to save your changes.

To Cache JavaServer Pages (JSP)
You can specify the number of JSP pages that are cached by each KJS engine for
each iPlanet Application Server instance. Caching JSPs optimizes application
response time.

To set the JSP caching value of the Administrative Server, perform the following
tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
instance for which you want to set the JSP caching value.

3. Click the Server tab from the right pane of the General window.

4. Specify the JSP Cache Size in the text field. The cache size is set on a per-page
basis.

5. Click Apply Changes to save your changes.

NOTE You must stop and restart the server for your changes to take
affect. See “Performing Administrative Tasks Using iPlanet
Registry Editor,” on page 33 for information.



Implementing a Multi-Process, Single-Threaded Environment

Chapter 6 Enabling High Availability of Server Resources 143

To Specify Maximum Server and Engine
Shutdown Time
You can set shutdown values of the Administrative Server for both iPlanet
Application Server and engine processes. For example, if you set a 60 seconds
engine shutdown time, application tasks being processed are allowed 60 seconds
for completion. No new requests are accepted after this period has elapsed.
Specifying a shutdown value avoids a “hard” shutdown that will return errors to
the client.

To set the server and engine shutdown time of the Administrative Server, perform
the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
instance whose shutdown time you want to specify.

3. Click the Server tab from the right pane of the General window.

Specify a Maximum Server Shutdown Time.

The Maximum Server Shutdown Time is the maximum time taken to shut
down iPlanet Application Server. After this time, any engines that are still
running are killed. The server typically shuts down quickly unless it is heavily
loaded.

4. Enter a Maximum Engine Shutdown Time.

The Maximum Engine Shutdown Time is the maximum time that iPlanet
Application Server will wait for an engine to shut down. After this time, the
engine will be killed, and the next engine(s) will be shutdown.

5. Click Apply Changes to save your changes.

Implementing a Multi-Process, Single-Threaded
Environment

You can add a Java Server (KJS) or C++ Server (KCS) process to implement a
multi-process, single-threaded environment. Running multiple KJS processes, all
in single-threaded request mode, effectively creates a “multi-threaded”
environment, which allows simultaneous processing of users requests.
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Implementing this environment allows each process to accept only one request at a
time. This is useful when you integrate third-party utilities. Running third-party
utilities in the iPlanet Application Server multi-threaded request environment can
cause errors that the application server may not be able to handle, including thread
safety issues. You can implement a multi-process, single-threaded environment
and avoid this type of problem, while enabling iPlanet Application Server to scale.

For example, if a third-party utility which is not thread safe runs within the KJS
process, you can adjust the request threads of the KJS to 1 and eliminate the issues
of utility safety. However, this creates a request backlog as requests wait for the
KJS to process a single request at a time. You can avoid this by running KJS
processes in single-threaded request mode, and effectively create a
“multi-threaded” environment allowing simultaneous processing of user requests.

You do need to maintain multiple request threads for the Executive Server (KXS)
process, as it distributes all requests that come into iPlanet Application Server.

To implement a multi-process, single-threaded environment, perform the
following tasks:

1. Add a KJS or a KCS processes.

See To Add and Tune Java and C++ Processes.

2. Adjust the request threads allocated for those processes to 1.

See Adjusting the Number of Threads for Processing Requests.

Configuring Directory Server Failover
The Directory Server connected to your iPlanet Application Server instance
contains global information shared by all application servers in a Directory Server
cluster. A Directory Server cluster is simply one or more iPlanet Application Server
instances that share a single Directory Server. See “What Is LDAP?,” on page 100
for more information on LDAP servers.

To protect this globally shared information, you need to configure a second
Directory Server to act as a backup if the primary server fails. You need to install
the backup Directory Server on a machine other than the one on which your
primary Directory Server is configured.

Perform the following tasks to effectively configure a backup Directory Server for
failover:

1. Install iPlanet Directory Server 5.0, on a separate machine. For installation
details, see the documentation provided along with iPlanet Directory Server.
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2. Set up the backup Directory Server as the consumer.

3. Modify the primary Directory Server configuration to include the backup
Directory Server’s hostname and port number.

4. Create a Replication Agreement between the two directory servers.

5. If you have a webless installation of iPlanet Application Server, modify iPlanet
Registry entries for the web-connector.

Setting Up Supplier-Initiated Replication
Supplier-Initiated Replication is a replication configuration where servers
containing master copies of directory trees and sub-trees replicate directory data to
consumer directory servers. To set up Supplier-Initiated Replication, you need to
first configure the backup Directory Server to accept replication configuration
updates. Then you need to set up replication agreements for specific directory trees
in the primary Directory Server.

Note that once the backup Directory Server is set up to accept replication
configuration, any modifications made to the primary Directory Server will be
replicated to the backup Directory Server.

These topics are described in detail in the following sections:

• To Configure Backup Directory Server

• To Configure Primary Directory Server

• To Create Replication Agreement

• To Configure the Backup Directory Server in iASAT

• To Configure Registry Entries for Web Connector Plug-in

To Configure Backup Directory Server
To configure the backup Directory Server (consumer) to accept replication updates
from the supplier, perform the following tasks:

1. Start iPlanet Console (on the machine in which the backup Directory Server is
installed).

On Windows systems, you can do this by opening the Start menu, and
choosing Programs>iPlanet Server Products>iPlanet Console 6.5.
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On both Windows and Solaris systems, navigate to the <iASInstallDir> path,
and type startconsole at the command line prompt.

2. Select Directory Server, as shown in the following figure:

Figure 6-1 iPlanet Console screen

3. Click Open to access the iPlanet Directory Server configuration screen.

4. Click Configuration.

The following window appears:
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Figure 6-2 Backup directory server

5. Select Replication in the left pane.

6. Expand Replication and select NetscapeRoot in the left pane.

The following dialog appears.
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Figure 6-3 Setting up backup directory server

7. Select Enable Replica.

8. Select Dedicated Consumer, to set this directory server to be the backup
directory server.

9. Enter a Replica ID number. This can be a number between 1 and 255.

10. Enter the number of days after which entries will expire in the backup
directory server.

Select Never if you do not want to keep the entries made by the supplier.

11. Enter a valid Distinguished Name in the Supplier DN text field, for example,
cn=Directory Manager.

If the supplier directory server is running a 4.x version of iPlanet Directory
Server, enable the Updatable by a 4.X Replica. You will have to make
additional settings in the Legacy Consumer Settings tab.
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12. Click Save to commit your modifications.

This sets up your backup directory server. Next you have to configure the
primary directory server, or the supplier, to send updates to the consumer you
have just setup.

To Configure Primary Directory Server
Follow these steps to configure your primary directory server (supplier) to update
the backup directory server.

1. Start iPlanet Console (on the machine in which the backup Directory Server is
installed).

On Windows systems, you can do this by opening the Start menu, and
choosing Programs>iPlanet Server Products>iPlanet Console 6.5.

On both Windows and Solaris systems, navigate to the <iASInstallDir> path,
and type startconsole at the command line prompt.

2. Select Directory Server and click Open.

3. Select Replication in the left pane.

The following dialog appears:
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Figure 6-4 Primary directory server

4. Click Enable Changelog.

You must select this option to proceed with the replication agreement
procedure.

5. Choose a directory to store the change log data.

This is the directory where all the changes made to the directory server’s
settings are logged. Specify the changelog directory in the Changelog database
directory text field. Click Browse to locate a directory, or click Use default to
set the default changelog directory.

The default directory is set to
iASInstallDir/slapd-machine_name/changelogdb.

6. Click Save to commit the changes you have made.

7. Expand Replication and select NetscapeRoot in the left pane.

The following dialog appears:
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Figure 6-5 Setting up primary directory server

8. Select Enable Replica.

9. Select Single Master, to set this directory server to be the primary directory
server (supplier).

To configure multiple supplier directory servers to a consumer, each holding
the same subtree, select the Multiple Master option. For more information on
configuring multi-master replication, see iPlanet Directory Server
documentation.

10. Enter a Replica ID number. This can be a number between 1 and 255.

11. Enter the number of days after which entries will expire in the backup
directory server.

Select Never if you do not want to keep the entries made by the supplier.

12. Enter a valid Distinguished Name in the Supplier DN text field, for example,
cn=Directory Manager.
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If the supplier directory server is running a 4.x version of iPlanet Directory
Server, enable the Updatable by a 4.X Replica. You will have to make
additional settings in the Legacy Consumer Settings tab.

13. Click Save to commit your modifications.

Now the setup of the primary directory server as the supplier is complete. Next
you must create a Replication Agreement between the supplier and consumer
directory servers.

To Create Replication Agreement
Follow these steps to create the Replication Agreement between the two directory
servers.

1. From the primary directory server’s console, right-click NetscapeRoot > New

Replication Agreement...

Figure 6-6 Replication Agreement configuration
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2. Enter a name and description to identify this replication agreement.

For example, for Name enter ReplicaOne, and for Description enter, iAS
LDAP failover.

Click Next.

3. Enter the URL of the backup (consumer) directory server alongwith your
authentication credentials.

Figure 6-7 Specify consumer and user credentials

a. In the Consumer text field, enter the hostname of the machine on which
the backup Directory Server is installed.
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b. Click Other. The Consumer Server Information popup window opens, as
shown in the following figure:

c. In the Host name text field, provide the host name of the machine on
which the backup Directory Server is installed.

In the Port text field, provide the Port Number, if it is different from the
primary Directory Server machine’s port number.

d. Click OK to confirm. You can now see the consumer name in the Source
and Destination window.

e. Select Simple authentication for simple and direct authentication.

f. Provide a valid Distinguished Name in the Bind As text field, which the
primary server will use to bind to the backup directory server.

g. In the Password text field, provide the password that you used during
iPlanet Application Server installation.

4. Select the replication schedule you need.

NOTE If you want a higher level of security, you can choose
encrypted SSL connection. If you choose this option, the user
will be authenticated through a Secure Socket Layer (SSL)
process. You will need to specify the subject DN of the
certificate server. For more information, see iPlanet Directory
Server documentation.

NOTE You can have multiple instances of iPlanet Application
Server on a Solaris system. Ensure that the password you
provide pertains to the iPlanet Application Server instance
for which you are configuring a backup Directory Server.
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Figure 6-8 Specify replication schedule

❍ Select Always keep directories in sync, to keep the data current in both
Directory Servers.

❍ Select Sync on the following days if you want to schedule the data
synchronization between the primary and backup Directory Servers. Data
replication will occur during the period you specify on the selected days of
the week.

❍ Click All if you want to schedule data synchronization on all days of the
week.

5. Select the method you would like to use to initiate the connection to the
consumer.
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Figure 6-9 Consumer initialization options

❍ Select Do not initialize consumer to stop replication at this point. If you
choose this option, data is not replicated in the backup Directory Server.

❍ Select the Initialize consumer now radio button. This option initializes the
backup Directory Server immediately. The backup Directory Server is
ready for replication.

❍ Select Create consumer initialization file if you want to write the data to a file.
Select a .ldif file for storing the data, which can be copied to the backup
Directory Server later. See “Using LDIF to Add Entries to Directory
Server,” on page 106, for more information.

6. The summary screen displays the values you have chosen.
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7. Click Done to complete the replication agreement procedure. Click Back if you
want to make any changes.

If you had selected initialize consumer now option in the Initialize Consumer
screen, the backup directory server will now be updated by the primary
directory server.

8. You will get a confirmation message when the replication completes
successfully.

You can see the entries of the primary directory server in the backup, after
replication completes.

NOTE Now you need to replicate cn=iasRoot. Follow the steps in “To
Create Replication Agreement,” on page 152 to add this node as
well to the replication scheme.
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To Configure the Backup Directory Server in
iASAT
Once the backup Directory Server is installed and replicated, you need to modify
the primary Directory Server configuration to include the name and port number
of the backup Directory Server, in iASAT. You can do this by performing the
following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. Select the iPlanet Application Server instance for which you want to configure
a backup Directory Server.

3. Open the LDAP tab from the right pane of the General window. The following
window appears:

Directory Server(s) associated with your iPlanet Application Server instance
appears in this window.

4. Select the primary Directory Server and click Modify. The following dialog box
appears:

NOTE For more information on certificate based authentication, see the
chapter “Managing Replication,” in the iPlanet Directory Server
Administrator’s Guide. This document is available with your
Directory Server installation in the following location:

<iASInstallDir>/manual/en/slapd/ag/replicat.htm
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5. In the Hostname field, insert a space after the existing hostname and enter the
name of the machine on which the backup Directory Server is installed (as
shown in the figure given above). If the port number of the backup Directory
Server machine is different, insert a colon (:) next to the hostname and specify
the port number, for example, bozo viper:399

You need to specify the port number only if it is different from the port number
of the host.

6. Click OK to close the window.

7. Click Apply Changes to register the changes in iASAT.

8. You need to stop and start iPlanet Application Server for the change to take
effect.

The backup Directory Server is now configured. Note that you must always have at
least one Directory Server configured to work with iPlanet Application Server.

NOTE To remove a Directory Server, select the required Directory Server in
the right pane of the General window in iASAT, and click Remove.
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To Configure Registry Entries for Web
Connector Plug-in
When you configure a backup Directory Server, iPlanet Application Server creates
the necessary back-end entries in iPlanet Registry. However, in the case of a
webless installation of iPlanet Application Server, where iPlanet Application
Server and the web-connector are installed on different machines, you have 2
instances of iPlanet Registry. You need to update iPlanet Registry entries on the
web-connector, with the host name and port number of the machine on which the
backup Directory Server is installed.

To update iPlanet Registry with the backup Directory Server details, perform the
following tasks:

1. Start iPlanet Registry (on the machine where the web-connector is installed).

2. Open the following key:

SOFTWARE/iPlanet/Application
Server/GDS/Backends/Ldap/LdapBackend1/0/
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3. Select the Host=<hostname> value.

Double-click the value to open it, or choose Modify Value from the Edit menu.
The Modify Value dialog box appears.

4. Insert a space after the existing hostname and enter the name of the machine on
which the backup Directory Server is installed. If the port number of the
backup Directory Server machine is different, insert a colon (:) next to the
hostname and specify the port number.
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Figure 6-10 Adding the consumer directory server in the registry

5. Stop and start iPlanet Registry editor for the changes to take effect.
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Chapter 7

Configuring the Web Connector
Plug-In

This chapter describes the Web Connector Plug-in which sends users’ requests to
applications residing on iPlanet Application Server.

The following topics are included in this chapter:

• About the Web Connector Plug-In

• Manually Configuring a Web Server

• Configuring the Web Connector Plug-in for Web Server Logging

• Configuring Cookie and Hidden Field Usage

• Configuring URL Rewriting

• Configuring a CGI Flag for CGI Requests

• Changing the Web Connector Port Number

• Specifying HTTP Variables for Input to Application Components

About the Web Connector Plug-In
The Web Connector Plug-in is installed on your web server at the time you install
iPlanet Application Server.

If you install iPlanet Application Server on the same machine where a web server is
installed, the Web Connector Plug-in is simultaneously installed and the web
server configured automatically.



Manually Configuring a Web Server

164 iPlanet Application Server Administrator’s Guide • October 2002

If you install iPlanet Application Server on a machine where a web server is not
installed, you must manually install the Web Connector Plug-in on that web server
machine. For more information about manually installing the web connector, see
the Installation Guide.

You can configure the following Web Connector Plug-in functions:

Manually Configuring a Web Server
When you install iPlanet Application Server, your web server is automatically
configured for the Web Connector Plug-in, meaning that all the necessary
directories and settings on the web server are updated. However, there may be
occasions, when, after you’ve installed the Web Connector Plug-in, you must
manually re-configure the web server. This procedure is recommended only if you
are having problems with the connection between iPlanet Application Server and
your web server.

Table 7-1 Configurable Web Connector Plug-in Functions

Connector functionality Description More information

Web server request
logging

Mapping web server
request components to
database fields and
adding HTTP variables to
the log.

Configuring the Web
Connector Plug-in for Web
Server Logging

Cookie and hidden field
security

Enable or disable cookies
and hidden fields during
web server to iPlanet
Application Server
communication.

Configuring Cookie and
Hidden Field Usage

CGI flag for CGI request
processing

Set a flag to process
requests in CGI mode
when that is necessary.

Configuring a CGI Flag for
CGI Requests

The plug-in port number Reconfigure the port
number used by the
plug-in.

Changing the Web Connector
Port Number

Configuring HTTP
variables as input for
application components

Determine which HTTP
variables can be accessed
by application
components.

Specifying HTTP Variables for
Input to Application
Components
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The following steps explain how to manually configure a web server to use the
Web Connector Plug-in, whether your web server resides on the same or a
different machine than where iPlanet Application Server is installed.

If you perform only step one of the following procedure (enabling CGI), the Web
Connector Plug-in will run as a CGI script. If you perform the entire procedure, the
Web Connector Plug-in will run as a plug-in, which is more efficient since a plug-in
is faster than a CGI script.

You must be logged in as the same administrator user who installed the web
server.

The following topics are described in this section:

• Configuring iPlanet Web Server

• Configuring Apache Web Server

• Configuring Microsoft Internet Information Server

Configuring iPlanet Web Server
To reconfigure an iPlanet Web Server, perform the following steps:

1. Enable CGI, if it is not already enabled:

a. On Windows, from the Start menu, select iPlanet Web Server>
Administer Web Servers.

b. Enter the administrator ID and password, and click OK.

c. On the iPlanet Server Selector screen, choose the web server instance you
want to configure from the drop-down list and click Manage.

d. Click Programs, from the menu toolbar.

e. On the CGI directory screen under URL prefix, type cgi-bin.

f. Under CGI directory, enter the cgi-bin path.

For iPlanet Web Server 4.1, Windows:

<drive letter>:\Netscape\Server4\docs\cgi-bin

For iPlanet Web Server 4.1, Solaris:

<iWSInstallDir>/docs/cgi-bin

Now you are ready to configure the Web Connector Plug-in.
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2. Edit the file obj.conf (till iWS 4.1) or magnus.conf (from iWS 6.0 onwards) in
the web server configuration directory.

For iWS 4.1, the file obj.conf will hold all the changes. For iWS 6.0 and later,
the file magnus.conf will also be modified.

For iPlanet Web Server 4.1 on Windows, modify the file obj.conf in the
following path:

drive letter:\Netscape\Server4\https-machinename\config

For iPlanet Web Server 4.1 on Solaris, modify the file obj.conf in the
following path:

iWSInstallDir/https-machinename/config

Make a copy of the file before modifying it.

3. At the end of the Init section of the obj.conf file, add the following as two
lines:

❍ On Windows:

Init fn="load-modules"
funcs=nas_name_trans,gxrequest,gxlog,gxinit,gxredirect,
gxhtmlrequest shlib="<path to iAS bin dir>\gxnsapi6.dll>”

Init fn="gxinit"

❍ On Solaris:

Init fn="load-modules"
funcs=nas_name_trans,gxrequest,gxlog,gxinit,gxredirect,
gxhtmlrequest shlib="libgxnsapi6.so"

Init fn="gxinit" LateInit=yes

The following changes need to be made to the obj.conf file and magnus.conf (for
all versions of iPlanet Web Server).

4. Add the following line before the NameTrans fn=document-root
root="$docroot" line:

NameTrans from="/" fn="nas_name_trans"

5. In the Object name=default section, just after type=text/plain section, add
the following line:

Service fn="gxredirect" fnname="imagemap" method="(GET|HEAD)"
type=”magnus-internal/imagemap”

6. In the Object name=cgi section(s), insert the following line immediately
before the Service fn="send-cgi" line:



Manually Configuring a Web Server

Chapter 7 Configuring the Web Connector Plug-In 167

Service fn="gxrequest"

7. Next, insert the following line immediately after the Service fn="send-cgi"

line:

AddLog fn="gxlog"

8. Add the following lines after the Object name=cgi section.

<Object name="nassspl"> ObjectType fn="force-type"

type="magnus-internal/cgi" Service fn="gxrequest" AddLog

fn="gxlog" </Object>

<Object name="nashtml"> Service fn="gxhtmlrequest" AddLog
fn="flex-log" name="access" </Object>

9. Make a copy of the current version of the file obj.conf and magnus.conf, and
copy them to the back-up version (so that the backup is consistent with the
current version) in the following directory:

For Windows:

drive letter:\iPlanet\SuiteSpot\https-machinename\conf_bk

For Solaris:

iPlanet install directory/https-machinename/conf_bk

10. Solaris only: Modify the web server’s start and stop scripts as follows:

In the start script:

a. Set GX_ROOTDIR to the directory in which iPlanet Application Server is
installed. For example:

GX_ROOTDIR=iASInstallDir; export GX_ROOTDIR

b. Update LD_LIBRARY_PATH.

11. Restart the web server.

Configuring Apache Web Server
Apache Web Server 1.3.19 is supported in the iPlanet Application Server 6.5
release. To use the Apache Web server with the iPlanet Application Server’s Web
Connector Plug-in, a few manual configuration steps have to be performed.
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You must install and configure the Apache Web Server on the machine on which
the Web Connector Plug-in is installed.

The following topics are discussed in this section:

• To Install Apache Web Server on Solaris

• To Install Apache Web Server on Windows

• To Configure the Plugin on Apache to Run CGI Scripts

NOTE To use the Apache Web Server, you must select either the iPlanet
Web Server or Microsoft Internet Information Server (on Windows
only) during the application server installation. After installing the
iPlanet Application Server, install and configure the Apache Web
Server.
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To Install Apache Web Server on Solaris
1. Download the Apache web server 1.3.19 source files from the Apache Web site

at www.apache.org and unpack the tar.gz file.

NOTE • ar should be in your PATH.

• The owner/group of iPlanet Application Server and Apache
should be the same. By default, Apache runs as
nobody:nobody.

If you need to change the owner/group of iPlanet
Application Server files say, to nobody:nobody, then type
the following command:

chown -R nobody:nobody <iASInstallDirectory/ias/>

• Apache recommends that the Web server not be run as root.
For more information, see the Apache Web site.

To run as root, set the shell variable EXTRA_CFLAGS to
-DBIG_SECURITY_HOLE, before compiling.

• If you are using an older version of GNU binutils (2.7 or
earlier), pass the option -export-dynamic to the GNU
linker.

Without this option, the runtime linker will not be able to
resolve certain Apache symbols referred in the plugin and
the web server will crash when you start it.
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2. Go to the root directory where the source files are saved and run:

./configure  --prefix=<Installation_Directory>
--enable-module=so --with-port=<PortNo.>
make
make install

The Apache control script is called apachectl and is available in the bin
directory of the installation.

To start the script, type:

apachectl  start

To stop, type

apachectl  stop

To Configure Apache Web Server on Solaris
1. Add the shell variables GX_ROOTDIR, LD_LIBRARY_PATH and

LD_PRELOAD to the apachectl script:

NOTE • enable-module=so is mandatory

• The port number value is optional, as it is set to 80, by
default.
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2. Add the following lines at the end of <ApacheInstallDir>/conf/httpd.conf

Code Example 7-1

# Additions for the iPlanet Application Server
#
GX_ROOTDIR=<iASInstallDir>/ias
export GX_ROOTDIR
LD_LIBRARY_PATH=${GX_ROOTDIR}/gxlib:$LD_LIBRARY_PATH
export LD_LIBRARY_PATH
LD_PRELOAD=${GX_ROOTDIR}/gxlib/libiasdl.so
export LD_PRELOAD
#

NOTE • Replace <iASInstallDir> with the installation directory of iPlanet
Application Server.

• Replace <ApacheInstallDir> with the installation directory of
Apache web server.

• The lines with LD_PRELOAD are required only for Solaris 2.6.

Code Example 7-2

# Additions for the iPlanet Application Server
#
LoadModule nas_module <iASInstallDir>/ias/gxlib/libiASApachePlugin.so
AddModule iASApacheInterface.cpp
<Location “/”>
SetHandler ias-handler
</Location>
#
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3. Copy the <iASInstallDir>/ias/GXApp and
<iASInstallDir>/ias/ias-samples directories to the
<apacheInstallDir>/htdocs/ directory.

The minimum, maximum and the starting number of Web servers can be
controlled by the following keys in conf/httpd.conf. These are the default
values provided by Apache:

MinSpareServers 5

MaxSpareServers 10

StartServers 5

All the web servers write to the same log file.

4. Modify the iPlanet Application Server registry using kregedit, as given in
“Configuring iPlanet Application Server Registry,” on page 173.

To Install Apache Web Server on Windows
Download and install the binaries for Apache 1.3.19 from the Apache Web site at
www.apache.org. For more information on installing Apache on Windows, follow
instructions on the Apache Web site.

To Configure Apache Web Server on Windows
1. Add the path of the Apache executable in the system variable PATH.

2. Add the path of iASApachePlugin.dll (the Web Connector Plug-in) to the
system variable PATH.

The path will be <iASInstallDir>/ias/bin.

3. Add the following lines at the end of <ApacheInstallDir>/conf/httpd.conf

NOTE Replace <iASInstallDir> with the installation directory of iPlanet
Application Server.
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4. Copy the <iASInstallDir>/ias/GXApp and
<iASInstallDir>/ias/ias-samples directories to the
<ApacheInstallDir>/htdocs/ directory.

5. Modify the iPlanet Application Server registry using kregedit, as given in
“Configuring iPlanet Application Server Registry,” on page 173”.

Configuring iPlanet Application Server Registry
After installation, use kregedit to modify the following keys in the iPlanet
Application Server registry.

1. Set SOFTWARE/iPlanet/Application Server/6.5/CCS0/HTTPAPI/HTTPPort
to the listening port of the Apache web server.

2. Set SOFTWARE/iPlanet/Application Server/6.5/CCS0/HTTPAPI/PATH and
SOFTWARE/iPlanet/Application

Server/6.5/deployment/LogicalName/WWW_DOCROOT to the document root
directory.

3. Append the document root directory,
<Apache_Installation_Directory>/htdocs, to
SOFTWARE/iPlanet/Application Server/6.5/CCS0/TEMPLATE/PATH,
separated by semi colons.

To Configure the Plugin on Apache to Run CGI Scripts
Setting the ias-handler using <Location "/"> will send all requests to the
ias-handler in the webserver.

If you wnat to use cgi-scripts you must be more specific about what gets sent to the
ias-handler, you need to set the location in the registry entry:
\SOFTWARE\iPLANET\Application
Server\6.0\CCSO\HTTPAPI\SSPL_APP_PREFIX.

Code Example 7-3

#Additions for the iPlanet Application Server
#
LoadModule nas_module <iASInstallDir>/ias/bin/iASApachePlugin.dll
AddModule iASApacheInterface.cpp
<Location “/”>
SetHandler ias-handler
</Location>
#
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The default value is NASApp. Therefore, if you were using the default setting, you
should set the ias-handler using <Location "/NASApp/"> to send requests that
begin with "//severname:port/NASApp" to the ias-handler.

Any other request would be handled by the webserver, enabling cgi-scripts to be
run in the webserver even when the ias-handler is loaded. You can set more than
one location in the httpd.conf.

For example, if you want to run Netscape Application Server 2.x style applogics
with the /cgi-bin/gx.cgi prefix as well as the /NASApp/ prefix, add the following
to the Apache httpd.conf file:

Code Example 7-4 Running CGI scripts on Apache

<Location "/NASApp"> SetHandler ias-handler

</Location>

<Location "/cgi-bin/gx.cgi/"> SetHandler ias-handler

</Location>

Configuring Microsoft Internet Information Server
Keep in mind the following information when reconfiguring Microsoft IIS:

• Rename the gxisapi.dll library to gx.dll and leave it in the cgi-bin directory
of the IIS wwwroot (inetput/wwwroot/cgi-bin/).

• Configure the ISAPI filter file, gx.dll, in the following registry entry:

My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

\W3SVC\Parameters\

A string key, Filter DLLs, should be added under Parameters, with the
following value:

<drive letter>:\inetpub\wwwroot\cgi-bin\gx.dll

• The Webconnector Plugin will throw exceptions if it doesn’t have permission
to write to the Windows registry.

Follow these instructions to enable the Plugin to modify the registry:

a. Open the Windows registry editor.

b. Go to \\HKEY_LOCAL_MACHINE\SOFTWARE\iPLANET\Application

Server\6.5\CCSO\HTTPAPI.
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c. From the menu options, open the Permission Definition key.

d. Change the permission from Special Access to Full Control.

e. Enable the changes for the subkeys.

f. Click Apply Changes to commit the modifications.

Configuring the Web Connector Plug-in for Web
Server Logging

Web server requests are divided into components. Each component is represented
by an HTTP variable. HTTP variables are standardized across all web servers, so
the configurations you make with regard to their use are web- server independent.

This section describes the following topics:

• Mapping HTTP Variables to Database Fields

• Adding HTTP Variables to the Log

Mapping HTTP Variables to Database Fields
To enable logging of a particular component of a web server request, you must
map HTTP variables to specific database fields to ensure that web server requests
are properly logged. Mapping HTTP variables to database fields is done in the
Web Connector Plug-in on the web server machine. The web server machine may
or may not be the same machine where you installed iPlanet Application Server.

To map HTTP variables to database fields, perform the following steps:

1. Open the iPlanet Registry Editor by typing kregedit at the command line.

The editor tool opens and displays the keys and values that apply to iPlanet
Application Server. If the web server and iPlanet Application Server are
installed on separate machines, the editor opens and displays the keys and
values that apply to the Web Connector Plug-in.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCS0\HTTPLOG\INPUTVARS

Each value under this key represents an HTTP variable and the database field
to which the variable is mapped.
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The ID of the value is the HTTP variable. The string value is the database field.

The HTTP variable is in ALL CAPS, such as HTTP_REFERER, and the database
field is exactly as it appears in the database table.

3. Double-click the HTTP variable you want to map to a database field.

The String editor dialog box appears.

4. Enter the database field name as the value data and click OK.

5. Leave any HTTP variables you do not want to log blank.

6. Close the editor.

See your web server documentation for an explanation of the HTTP variables.

Use the iPlanet Registry Editor to modify the Web Connector Plug-in.

Adding HTTP Variables to the Log
You can also modify the list of available HTTP variables, adding variables to the
list to expand your logging options.

To add HTTP variables to the log, perform the following steps:

1. Open the iPlanet Registry Editor by typing kregedit at the command line.

The editor opens and displays the keys and values that apply to iPlanet
Application Server. If the web server and iPlanet Application Server are
installed on separate machines, the editor opens and displays the keys and
values that apply to the Web Connector Plug-in.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCS0\HTTPLOG\INPUTVARS

Each value under this key represents an HTTP variable and the database field
to which the variable is mapped.

The ID of the value is the HTTP variable. The string value is the database field.

The HTTP variable is in ALL CAPS, such as HTTP_REFERER, and the database
field is exactly how it appears in the database table.

3. Add a new String value with the new HTTP variable name.

4. Click OK.

5. Repeat steps 3 through 5 for each new HTTP variable.
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6. Close the editor.

See your web server documentation for a list and an explanation of all available
HTTP variables.

Configuring Cookie and Hidden Field Usage
iPlanet Application Server is designed to work with web browsers in all modes of
cookie and hidden-field security. There are three configurations you can set for the
Web Connector Plug-in to support the various security modes. These
configurations are described in the following table:

To configure cookie and hidden field usage, perform the following steps:

1. Open the iPlanet Registry Editor by typing kregedit at the command line.

The editor tool opens and displays the keys and values that apply to iPlanet
Application Server. If the web server and iPlanet Application Server are
installed on separate machines, the registry editor opens and displays the keys
and values that apply to the Web Connector Plug-in.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCSO\HTTPAPI

3. Double-click the NoCookie DWORD value.

The DWORD editor dialog box appears.

4. To disable cookies being passed to the web browser, change the value data to 1.

5. To disable hidden fields being passed to the web browser, change the value
data to 2.

6. To enable both cookie and hidden fields, change the value data to 0.

Table 7-2 Configurations to Support Security Modes

Cookie setting Description

0 Cookies and hidden fields are passed back to the requesting web
browser. This is the default setting.

1 Only hidden fields are passed back to the requesting web browser.

2 Only cookies are passed back to the requesting web browser.
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7. When finished, close the editor.

Configuring URL Rewriting
iPlanet Application Server provides the user the choice of either using implicit URL
rewriting (the default method), or explicit URL rewriting.

By default, implicit URL rewriting is enabled. To enable explicit URL rewriting, use
kregedit to modify the default=implicit key in the iPlanet Application Server
registry path:

SOFTWARE/iPlanet/Application Server/6.0/CCS0/HTTPAPI/URLRewrite

To enable explicit URL rewriting, change the value default=implicit to
default=explicit.

Implicit URL rewriting is performed by the WebConnector Plugin and does not
require any changes to the code by the developer. To enable Explicit URL
Rewriting, which is performed by the Web container, developers have to modify
the Servlet or JSP code to make explicit calls to encodeURL and
encodeRedirectURL.

For more information on URL Rewriting, see iPlanet Application Server Developer’s
Guide.

Configuring a CGI Flag for CGI Requests
Some requests must be processed in CGI mode. You can set a flag in the Web
Connector Plug-in to identify those requests.

To configure a CGI flag for CGI requests, perform the following steps:

1. Open the iPlanet Registry Editor by typing kregedit at the command line.

The editor opens and displays the keys and values that apply to iPlanet
Application Server. If the web server and iPlanet Application Server are
installed on separate machines, the editor opens and displays the keys and
values that apply to the Web Connector Plug-in.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCSO\HTTPAPI

3. Double-click the AgentToken String value.
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The String Editor dialog box appears.

4. For the value data, enter the flag that marks requests for CGI mode processing.

5. Click OK.

6. Close the editor.

Changing the Web Connector Port Number
In certain configurations, the web connector port number might conflict with
another software package. You can reconfigure the connector port number to
resolve this conflict.

To change the Web Connector Plug-in port number, perform the following steps:

1. Open the iPlanet Registry Editor. by typing kregedit at the command line.

The editor opens and displays the keys and values that apply to iPlanet
Application Server. If the web server and iPlanet Application Server are
installed on separate machines, the editor opens and displays the keys and
values that apply to the Web Connector Plug-in.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCSO\HTTPAPI

3. Double-click the ListenPort DWORD value and change the value data to an
available port number.

4. Click OK.

5. Close the editor.

Specifying HTTP Variables for Input to
Application Components

HTTP variables can be passed as part of the application request to application
components like Enterprise Java Beans (EJBs). This allows the developer to
determine certain information about the request and use that information when
processing the request.
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For example, the application might look at the HTTP_REFERER variable to determine
where the request is coming from. This information might be used to present a
more individualized greeting screen, or to keep statistics about where requests
originate.

You edit entries in the registry to manage the HTTP variables. You can enable and
disable them as desired. By default, iPlanet Web Server provides the following
HTTP variables:

To specify HTTP variables for input to application components, perform the
following steps:

1. Open the iPlanet Registry Editor by typing kregedit at the command line.

HTTPS HTTP_USER_DEFINED

AUTH_USER HTTPS_KEYSIZE

CLIENT_CERT HTTPS_SECRETKEYSIZE

CONTENT_LENGTH PATH_INFO

CONTENT_TYPE PATH_TRANSLATED

HOST QUERY

HTTP_ACCEPT QUERY_STRING

HTTP_ACCEPT_CHARSET REMOTE_ADDR

HTTP_ACCEPT_ENCODING REMOTE_HOST

HTTP_ACCEPT_LANGUAGE REMOTE_IDENT

HTTP_AUTHORIZATION REMOTE_USER

HTTP_CONNECTION REQUEST_METHOD

HTTP_COOKIE SCRIPT_NAME

HTTP_HOST SERVER_PORT

HTTP_IF_MODIFIED_SINCE SERVER_PROTOCOL

HTTP_REFERER SERVER_SOFTWARE

HTTP_USER_AGENT SERVER_URL
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The editor opens and displays the keys and values that apply to iPlanet
Application Server. If the web server and iPlanet Application Server are
installed on separate machines, the editor opens and displays the keys and
values that apply to the Web Connector Plug-in.

2. Open the appropriate key:

❍ For iPlanet web servers, open the following key:

SOFTWARE\iPlanet\Application
Server\6.5\CCSO\HTTPAPI\INPUTNSAPI

❍ For Microsoft web servers, open the following key:

SOFTWARE\iPlanet\Application
Server\6.5\CCSO\HTTPAPI\INPUTISAPI

❍ For Apache web servers, open the following key:

SOFTWARE\iPlanet\Application
Server\6.5\CCSO\HTTPAPI\INPUTAPACHE

Each value name shown represents an HTTP variable. The value determines
whether the HTTP variable is passed to iPlanet Application Server with the
application request. If the name’s value is non-zero, the HTTP variable is
passed to the iPlanet Application Server machine with the application request.

The name is created in ALL CAPS, such as HTTP_REFERER.

3. Add a name that is the HTTP variable name.

4. Double-click the new HTTP variable (name) and enter one of the following as
the value:

❍ Enter a 0 to disable the HTTP variable.

❍ Enter a 1 to enable the HTTP variable.

5. Click OK.

6. Repeat steps 4 through 6 for each HTTP variable you want to
add/enable/disable.

NOTE You can disable any of the default HTTP variables by adding the
HTTP variable name and then setting the key name value to 0. For
example, you could add ENTITY_HEADER and set its value to 1
and then add HTTP_REFERER (a HTTP variable provided by
default) and set its value to 0 to disable it.
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7. Close the editor. You need to restart the Web Server for the changes to take
effect.
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Chapter 8

Administering Database Connectivity

iPlanet Application Server applications can access database(s), to add, retrieve, and
modify data. This chapter describes how to configure data access drivers and apply
settings to database connectivity parameters.

The following topics are included in this chapter:

• About Data Access Drivers

• Setting up Third Party JDBC drivers

• Registry Settings for Third Party JDBC Drivers

• Configuring Datasources

About Data Access Drivers
iPlanet Application Server applications often require database access. Database
access is achieved through a data access driver, software written either by the
database vendor or a third-party vendor. The following types of data access drivers
can be configured with iPlanet Application Server to provide database
connectivity:

• Oracle

• DB2

• Informix

• Sybase

• MS SQL server (on Windows)

• ODBC
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Make sure that data access drivers are installed before installing iPlanet
Application Server. This way, iPlanet Application Server can automatically
configure the drivers.

All third party JDBC drivers conforming to the JDBC 2.0 Extensions specifications
are supported by iPlanet Application Server. If your database driver does not
comply with the JDBC 2.0 Extensions framework, it will not work with iPlanet
Application Server.

Configuring Third Party JDBC Drivers
Third party JDBC drivers need be identified to iPlanet either during application
server installation, or via registration tools after installation. Registration must
occur on each application server instance housing applications with third party
JDBC driver datasources. For example, if you are configuring a two node cluster of
iPlanet Application Server, and you are making an application available on both
nodes in the cluster, then you must register the third party JDBC driver with each
instance. (Existing iPlanet Type 2 drivers have the same requirement).

This section describes the following topics:

• During Installation

• After Installation

• Setting up Third Party JDBC drivers

• Using Command Line Tools to Set up Third Party JDBC drivers

• Registry Settings for Third Party JDBC Drivers

NOTE •  Global transactions are not supported for Native JDBC
drivers. To use global transactions, you must configure a
third party JDBC driver.

Native drivers were deprecated in iPlanet Application
Server 6.0 SP1. Support for native JDBC drivers is limited to
maintain backward compatibility.

• For transactions support for your database driver, you must
use third party JDBC drivers that conform to JDBC 2.0 with
Extensions specifications.
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During Installation
You can configure the third party JDBC drivers only through the Custom
installation option. If you use the Express or Typical installation, see the next
section for configuring the third party JDBC drivers after installation of the
application server.

During application server Custom installation, you can only choose to configure
iPlanet Type 2, third party JDBC, or no JDBC drivers. Although you can only
configure either the Type 2 driver or third party JDBC driver during installation,
you can choose to configure both after installation.

After Installation
Configure third party JDBC drivers after installation through the iPlanet
Application Server Administration Tool.

Registration of iPlanet Type 2 JDBC drivers for the supported database platforms is
automatic since iPlanet automatically recognizes the presence of the supported
native client libraries.

For more information on registering database drivers after installation, see iPlanet
Application Server Administration Guide.

Setting up Third Party JDBC drivers
JDBC is the Javasoft specification of a standard API that allows Java programs to
access Database Management Systems (DBMSs). The JDBC API consists of a set of
interfaces and classes that can be used to perform the following procedures:

• Write applications and applets that connect to databases.

• Send queries written in Structured Query Language (SQL).

• Process the results.

You can configure native and third party JDBC drivers when you install iPlanet
Application Server. If you want to do this after installation, use the iPlanet
Application Server Administration Tool.

If you need to use command line tools to set up third party drivers, see Using
Command Line Tools to Set up Third Party JDBC drivers.
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Certified Third Party Drivers
The following table lists the third party JDBC drivers certified to work with iPlanet
Application Server 6.5.

To Set up Third Party JDBC Drivers
To configure third party JDBC drivers on Solaris and Windows, perform the
following steps:

1. Start the iPlanet Application Server Administration Tool.

❍ On Solaris, go to iASInstallDir/ias/bin

./ksvradmin

❍ on Windows, go to Start > iPlanet Application Server 6.5 > iAS
Administration Tool.

The Administration Tool starts up.

2. Select Database from the menu options.

3. Click the + sign next to the registered iPlanet Application Server to see all the
database options.

Table 8-1 Certified third party drivers on Solaris and Windows

Driver Platform

Oracle 8.1.7 Type 2 and Type 4 (thin), 9i Solaris and Windows

Merant (Intersolv) SequeLink DataDirect
Java 5.1

Solaris and Windows

(all databases supported by DDJ5.1)

Sybase jConnect for JDBC 5.2 Type 4 Solaris and Windows

DB2 JDBC 7.1 client Solaris and Windows

Access to Microsoft SQL Server Available from Merant for Windows only

Informix JDBC v2.1 Type 4 Solaris and Windows
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4. Select External JDBC Drivers > click Add.

You will see the following dialog box:

5. Enter a Driver Name for the driver you are configuring, for example driver1.

The Driver Name is a logical name by which you identify the driver to iPlanet
Application Server. This name is used to link datasource definitions back to a
physical driver type. The name can be of any string value you choose.
Examples include: driver1,ora-type4, ora-type2, and jconnect.
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6. Enter driver classpath, for example Oracle_Home/jdbc/lib/classes12.zip

The fully qualified path to the driver classes, JAR, or ZIP file. This zip file holds
the library classes for the driver. Specify the complete path as shown in the
following example:

usr/oraclient/jdbc/classes/lib/classes12.zip.

On Windows, the Driver Classpath will look like this:
D:\orant\jdbc\lib\classes12.zip.

The following table gives typical Solaris and Windows CLASSPATHs:

7. Enter Pooled Datasource Classname, for example
oracle.jdbc.pool.OracleConnectionPoolDataSource

Table 8-2 Typical Solaris and Windows CLASSPATHs

Driver Solaris CLASSPATH Windows CLASSPATH

Oracle Types 2
& 4

/oraclient/jdbc/lib/classes12
.zip

D:\orant\jdbc\lib\classes12.zip

SequeLink Java
5

/sljc/driver/lib/sljc.jar C:\sljc\driver\lib\sljc.jar

Sybase jConnect
5.2

/jConnect-5_2/classes/jconn
2.jar

D:\jConnect-5_2\classes\jconn2
.jar

DB2 /DB2DIR/java/db2java.zip D:\SQLLLIB\java\db2java.zip

Informix /lib/ifxjdbc.jar D:\lib\ifxjdbc.jar

NOTE If this Pooled Datasource Classname is
com.iplanet.ias.jdbc.IASConnectionPoolDataSource, then
you have to specify the JDBC Driver Class name specific to the
driver. For example:
com.pointbase.jdbc.jdbcUniversalDriver.

This option is required for drivers which only support Driver
Manager, for example PointBase, which is bundled with iPlanet
Application Server.

iPlanet Application Server provides wrappers to support pooled
connections for such drivers. The name of the wrapper is:
com.iplanet.ias.jdbc.iASConnectionPoolDatasource.
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8. Enter the XA Datasource Classname, for example
oracle.jdbc.xa.client.OracleXADataSource

9. Click OK to complete the driver registration process.

The new JDBC driver will show up in the Admin Tool under External JDBC
Drivers.

To Modify JDBC Driver Settings
Follow these steps to modify driver properties from the Administration Tool:

1. Select the driver you want to modify in the left pane of the Administration
Tool.

2. Click Modify in the right pane.

3. Make the required changes.

4. Click OK to commit the changes.

NOTE This is optional and need to be specified if you want to use
global transactions.
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Deleting a JDBC Driver
Follow these steps to delete a driver from the Administration Tool:

1. Select the driver you want to delete in the left pane of the Administration Tool.

2. Click Edit > Delete.

3. Click Yes when you are asked to confirm the deletion.

Using Command Line Tools to Set up Third
Party JDBC drivers
The following sections describe how to configure third party JDBC drivers on both
Solaris and Windows machines:

• To Set up Third Party JDBC Drivers on Solaris Using db_setup.sh

• To Set Up Third Party JDBC Drivers on Windows Using jdbcsetup.exe

To Set up Third Party JDBC Drivers on Solaris
Using db_setup.sh
To configure third party JDBC drivers, perform the following steps:

1. Go to <iasinstall>/ias/bin. Run the following script:

db_setup.sh

2. Choose the driver you want to install. You can see the following options:

1. iPlanet Type 2 JDBC Drivers

2. Third Party JDBC Drivers

Type (2) to configure native JDBC drivers, and press Enter.

3. Specify the directory on your machine in which iPlanet Application Server has
been installed, for example, /usr/iplanet/ias6. Press Enter.

4. Specify the number of drivers you want to configure and press Enter.

NOTE The dbsetup.exe utility on Windows has been deprecated and is no
longer part of iPlanet Application Server installation.
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These drivers can be configured for the same or different database clients.

5. Enter a Driver Name for the driver you are configuring, for example driver1.

The Driver Name is a logical name by which you identify the driver to iPlanet
Application Server. This name is used to link datasource definitions back to a
physical driver type. The name can be of any string value you choose.
Examples include: driver1,ora-type4, ora-type2, and jconnect.

6. Enter driver classpath, for example Oracle_Home/jdbc/lib/classes12.zip

The fully qualified path to the driver classes, JAR, or ZIP file. This zip file holds
the library classes for the driver. Specify the complete path as shown in the
following example:

usr/oraclient/jdbc/classes/lib/classes12.zip.

See Table 8-2 for typical Solaris classpaths.

7. Enter Pooled Datasource Classname, for example
oracle.jdbc.pool.OracleConnectionPoolDataSource

8. Enter the XA Datasource Classname, for example
oracle.jdbc.xa.client.OracleXADataSource

9. You will be prompted to set the environment variables for your driver in the
iASInstallDir/ias/env/iasenv.ksh file after installation.

NOTE If this Pooled Datasource Classname is
com.iplanet.ias.jdbc.IASConnectionPoolDataSource, then
you have to specify the JDBC Driver Class name specific to the
driver. For example:
com.pointbase.jdbc.jdbcUniversalDriver

NOTE This is optional and need to be specified if you want to use
global transactions.
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To Set Up Third Party JDBC Drivers on Windows
Using jdbcsetup.exe
Perform the following steps to set up native or third party JDBC drivers on a
Windows system:

1. Navigate to the iASinstallDir/ias6/ias/bin path. Run the following script:

jdbcsetup.exe.

The following window appears:

2. Enter a Driver Identifier for the driver, for example drive2.
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The Driver Name is a logical name by which you identify the driver to iPlanet
Application Server. This name is used to link datasource definitions back to a
physical driver type. The name can be of any string value you choose.
Examples include: driver2, ora-type4, ora-type2, and jconnect.

3. Enter the Driver class path, for example
Oracle_Home/jdbc/lib/classes12.zip

The Driver class path is the fully qualified path to the driver classes, JAR, or
ZIP file. This zip file holds the library classes for the driver. Specify the
complete path as shown in the following example:

d:\oracle\jdbc\lib\classes12.zip.

SeeTable 8-2 for typical classpath examples.

4. Enter the Pooled Datasource class name, for example
oracle.jdbc.pool.OracleConnectionPoolDataSource.

5. Enter the XA Datasource classname, for example
Database.Jdbc.xa.client.DatabaseXADatasource. If your database is
Oracle, type oracle.xa.jdbc.client.OracleConnectionXADataSource.

6. Click Add to register the driver.

You can choose to configure more drivers or click Cancel to abort the process.

Click OK to commit the changes.

NOTE Do not specify the class path if you are setting up a native JDBC
driver.

Registration of iPlanet Type 2 JDBC drivers for the supported
database platforms is automatic since iPlanet Application Server
automatically recognizes the presence of the supported native
client libraries.

NOTE If this Pooled Datasource Classname is
com.iplanet.ias.jdbc.IASConnectionPoolDataSource, then
you have to specify the JDBC Driver Class name specific to the
driver. For example:
com.pointbase.jdbc.jdbcUniversalDriver
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Registry Settings for Third Party JDBC Drivers
As you register third party JDBC drivers in iPlanet, you will see the following
iPlanet Registry settings:

Driver Entry
SOFTWARE\iPlanet\Application Server\6.5\CCS0\DAE3\DRIVERS\<driver
name>\

Under this key, you will find the driver's class name.

For more information registry key settings, see iPlanet Application Server Registry
Guide.

Configuring Datasources
A datasource contains information pertaining to the database client that the
database driver needs to know, to connect to the database. In iPlanet Application
Server 6.5, Datasource is a factory class for getting JDBC connections. It supports
both iPlanet native and third party JDBC drivers, as well as PooledDataSource
and XADataSource of third party driver implementations.

The datasource provides wrappers to support pooled connections for drivers
which only support driver manager.

The following topics are described in this section:

• New Datasource Features

• To Add a Datasource to an External JDBC Driver

• To Add Datasource To a Native Database Driver

• To Add a Datasource Using Deploy Tool

• To Add a Datasource Using Command-line Tools

• Datasource Configuration Parameters

• Modifying Third Party Datasources

NOTE You must first install and configure database driver(s) on your
machine before adding a datasource.



Configuring Datasources

Chapter 8 Administering Database Connectivity 193

New Datasource Features
The following new datasource features are available in iPlanet Application Server
6.5:

• Provides connection sharing for JDBC connections used in transactions and
provides mechanism to perform sanity check on connections being returned to
the user. If a pool is corrupted, it is automatically destroyed and a new pool is
created.

• Optional table based sanity.

• Supports dynamic configuration for few datasource properties such as:

❍ sanityRequired

❍ tableBasedSanity

❍ tableName

Registering Datasources
Use a third party JDBC driver for datasource-based access in iPlanet Application
Server for J2EE JNDI, connection pooling and, local and global transaction
management capabilities.

NOTE iPlanet Application Server 6.0 SPx based datasource XML format
has been deprecated. Use the Deployment Tool to migrate your old
datasource XML files to the new one.

For more information in migrating datasource XML files to 6.5, see
To Migrate 6.x Deployment Descriptor XML File.

NOTE If you have to use a third party JDBC driver without iPlanet's JDBC
integration, ensure that your application manually loads the driver
(typically performed through the DriverManager class), and sets up
the appropriate connection settings.

Configure the application server runtime environment with the
appropriate CLASSPATH and library path settings.
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Once you have registered a third party JDBC driver with the application server,
you must define JDBC datasources for applications to be able to interact with your
database management system.

This section describes the information required to register a JDBC datasource
associated with a third party or native JDBC driver in iPlanet Application Server.
Once you've registered a JDBC datasource in iPlanet, you can modify the
connection pooling settings from the Administration Tool.

The following sections explain how you can add a datasource, to both external
third party and native database drivers:

• To Add a Datasource to an External JDBC Driver

• To Add Datasource To a Native Database Driver

To Add a Datasource to an External JDBC Driver
To add a datasource to an external JDBC driver, such as a Type 4 JDBC driver,
perform the following tasks:

1. Start iASAT.

2. In the iASAT toolbar, click Databases.

The database connectivity settings that have been set for the machine are
displayed.

3. Select the External JDBC Datasources node , as shown in the following figure:
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4. Click Add in the right pane of the window. The Datasource Registration
window appears, as shown in the following figure:

When you register the datasource, a node is created in iASAT with this name.

❍ JNDI Name

The JNDI Name uniquely identifies the datasource within the JNDI
namespace of the application server. For example, a JNDI name of
dbc/estore/EstoreDB would be referenced in ias-web.xml and
ias-ejb-jar.xml files <resource-ref> entries of J2EE applications.

The <resource-ref> entries map resource names used by J2EE applications
to JNDI names defined within the application server.

❍ Driver Type

The driver-type maps to the logical name assigned to a third party JDBC
driver.

NOTE The JNDI name should be unique for each datasource that
you add.
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❍ Driver Name

A logical name by which you identify the driver to iPlanet. This name is
used to link datasource definitions back to a physical driver type. The
name can be of any string value you choose. Examples include:
"ora-type4", "ora-type2", and "jconnect".

❍ Username

The username is supplied to the RDBMS when iPlanet makes a connection
to the database. Username and password are optional, since they can be
supplied either programmatically, or on the connection URL.

❍ Password

The password is supplied to the RDBMS when iPlanet ApplicatioN Server
makes a connection to the database.

5. Under Vendor Specific properties, provide the JDBC driver vendor specific
data, for example, Property Name as URL and Property Value in the database
URL format.

6. Click OK to commit the vendor property value.

7. Click OK (in the main screen) to complete datasource registration.

To Add Datasource To a Native Database Driver
To add a datasource to a Native database driver, such as a Type 2 JDBC driver,
perform the following tasks:

1. Start iASAT. On Windows, from the Start menu, choose Programs>iPlanet
Application Server 6.5>iPlanet Application Server Administration
Tool.

On Solaris, navigate to <iASInstallDir>/ias/bin/ and type the following
command:
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kvsradmin

2. In the iASAT toolbar, click Databases.

3. In the left pane of the window, select the iPlanet Application Server instance
for which you want to add a datasource. You can see all the database
connectivity settings that have been set for that machine.

4. Select the iPlanet Type 2 JDBC Datasources folder, as shown in the following
figure:

5. To add a datasource, click Add in the right pane of the Databases window.

The iPlanet Type 2 JDBC Datasource Registration window appears, as shown
in the following figure:
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6. In the JNDI name field, enter a name for the datasource, for example, BankDB.
When you register the datasource, a node is created with this name.

7. In the Driver Type drop-down list, select the driver for which you want to add
a datasource.

8. In the DataSource field, enter the relevant value depending on the database
client for which you are adding a datasource. The database connects to the
driver using this value. The following table provides the values for each
database type that iPlanet Application Server supports:

NOTE The JNDI name should be unique for each datasource that you add.

NOTE For a native driver, you need to install the database client on your
machine.

Table  3 List of Datasource Values

Database Type Value for the DataSource field

Oracle TNS name of the Oracle database. You can find this value in the
tnsnames.ora file which is present in the
ORACLE_HOME/network/Admin directory.
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9. In the DataBase field, provide the name of the database, for example, Oracle.
For Sybase, the database name should be prefixed with the server name, in
order to connect to multiple sybase servers.

10. In the Username field, enter the user name that was provided when the
database client was installed.

11. In the Password field, enter the password for that user name.

12. Click OK to register the datasource. You need to stop and start iPlanet
Application Server, for the changes to take effect. See “Performing
Administrative Tasks Using iASAT”, for more information on starting and
stopping iPlanet Application Server.

To Add a Datasource Using Deploy Tool
Follow these steps to register a datasource using the Deploy Tool:

1. Start the Deployment Tool (deploytool)

2. Go to Tools->Register Datasource.

The following dialog box appears:

Sybase This is the name of the server on which the Sybase client has been
installed.

DB2 Any string value. When you connect to the database, you need to
provide this string value along with your user name and password.

Informix You do not need to provide any value in this field. The Informix
client automatically picks up the datasource when you log on.

Table  3 List of Datasource Values

Database Type Value for the DataSource field
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Figure 8-1 Registering datasources through Deploy Tool

3. Enter the database driver parameters, connection pooling parameters, and
connection sanity parameters.

For detailed explanation of these fields, see Datasource Configuration
Parameters.

4. Click Save As.

Enter a name for the new datasource deployment descriptor.

5. Click Register.

6. Select Register to register the datasource with one or more application server
instances.
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To Migrate 6.x Deployment Descriptor XML File
iPlanet Application Server 6.5 contains enhancements to the database connection
infrastructure. To take advantage of the new features and to continue to use you
older datasource configuration you will have to migrate to the new datasource
XML DTD.

1. Choose Tools > Register Datasource.

The datasource registration dialog will appear.

2. Click Open > select the XML file which contains the datasource descriptions.

The Deployment Tool will import the values present in the old XML file and
add default values for the new fields available in 6.5. in the XML file.

3. Accept the default values or modify them for your datasource.

4. Enter the database driver parameters, connection pooling parameters, and
connection sanity parameters.

For detailed explanation of the fields, see Datasource Configuration
Parameters.

5. Click Save.

The Deployment Tool will overwrite the datasource deployment descriptors
with the values you have specified, in the file you have opened.

Note: Select Save As to save the updated XML file with another name, and in a
different location.

6. Click Register.

The Deployment Tool will update the datasource deployment descriptors with
the values you have specified. Now your datasource will be able to take
advantage of the new features in iPlanet Application Server 6.5.

To Add a Datasource Using Command-line
Tools
Use the iasdeploy and regdatasource command line tools to register a
datasource.
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The iasdeploy tool is recommended for command line registration of
datasources. Example:

iasdeploy resreg EstoreDB.xml

If you are registering against a local server, you can use the resreg command:

resreg EstoreDB.xml

Datasource Configuration Parameters
These parameters are based on the JDBC 2.0 specification. Most of the properties
provided under these parameters are optional.

The following tables describe the various parameters on the datasource properties’
screen.

❍ Datasource Parameters

❍ Connection Pool Parameters

❍ Connection Sanity Parameters

❍ Datasource Registry Settings

Datasource Parameters

Table 8-4 Datasource configuration parameters

Configuration Parameters Description Default Values

Driver Type Type of driver (either one
of the drivers registered
with iAS)

None

database Name of the database on
the server

None

Datasource Name of the database on
the server.

None

Description Description of this
datasource

None

Username User’s account name None

Password Password None

serverName Database server name None
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Connection Pool Parameters

NetworkProtocol network protocol used to
communicate with the
server

None

Port Number The port number on which
the server is listening for
requests

None

Role Name Initial SQL role name None

Table 8-5

Configuration Parameters Description Default Values

Initial Pool Size The number of connections
obtained at the pool
creation time.

1

Min Pool Size The number of physical
connections the pool should
keep irrespective of the
maxIdleTime set.

The minPoolSize criteria
will be ensured once the
pool reaches the
minPoolSize.

The initialPoolSize
could be less than
minPoolSize as the
minPoolSize criteria will
be applied only when the
pool reaches the
minPooSize number.

1

Table 8-4 Datasource configuration parameters

Configuration Parameters Description Default Values
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Max Pool Size The maximum number of
physical connections that
the pool should contain.

Once the pool reaches the
maxPoolSize, and if the
waitQueue is enabled,
then the connection
requests will be queued. If
not, an SQLException will
be thrown.

30

Increment Pool Size The number of physical
connections obtained when
there are no free
connections available in the
pool and user requests for a
connection.

If the Pool has already
reached its maxPoolSize,
then SQLException will be
thrown.

1

Max. Idle Time (s) The time, in seconds, that a
physical connection should
remain unused in the pool
before the connection is
closed.

This criteria will be applied
only if the number of
unused, or free connections
in the pool, are more than
minPoolSize.

120

Table 8-5

Configuration Parameters Description Default Values
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Reclaim Time (s) The time till when the pool
will reclaim a connection
used by an application, in
seconds.

Reclaim Time comes into
picture when an application
acquires a connection but
forget to close the
connection.  If the
application forgets to close
the connection, then the
connection pool forcefully
closes the connection.

By default, the value is set
very high so that legitimate
programs are not effected.

Therefore, Reclaim Time
should be used only for
those buggy applications
which does not close the
connection explicitly by
calling
connection.close.

64000

Wait Time in Q (s) The time for which the pool
will keep connections in the
queue till a connection is
available to the database, in
seconds.

120

Enable Wait Q Set the pool to wait till a
connection is available.

True (enabled)

Q Length The number of connections
that will be maintained in
the queue.

30

Table 8-5

Configuration Parameters Description Default Values
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Connection Sanity Parameters

Enable Stat Enables the collection of
statistics about the
connection pool.

If Trace is enabled, then
both current and
cumulative statistics are
written to the KJS log when
the connection pool cleanup
thread is executed.

For more information, see
“Datasource Monitoring,”
on page 211.

Disable

Enable Trace Enables the tracing of
connection pool properties.
The Trace option writes
whatever function the
connection pool is currently
performing to KJS logs. The
messages are
self-explanatory.

Trace should be enabled to
output current and
cumulative statistics to KJS
logs.

Disable

Table 8-6 Datasource connection sanity parameters

Configuration Parameters Description Default Values

TableBasedSanity Enable table based sanity
(true/false)

False

IsSanityRequired Used to enable sanity
(true/false)

True

TableName Table name to be used in
case of table based sanity

ias_table

Table 8-5

Configuration Parameters Description Default Values
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Apart from dynamically changing all pool configuration parameters, you can also
modify pool configuration parameters for multiple datasources simultaneously.
For more information on modifying the datasource properties, see “Modifying
Third Party Datasources,” on page 208.

For more information on the parameters in this dialog box, please see the JDBC 2.0
Extensions specification.

The following table lists a few examples of database URL formats:

Table 8-7 Database URL formats

Driver Class name

Oracle Types 2 & 4 jdbc:oracle:oci8:@MyHostString
jdbc:oracle:thin:@myhost:1521:orcl

jdbc:oracle:thin:scott/tiger@myhost:1521:orcl
jdbc:oracle:oci8:scott/tiger@myhost

SequeLink Java 5 jdbc:sequelink://sequelinkhost:19996

jdbc:sequelink://192.168.5.96:19996;user=john;password=wh
atever

jdbc:sequelink://192.168.5.96:19996;databaseName=stores7

jdbc:sequelink://192.168.5.96:19996;databaseName=pubs;H
User=john;HPassword=whatever

jdbc:sequelink://sequelinkhost:4006;databaseName=pubs;D
BUser=john;DBPassword=whatever

jdbc:sequelink:ssl://mysecurehost:9500;cipherSuites=SSL_D
H_anon_WITH_3DES_EDE_CBC_SHA

jdbc:sequelink:ssl://mysecurehost:9502;

Sybase jConnect 5.2 jdbc:sybase:Tds:host:port

DB2 db2:jdbc:dbname

Informix jdbc:informix-sqli://mysecurehost:1528/database:informixse
rver=my_server

PointBase 3.5 jdbc:pointbase://localhost:9092/j2eeguide,
max.connections=100
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Datasource Registry Settings
As you register datasources associated with third party JDBC drivers, you will see
the following iPlanet Registry settings under

SOFTWARE\iPlanet\Application Server\6.5\DataSource\<jndi-name>\.

Modifying Third Party Datasources
Use iASAT to modify the various parameters associated with the registered
datasources. The following parameters can be modified for each datasource:

• Datasource Parameters
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• Connection Sanity Parameters

• Connection Pool Parameters

You can choose to modify either a single datasource at one time or, multiple
datasources simultaneously. The option to select and modify multiple datasources
at once allows you to set global connection pooling parameters for the selected
datasources.

The following section describes how to modify datasources - either a single one or
multiple datasources at the same time.

To Modify a Single Datasource
Follow these steps to modify a single datasource.:

1. From the iASAT menu bar, select Databases.

2. In the left pane, select External JDBC Datasource.

3. Select the datasource you want to modify in the DataSource Selection Box.

4. You can modify the properties that are available in the right pane.
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5. After completing the modifications, click Apply Changes to save the changes.

To Modify Multiple Datasources
By modifying multiple datasources, you can set global connection pool parameters
for a number of datasources.

Follow these steps to modify multiple datasources.

1. Follow the first two steps from “To Modify a Single Datasource,” on page 209.

2. Select the datasources you want to modify by pressing down the Shift key.

You will notice that the Datasource Parameters entries have been greyed out.
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When you select multiple datasources, only the Connection Sanity Parameters
and Connection Pool Parameters can be modified.

3. Make the changes you want to the Connection Pool Parameters that will be
common to the selected datasources.

4. After you have finished making the changes, click Apply Changes to save the
changes.

Datasource Monitoring
iASAT provides the functionality to collect statistics of all the active connection
pools.

NOTE When you select multiple datasources, the Connection Pool
Parameters are returned to their default values.
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To view the statistics for a particular datasource, select the datasource in the left
pane of iASAT. If multiple KJS’ are configured, choose the KJS for which you want
to view the statistics from the Engine ID drop-down box.

Administrators can monitor, configure, and manage the connection pools created
for a particular datasource. The admin tool provides options to enable and disable
pool statistics. Statistics can be enabled from this screen, as well as from the main
datasource panel.

It provides two types of statistics for pools:

• Current Statistics

• Cumulative Statistics

Current Statistics
The administration tool displays current statistics for the selected datasource
irrespective of whether the Enable Stats check box is enabled.The parameters
monitored under Current statistics are:

• Total connections in pool

• Connections in use

• Waiting queue size.
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Cumulative Statistics
Cumulative statistics provides information on the connection pool from the time
Enable Stats is enabled. To view cumulative statistics from the admin tool, both
Stats and Trace needs to be enabled. The output is written to the KJS log when
the connection pool cleanup thread is executed.

The value displayed for each parameter is a cumulative value of all the pools
created for that datasource. The parameters monitored under cumulative statistics
are:

• Peak value for total connections in Pool.

❍ Peak value for connections in use.

❍ Peak value for queue size.

• Cache hits.

• Cache misses.

• Total connection requests.

• Total connections dropped.

• Connections obtained after wait.

• Connections dropped after wait.

• Connections reclaimed.

• Connections released after idle time.

Statistics in Detail
You can view all the above mentioned parameters in detail for each pool by
clicking on the Detail button. This option, apart from the above parameters,
shows the pool name and pool type (XA, Normal).

The other options that the admin tool provides are:

• Destroy Pool

• Flush Pool

NOTE Enabling Stats alone does not produce any output in the KJS logs,
Trace must also be enabled. When Stats and Trace is enabled,
both current and cumulative statistics are written to the KJS logs.
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Destroy Pool
You have the option to destroy the connection pool by selecting the Destroy
button. The Destroy pool option will remove all the connections from the pool.

Flush Pool
You have the option to flush the connection pool by selecting the Flush button. The
Flush pool option will remove all the idle connections from the pool.

To Delete a Datasource
Follow these steps to delete a datasource:

1. From the iPlanet Application Server Administration Tool select the datasource
you want to delete.

2. Press the Delete button on the Keyboard.

3. Click Yes when asked for confirmation.

When a datasource is deleted from the Administration Tool, the corresponding
datasource object is also deleted from the initial context.

Datasource XML Format
The new XML format provided in iPlanet Application Server 6.5 is flexible and
supports standard JDBC datasource properties and driver specific datasource
properties. Old XML formats used by iPlanet Application Server 6.0 SPx for
datasource registration are automatically converted to the new XML format. The
converted XML file is stored as xmlfilename.new.

The following is an example of the new XML datasource format:

Code Example 8-1 New datasource XML format

<ias-resource>

<resource>

<jndi-name>jdbc/dsName</jndi-name>

<jdbc>
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<user>admin</user>

<password>admin</password>

<database-url>jdbc:oracle:oci8:@rcl</database-url>

<driver-name>oracle_xa</driver-name>

Add extra data here, for example, port number <port>1050</port>

<conn-pooling>

<initialPoolSize>1</initialPoolSize>

<waitQueueEnabled>true</waitQueueEnabled>

<reclaimTime>1200</reclaimTime>

<maxPoolSize>abc</maxPoolSize>

<maxIdleTime>120</maxIdleTime>

<queueLength>20</queueLength>

<trace>false</trace>

<stat>false</stat>

<waitTimeInQueue>120</waitTimeInQueue>

<incrementPoolSize>1</incrementPoolSize>

<minPoolSize>5</minPoolSize>

</conn-pooling>

</jdbc>

</resource>

</ias-resource>

Examples for other database vendors are available in iPlanet Application Server
Developer’s Guide.
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Chapter 9

Administering Transactions

This chapter describes the tasks and conceptual information necessary for
administering transactions using the iPlanet Application Server Administration
Tool (iASAT)

The following topics are included in this chapter:

• About the Transaction Manager

• Administering Distributed Transactions from iASAT

• Monitoring Transactions

About the Transaction Manager
The transaction manager is installed with each instance of iPlanet Application
Server to coordinate global transactions within a Java Server (KJS) process. Global
transactions are a set of related operations that must be executed as a unit, though
each operation may run in a different process.

You can use global transactions to update a database that uses one or more
Enterprise Java Beans (EJBs) running concurrently for the same global transaction,
from within one or more KJS processes. This occurs when an EJB triggers another
EJB to run and they both participate in the same transaction. You can also update
multiple databases that are distributed over different geographic locations or
update multiple databases of different types (such as Oracle and Sybase).The
transaction manager runs within a KJS process.



About the Transaction Manager

216 iPlanet Application Server Administrator’s Guide • October 2002

New Features
Beginning with iPlanet Application Server, Enterprise Edition 6.5 release, the
bundled transaction manager is based on the Java Transaction Service Reference
Implementation (JTS RI) with suitable modifications for production environments.

A local transaction manager has also been added for optimization of applications
that use local transactions.

The datasource manager now has enhanced functionality and provides support for
XADataSource, PooledDataSource and DriverManager. New Connection Pooling
infrastructure has been implemented to support pooling of XA connections and
Pooled connections.

The following new features have been added to the transaction manager:

• Flexibility to run both global and local transactions at the same time.

• Provision for the user to specify the transaction type at three levels:

❍ Instance wide

❍ At package level (under J2EE-Module/package name)

❍ At component level.

iPlanet Application Server determines the transaction type for a particular
component/application by initially referring under the package name,
followed by the component <classdef\<guid>, and finally for instance wide
value under <CCSO\TXNMGR> in the registry.

• Support for recovery.

When iPlanet Application Server starts up, it queries for all pending
transactions from all databases used by datasources registered in the registry,
and performs recovery. Recovery can also be disabled.

The new transaction manager has better administration control, monitoring and
tracing facility. The iPlanet Application Server Administration Tool has been
enhanced significantly to support administration and monitoring features.

TIP You can achieve better performance by specifying the transaction
type at the component level.
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Administering Distributed Transactions from
iASAT

You can administer transactions using the Transaction menu option of iPlanet
Application Server Administration Tool.

This section describes the following topics:

• About the Transaction Window

• Viewing Transactions Per Server

• Configuring Transactions Per Server

• Administering Transactions Per Process

• Viewing Transactions on a Selected Process

• Administering Transactions Per Process

About the Transaction Window
The left pane of the Transaction window displays a tree of nodes as shown in the
following illustration:

Figure 9-1 Transaction manager configuration tab
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The top level of the tree lists which servers are registered with iASAT. The second
level, below each registered server name, displays one or more process nodes.
These nodes indicate which processes are running on each registered server. Only
Java Server (KJS) processes appear in the tree because only KJS processes support
transactions.

The KJS process is displayed alongwith the port number (for example,10819) and
the ORB port (for example, 10920) used to connect to the JMS Listener.

Configuring Transactions Per Server
When you select an iPlanet Application Server instance and click Transactions on
the menu bar, the global properties for that server instance is displayed. All KJS
instances share the properties of iPlanet Application Server except for their identity
(Engine Id, port number, etc.). Changes made in this Configuration dialog box will
affect all transactions running on that server.

To change transaction settings for an application server, click a registered server in
the left pane of the Transaction window. The Configuration tab appears in the right
pane as shown here:

Figure 9-2 Configuration options for a server instance
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The following options can be configured:

• Transaction Type

You can set the transaction type to either local or global.

When global transactions are enabled, transactions can span across multiple
heterogeneous databases and processes.

• Time out

Set this time (in seconds) to rollback a transaction if it’s not completed in the
stipulated time. This would be helpful in cases where a transaction process was
started (for example a stateful session bean), but a bug in the application
design prevented its completion.

• Wait Interval

The Wait Interval specifies the time (in seconds) iPlanet Application Server will
wait before clearing stale or corrupt transactions.

• Log Directory

Specify the path where the transaction manager will store its log files. The
default is iASInstallDir/ias/logs/jts.

Viewing Transactions Per Server
To view details about a transaction, click the Transaction Manager tab. The
Transactions Manager dialog box appears with detailed information on the status
of various transactions in progress.
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Figure 9-3 Transaction properties for a server instance

The entries in the detailed view are explained below:

• Process

The Process tab displays the KJS engine to which the transaction belongs.

• Transaction ID

The transaction ID given to the transaction by the connection pool manager.

• State

The four states that are displayed are: prepared, running, rollbacked,
committing.

• Type

Shows whether the transaction is local or global.

• Originator

Originator indicates which servlet or bean originated the transaction.

• Elapsed Time

Shows the time since the transaction was started.

TIP You can click on the table heads to sort the data.
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Administering Transactions Per Server
Multiple entries can be selected at a time to control the active transactions. At the
bottom of the dialogue box are options which will enable you to control the
transactions that are in progress.

• Mark for Rollback

Use the Mark for Rollback option to roll back an active transaction. Select the
required transaction and click Mark for Rollback.

You can also roll back multiple transactions at the same time by selecting them
while holding the Shift key down, and pressing Mark for Rollback.

• Update

Click Update periodically to remove expired transactions from view and
display currently running transactions in the window.

Administering Transactions Per Process
You can administer each transaction process connected to a particular KJS engine
running under the desired iPlanet Application Server instance. This option allows
allows you granular control of transactions running on iPlanet Application Server.

Viewing Transactions on a Selected Process
To view the status of transactions on a particular KJS engine, select the required
engine in the left pane. The transactions running on that engine will be displayed
in the right pane.

NOTE Sometimes when you roll back a transaction, you may get a
message, “Transaction does not exist”. This is because the
transaction may have completed before your command got
executed.
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Figure 9-4 Transaction properties for a KJS engine

The entries in the detailed view are explained below:

• Transaction ID

The transaction ID given to the transaction by the connection pool manager.

• State

The four states that are displayed are: prepared, running, rollbacked,
committing.

• Type

Shows whether the transaction is local or global.

• Originator

Originator indicates which servlet or bean originated the transaction.

• Elapsed Time

Shows the time since the transaction was started.

TIP You can click on the table heads to sort the data.
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Administering Transactions Per Process
Select the application server instance in the left pane and then click on the
Transactions icon on the menu bar. You will get the dialog box as shown in
Figure 9-4 on page 222.

Multiple entries can be selected at a time to control the active transactions. At the
bottom of the dialogue box are options which will enable you to control the
transactions that are in progress.

• Mark for Rollback

Use the Mark for Rollback option to roll back an active transaction. Select the
required transaction and click Mark for Rollback.

You can also roll back multiple transactions at the same time by selecting them
and pressing Mark for Rollback.

• Freeze Transactions

Use the Freeze Transactions option to temporarily stop all active transactions.
You will be prompted to confirm whether you want to go ahead and stop all
transactions.

Press OK if you want to go ahead or Cancel to exit the Freeze option.

When the Freeze Transactions option is used, no new transactions will start
and existing transactions will be frozen at the next logical step.

• Unfreeze Transactions

Use Unfreeze Transactions to resume all transactions that were stopped by the
Freeze command.

You will be prompted for confirmation. Press OK to Unfreeze all existing
transactions.

• Update

Click Update periodically to remove expired transactions from view and
display currently running transactions in the window.
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Monitoring Transactions
The monitoring framework enables the display of various properties related to the
module. These could be used to get a view of the system’s internals to help fine
tune application parameters, detect bottlenecks, and check the health of the
application.

JTS provides more advanced monitoring facility for transactions. All results are
displayed by the admin tool. It provides following features:

• Displays all active transactions with the following information:

❍ Transaction ID

❍ Component that started the transaction,

❍ Status (prepared, running, rollbacked, committing)

❍ Transaction type (global/local)

❍ Elapsed time

• Displays TPM for both local and global transactions.

A value called sample time is displayed and is editable by the user. The sample
time would be used to compute the TPM. And it would be displayed. In
addition to a total count, there are two other values- one for local, and one for
global.

• Displays average time taken for each transaction (both global and local). For
the sample time, average time for transaction, local transaction and global
transaction are displayed.

Configuration Parameters
Configuration parameters provided for transaction manager are as follows:

Table 9-1 Transaction Manager configuration parameters

Configuration parameters Description Default Value

DefaultTxnType This key will be used to
determine the type of
transactions.(can be
local/global)

local

LogDirectory This directory will be used
for storing jts logs

$IAS_INSTALLDIR/ias/
logs/jts
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All keys can be found in registry under
SOFTWARE/iPlanet/ApplicationServer/6.5/CCS0/TXNMGR

RecoveryEnabled When the recovery is
enabled, when the kjs
comes up it will try to
recover the pending
transactions.(1/0, 1 to
enable, 0 to disable)

0

Timeout Default transaction
timeout.(in seconds)

60

TimerThreadInterval Interval at which the
timeout thread will be
invoked to clean up the
timedout transactions (in
seconds).

30

TraceEnabled Used to enable/disable
tracing.(values can be 1 or
0, 1 for enable, 0 for
disable).

0

TraceFile Tracing data will written
into this file

$IAS_INSTALLDIR/ias/lo
gs/txntrace

TraceLevel Used to provide trace level
(1 to 6, 1 being low and 6
being high).

0

Table 9-1 Transaction Manager configuration parameters

Configuration parameters Description Default Value
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Figure 9-5 Registry keys for transactions

Resolving In-Doubt Transactions
Occasionally, particularly when a Java Server (KJS) process quits suddenly, you
may find “hanging” or in-doubt transactions. For Microsoft SQL Server, in order to
manually commit or rollback in-doubt transactions, use DTC administrator
control. This is also known as DAC. dac.exe is found in the WINNT\SYSTEM32\
directory and is installed with DTC.

After starting DAC, perform the following steps to manually commit or rollback
in-doubt transactions:

1. From the iASAT toolbar, click Transactions to open the Transactions window.

2. Click the Transaction Manager tab.
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3. Select the transaction that you want to force and click Details.

4. Click Resolve/Abort to force rollback the transaction.

For Oracle resource managers, if you encounter a “lock held by distributed
transaction” error, you must connect to the database and rollback the global
transaction explicitly. To do so, perform the following steps:

1. Find out the local transaction ID that corresponds to the transaction by looking
at dba_2pc_pending, which has all the details about pending global
transactions.

For example, type the following at the SQLPLUS prompt:

SQLPLUS>select * from dba_2pc_pending

2. Rollback the transaction by typing

rollback force transaction_id

at the command line.

For Sybase resource managers, if you encounter a “lock held by distributed
transaction” error, you must connect to the database and rollback the global
transaction explicitly. To do so, perform the following steps:

1. Find out the local transaction ID that corresponds to the transaction by running
sp_xa_scan_xact, which supplies a list of transaction identifiers.

2. Use sp_finish_xact with a transaction identifier and a stat (either commit or
rollback) to force the branch to complete.
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Chapter 10

Enabling Support For Corba-Based
Clients

Earlier versions of iPlanet Application Server supported only the built-in Javasoft
ORB to access EJBs through the RMI/IIOP protocol. The current version of iPlanet
Application Server supports the use of a third-party ORB, ORBIX 2000, from IONA
Technologies, apart from the Javasoft ORB. You can now choose between the
built-in Javasoft ORB and ORBIX 2000, to provide server-side support to Corba
elements.

This section describes how to configure RMI/IIOP support for Corba-based clients
to access EJBs using either of the following ORBs:

• iPlanet Application Server’s Built-In Javasoft ORB

• ORBIX2000

The following topics are discussed in this section:

• Configuring Support For Javasoft ORB

• Configuring Support For ORBIX2000

Configuring Support For Javasoft ORB
You must add a CXS (Bridge) process to iPlanet Application Server, if Corba-based
clients are to communicate directly with EJBs hosted on a KJS process via the
Internet Inter-ORB Protocol (IIOP). Typically, requests are made through a web
path where they originate at a Web Browser and are then processed by JSPs and
servlets, which in turn access EJBs. This web path uses the HTTP protocol. In the
case of Corba-based clients, requests are made through the JavaSoft ORB directly to
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EJBs using the CORBA Executive Server (CXS), a Java engine within iPlanet
Application Server, which acts as a bridge between Corba-based clients and EJBs.
For more information about developing and deploying Corba-based clients, see the
Developer’s Guide.

The following figure depicts the communication architecture within iPlanet
Application Server, and the communication between Corba-based clients and EJBs
in the server, using the CXS bridge process.

Figure 10-1 iPlanet Application Server Communication Architecture

To add a CXS (Bridge) process, perform the following tasks:

1. On the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
instance where you want to add the CXS process.

3. From the File menu, click New>Process.

The New Process dialog box appears.
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4. From the Process drop-down box, choose CXS.

5. In the Port text box, specify an unused port number where the additional
process will run. This is an internal iPlanet Application Server engine port.

6. In the IIOP Port text box, specify a port number to be used by the Corba-based
client to talk to CXS. This is the port in which CXS listens for the Corba-based
client.

7. Click OK to add the new process.

8. To use this process in a single-threaded environment, perform the following
tasks:

a. Select the required process in the left pane of the General window.

b. In the right pane of the window, set the Minimum and Maximum Threads
to 1.

9. Click Apply Changes to save your changes.

Configuring Support For ORBIX2000
This section describes how to configure iPlanet Application Server for ORBIX 2000
support. The following topics are discussed in this section:

To Configure ORBIX Support on Solaris

To Configure ORBIX Support on Windows NT

To Configure ORBIX Support on Solaris
To configure ORBIX support on Solaris, perform the following tasks:

1. Install ORBIX 2000 version 1.2.1.



Configuring Support For ORBIX2000

232 iPlanet Application Server Administrator’s Guide • October 2002

2. Copy the license file to your machine and install the license. Refer to the ORBIX
documentation at http://www.iona.com for more details regarding license
installation.

3. Create a configuration domain for ORBIX.

ORBIX comes with a default localhost domain configuration that can be used
when both iPlanet Application Server and Corba elements are running on the
same machine.  If both iPlanet Application Server and the Corba elements are
running on different machines, you need to create a new configuration domain
using either the file-based method or repository-based method. In file-based
domain creation method, the complete configuration details relating to the
services are maintained in a configuration file. This file is created after you
perform the steps required for domain creation.

Refer to the ORBIX Administrator’s Guide for more information.

4. You now need to add interceptors for security services in the configuration file,
as follows:

a. Add server interceptor name iASServerInterceptor to the
server_binding_list at the global scope, in the configuration file that
you created.

For example, before you add the server interceptor name, the relevant
entry in the configuration file will look like this:

binding:server_binding_list=[OTS]

After you add iASServerInterceptor as the server interceptor name, the
configuration file entry will look like this:

binding:server_binding_list=[iASServerInterceptor, OTS]

b. Add the interceptor portable_interceptor to the orb_plugins entry in
the configuration file.

For example, before you add the interceptor portable_interceptor to
the orb-plugins entry, the entry looks like this:

orb_plugins=[iiop_profile,giop,iiop,ots]

After you add portable_interceptor as the portable interceptor name to
orb-plug ins, the entry looks like this:

orb_plugins=[iiop_profile,giop,iiop,ots,portable_interceptor]

5. You now need to modify the common environment variables file, iasenv.ksh,
to let iPlanet Application Server know the location of the ORBIX configuration
on your machine.
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a. Open iasenv.ksh. Navigate to the ORBIX configuration section, which
comes under the ORBIX Configuration Settings comment.

b. In the following variable, indicate the name of the directory in which
ORBIX is installed:

IT_PRODUCT_DIR = <ORBIX product install directory>

c. In the following variable, indicate the name of the directory into which you
have copied the ORBIX license file, licenses.txt:

IT_LICENSE_FILE_DIR= <path to ORBIX license file>

d. In the following variable, indicate the ORBIX configuration domain name.

ORBIX_DOMAIN_NAME=<configuration domain name>

e. In the following variable, indicate the path to the ORBIX configuration
domain file.

ORBIX_CONFIG_DOMAINS_DIR = <configuration file path>

f. In the following variable, indicate if you want to enable load-balancing
across CXS (Corba Executive Server), which is the server-side RMI/IIOP
process.

ORBIX_LOADBALANCING= true or false.

Load balancing across CXS is enabled, by default. Setting the flag to false
will turn this feature off.

g. The JAVA_ARGS variable is set for the JavaSoft ORB in iasenv.ksh, as
follows:

JAVA_ARGS=-Xss512k -Xms64m -Xmx64m

To enable support for ORBIX, you need to un-comment this variable, as
shown below:

##JAVA_ARGS=(-Xss512k -Xms64m -Xmx64m)
-DBridge_ORB_CLASS=com.iona.corba.art.artimpl.ORBImpl
-DORBIXLoadBalancing=$ORBIX_LOADBALANCING
-Xbootclasspath/a:$IT_PRODUCT_DIR/orbix_art/1.2/classes/omg.jar
-DORBdomain_name=$ORBIX_DOMAIN_NAME
-DORBconfig_domains_dir=$ORBIX_CONFIG_DOMAINS_DIR
-Dorg.omg.PortableInterceptor.ORBInitializerClass.com.iplanet.ia
s.iona.orbinitializers.IONAServerORBInitializerImpl=

If you want to enable support for JavaSoft again, reverse the above step.

6. Modify the following property in the orb.properties file, which is available in
the iASInstallDir/ias/usr/java/jre/lib:
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org.omg.CORBA.ORBSingletonClass=com.iona.corba.art.artimpl.ORBSingleton

7. To set ORBIX environment variables, execute the following commands at the
command line. Note that each command begins with a period (.), followed by a
space:

 . <orbix installation directory>/bin/<domain name>_env

 . <orbix installation directory>/bin/<domain name>_java_env

For example, if the domain name is “Marigold”, then:

. <orbix installation directory>/bin/marigold_env

. <orbix installation directory>/bin/marigold_java_env

8. Execute the following command to start the ORBIX service:

<orbix installation directory>/bin/start_<domain name>_services

For example, if the domain name is “Marigold”, then -

/space/iona/bin/start_marigold_services

9. Deploy the required applications. Ensure that the stubs and tie are regenerated
when the application is deployed and restart iPlanet Application Server.

The CXS engine, once registered, starts to process objects in the client-side
object groups. The RMI/IIOP ORB sends requests to the CXS engine and
continues to do so, even when the CXS engine is down. To avoid this, you need
to ensure that all the registered CXS engines are up. Normally, the KAS (the
Administrative Server) brings up failed server engine processes. However, if a
CXS engine is either disabled, deleted or not started (this may happen if KAS is
not started), it is better to delete that engine's object from all the object groups.
You can do that by using the following commands:

To list the current object groups handled by CXS engines - itadmin nsog list

To list the current members - itadmin nsog list_members <Group Name>

To remove a member (member name is equal to the engine number) -

itadmin nsog remove <GroupName>

 or

itadmin nsog remove_member -og_name <GroupName> <engine no>

To confirm removal -itadmin nsog list_members <Group Name>

The <group name> is the ejb-name + Group
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To Configure ORBIX Support on Windows NT
You can configure ORBIX support on Windows NT, by performing the following
tasks:

1. Install ORBIX 2000 version 1.2.1.

2. Copy the license file to your machine and install the license. Refer to the ORBIX
documentation at http://www.iona.com for more details.

3. Modify the following iPlanet Registry keys as indicated below:

SOFTWARE\iPlanet\Application Server\6.5\Java\ClassPath=<path to

ORBIX license file >;<path to ORBIX domain configuration

file>;<ClassPath>;<orbix_inst_dir>\orbix_art\1.2\classes\orbix20

00.jar;<orbix_inst_dir>\orbix_art\1.2\localhost

4. Modify the following iPlanet Registry as indicated below:

SOFTWARE\iPlanet\Application Server\6.5\Java\JavaArgs =
-Xbootclasspath/a:<orb_inst_dir>\orbix_art\1.2\classes\omg.jar

-DIASORBCLASS=com.iona.corba.art.artimpl.ORBImpl

-DORBdomain_name=domain name

-DORBconfig_domains_dir=<path to ORBIX domain configuration
file>

-Dorg.omg.PortableInterceptor.ORBInitializerClass.com.iplanet.ia
s.iona.orbinitializers.IONAServerORBInitializerImpl=

NOTE • <orbix_inst_dir> is the ORBIX installation directory.

• <orbix_inst_dir>\orbix_art\1.2\classes\orbix2000.jar

is path for ORBIX implementation JAR file - orbix2000.jar.

• <ClassPath> the existing specification, in iPlanet Registry.

• Refer to “About iPlanet Registry Editor,” on page 32 for
information on how to modify keys in iPlanet Registry.
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-DORBIXLoadBalancing=true

5. If iPlanet Application Server and the Corba client are running on different
machines, you need to create a new configuration domain on the machine
where ORBIX services are running. You can generate the domain configuration
using the file-based method or the repository-based method. Refer to the
ORBIX Administrator’s Guide for more information.

In the file- based domain creation method, the configuration details relating to
ORBIX services are maintained in a configuration file. This file is created when
you create a configuration domain in a specific path.

You need to update the following iPlanet Registry with the new configuration
domain name and and the path for the configuration domain file:

SOFTWARE\iPlanet\Application Server\6.5\Java\JavaArgs =
-DORBdomain_name=domain_name -DORBconfig_domains_dir=domain_path

For example, if the configuration domain name is Marigold, and the domain
configuration file is stored in the path D:\iona\domains, then you need to
modify the following iPlanet Registry key as given below:

SOFTWARE\iPlanet\Application Server\6.5\Java\JavaArgs =
-DORBdomain_name=marigold
-DORBconfig_domains_dir=D:\iona\domains

6. You now need to modify the ORBIX configuration file as given below, to
enable security services:

NOTE • IBride_ORB_CLASS refers to the ORB to be loaded. In this case,
it is com.iona.corba.art.artimpl.ORBImpl which is the
ORBIX ORB.

• If both iPlanet Application Server and the Corba client are
running on the same machine, you do not need to add
ORBdomain_name and ORBconfig_domains_dir to the JavaArgs
key in iPlanet Registry. These are configured in the local host
configuration file that comes with ORBIX.
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a. Add server interceptor name iASServerInterceptor to the
server_binding_list at the global scope in the configuration file.

For example, before you add the server interceptor name, the relevant
entry in the configuration file will look like this:

 binding:server_binding_list=[OTS]

After you add iASServerInterceptor as the server interceptor name, the
configuration file entry will look like this:

 binding:server_binding_list=[iASServerInterceptor,OTS]

b. Add the interceptor portable_interceptor to the orb_plugins entry in
the configuration file.

For example, before you add the interceptor portable_interceptor to
the orb-plugins entry, the entry looks like this:

 orb_plugins=[iiop_profile,giop,iiop,ots]

After you add portable_interceptor as the portable interceptor name to
orb-plug ins, the entry looks like this:

orb_plugins=[iiop_profile,giop,iiop,ots,?portable_interceptor
?]

7. Load balancing across CXS is enabled, by default. To disable load balancing,
set the following JavaArgs arguement to False, in iPlanet Registry:

SOFTWARE\iPlanet\Application Server\6.5\Java\JavaArgs

=ORBIXLoadBalancing = false

NOTE The following command displays all object groups:

<orbix home>/bin/itadmin nsog list

 The following command displays all the objects bound to a group:

<orbix home>/bin/itadmin nsog list_members <Group Name>

You can turn the load-balancing feature on or off, using the
following command:

 <orbix home>/bin/itadmin nsog modify -type
[rr|rand|active] <GroupName>

Note that the ‘group name’ is the ejb name+Group.
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The CXS engine, once registered, starts to process objects in the client-side
object groups. The RMI/IIOP ORB sends requests to the CXS engine and
continues to do so, even when the CXS engine is down. To avoid this, you need
to ensure that all the registered CXS engines are up. Normally, the KAS (the
Administrative Server) brings up failed server engine processes. However, if a
CXS engine is either disabled, deleted or not started (this may happen if KAS is
not started), it is better to delete that engine's object from all the object groups.
You can do that by using the following commands:

To list the current object groups handled by CXS engines:

itadmin nsog list

To list the current members:

itadmin nsog list_members <Group Name>

To remove a member (the member name is the same as the engine number):

itadmin nsog remove <GroupName>

 or

itadmin nsog remove_member -og_name <GroupName> <engine no>

To confirm removal:

itadmin nsog list_members <Group Name>

The <group name> is the ejb-name + Group

8. Modify the following property in the orb.properties file, which is available in
the iASInstallDir/ias/usr/java/jre/lib:

org.omg.CORBA.ORBSingletonClass=com.iona.corba.art.artimpl.ORBSingleton

9. Deploy the required application. Ensure that the stubs and ties are regenerated
while deploying the application.

10. Set ORBIX environment variables by running the following commands at
command prompt:

<orbix installation directory>/bin/<domain name>_env.bat

<orbix installation directory>/bin/<domain name>_java_env.bat

For example, if the domain name is Marigold, then:

<orbix installation directory>/bin/marigold_env.bat

<orbix installation directory>/bin/marigold_java_env.bat
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11. Start ORBIX services by executing following command at the command
prompt: <orbix installation directory>/bin/start_<domain
name>_services.bat

12. Start iPlanet Application Server.

Refer to the Developer’s Guide for information on client-side Corba programming.
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Chapter 11

Administering Message Driven Beans

To deploy and run message-driven beans on iPlanet Application Server, you must
first setup the Java Message Service (JMS) provider to enable clients to connect to a
message-driven bean.

The message-driven bean acts as a JMS message listener, and therefore a messaging
middleware needs to be configured to enable deployment of message-driven
beans. Currently, only the Java Message Queue is supported in this version of
iPlanet Application Server.

This chapter contains the following topic:

• Configuring a JMS Provider

• Administering Message Driven Beans

For more information on deploying message-drivem beans, see iPlanet Application
Server Developer’s Guide and the Deployment Tool online help.

Configuring a JMS Provider
To configure a JMS provider, you must first install the messaging middleware. By
default, iPlanet Application Server uses the iPlanet Message Queue (iMQ) for Java,
2.0 SP1. iMQ for Java, 2.0 SP1 is bundled on the iPlanet Application Server
installation CD. If you don’t have the installation CD, you can download it from
http://www.iplanet.com/products/iplanet_message_queue/home_message_
queue.html.

NOTE The message-driven bean functionality in iPlanet Application Server
is meant for developer use only. It has not been tested or certified for
production environments.
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You can use iMQ for Java, 2.0 SP1, which is supplied with iPlanet Application
Server, or use a third party product.

• To Configure iMQ for Java

• To Configure Third Party JMQ

To Configure iMQ for Java
Before starting the configuration of iMQ for Java 2.0 SP1, ensure that iPlanet
Message Queue for Java, 2.0 SP1 is installed on your machine.

Follow these steps to setup a JMS provider and a message queue to enable support
for message-driven beans:

1. Start iASAT.

2. Click the Messaging icon on the menu bar.

3. Click JMS Providers in the left pane.

4. Click Add in the right pane.

5. Enter the particulars for your environment.

All fields are mandatory. You need to specify the following:

❍ JMS Server Name

❍ JMS Server Host

❍ JMS Port Number
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❍ Initial Context Factory Class Name

This can be specified in terms of LDAP URL, filesystem path, etc.

❍ JMS ClassPath

❍ Naming Context Provider URL

❍ JMS Server User Name

❍ JMS Server User Password

The following figure shows a sample configuration:

6. Click OK to commit the changes.

7. Create an entry for the Queue in the directory server.

If you are using a filesystem context factory name, then specify the path to the
file.
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For information on creation an organizational Unit, see iPlanet Directory
Server 5.0 docuemntation.

8. Use the tools availablle with iMQ for Java 2.0 to create the Queue Connection
Factory object, QCF. in the directory server under ou=JMQ.

A sample file is shown below:

cmdtype=add

obj.type=qf

obj.lookupName=cn=QCF

objstore.attrs.java.naming.factory.initial=\com.sun.jndi.ldap.Ld
apCtxFactory

objstore.attrs.java.naming.provider.url=\ldap://border.india.sun
.com:389/ou=JMQ,o=NetscapeRoot

objstore.attrs.java.naming.security.principal=cn=Directory
Manager

objstore.attrs.java.naming.security.credentials=netscape

objstore.attrs.java.naming.security.authentication=simple
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9. Use iPlanet Console to ensure that the cn=QCF object in the directory has read,
compare and Search permissions.

Now that your JMS provider is configured you can start using message-driven
beans in your applications.

To Configure Third Party JMQ
Follow these steps to configure a third party Java messaging middleware. Ensure
that the message queue you plan to use, conforms to Chapter eight, “JMS
Application Server Facilities”, of the JMS specification.

Follow these steps to configure a third party JMS provider:

1. Manually create the Factory Context and configuration parameters in the
iPlanet Directory Server, under ou=JMQ,o=NetscapeRoot.

2. If you have already configured iPlanet Message Queue for Java 2.0, SP1, delete
the following iMQ specific entries from the iPlanet Registry:

❍ ServerHost

❍ ServerPort

❍ Username

❍ Password

These values are only valid for iPlanet Message Queue. Use the Factory
settings sepecified for your JMQ.

Administering Message Driven Beans
Message-driven beans can now be administered through the iPlanet Application
Server Administration Tool. You can change the properties of each individual
message-driven bean in a module.

To Administer Message Driven Beans
Follow these steps to modify the properties of a deployed message-driven bean:

1. Start iASAT.
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2. Click Application on the menu bar.

In the left pane all the deployed applications are displayed.

3. Select the message-driven bean you want to modify.

4. In the right pane, select MDBs tab.

The following dialog box will be displayed:

The following fields can be modified:

• MDB Name

• Enabled Flag

If the flag is disabled, KJS will not load the message-driven bean at startup.

• Destination Name

• Destination Type

Can be Queue or Topic.

• Acknowledgement Mode

• Max Message Limit
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• Max Pool Size

• Min Pool Size

• Durable Name

This property can be set for Topic Subscription only.

5. Click Apply Changes to commit the changes you have made.

6. Restart iPlanet Application Server to enable the changes.
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Chapter 12

Configuring Multiple Servers

This chapter describes how to configure multiple iPlanet Application Server
machines using iPlanet Application Server Administration Tool.

The following topics are included in this chapter:

• The Web Connector Plug-in in a Multiple-Server Enterprise

• Distributed Data Synchronization and Load Balancing

• Multicast Communication

The Web Connector Plug-in in a Multiple-Server
Enterprise

The Web Connector Plug-in directs users’ requests to applications on your iPlanet
Application Server machine. In a multiple-server enterprise, you can specify the
application server where the Web Connector Plug-in connects and logs web server
requests. The application server you specify is the default server where the web
connector exchanges requests and other application information. When the load
balancer plug-in of iPlanet Application Server does not specify an alternate
application server where application requests are forwarded, application requests
are sent only to this default server.

You can also specify the application server where the Web Connector Plug-in
sends the application request information for logging.

This section includes the following topics:

• Configuring the Web Connector Plug-in for Multiple Servers

• Specifying the Application Server Where Requests Are Sent



The Web Connector Plug-in in a Multiple-Server Enterprise

252 iPlanet Application Server Administrator’s Guide • October 2002

• Specifying the Application Server Responsible for Logging

Configuring the Web Connector Plug-in for
Multiple Servers
When you use multiple iPlanet Application Server machines to support your
enterprise application or applications, you must choose how to configure the web
server to forward requests to iPlanet Application Server. These configuration
options are provided by the Web Connector Plug-in. Use the configuration
scenarios described in the following table to help you decide how best to configure
the web connector plug-in for your enterprise:

Table 12-1 Configure the Web Connector for Multiple Servers

Configuration scenarios What to do

One web server supporting
multiple iPlanet
Application Server
machines without load
balancing

It is assumed that the application is partitioned. Configure
the web plug-in to forward requests to the application
server that hosts the application objects that process the
initial requests from the web browser. Use the other iPlanet
Application Server machines to host the application
components invoked by the objects on the first server.

Multiple web servers
supporting multiple
iPlanet Application Server
machines without load
balancing

If the application is not partitioned, configure each plug-in
to forward requests to each appropriate iPlanet Application
Server machine.

If the application is partitioned, configure each plug-in to
forward requests to an iPlanet Application Server machine
that hosts the components that process the initial web
browser requests. You can have multiple plug-ins connect
to a single iPlanet Application Server machine.

One web server supporting
multiple iPlanet
Application Server
machines with load
balancing

The load balancing plug-in forwards application requests
to the appropriate iPlanet Application Server machine.

As a default, configure the web connector plug-in to
forward requests to an iPlanet Application Server machine
that either performs the best or hosts the application
components that process the initial web browser requests.
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When you balance application loads, the web connector plug-in works with the
load balancer plug-in to automatically distribute requests across multiple iPlanet
Application Server machines. This prevents all requests from going to one iPlanet
Application Server machine.

If you are not balancing application loads, you must determine where a web server
forwards application requests.

Specifying the Application Server Where
Requests Are Sent
In a multiple application server enterprise, you can specify where the web
connector sends application requests.

If you have enabled load balancing, the load balancer plug-in first dictates where
the request is forwarded. However, if you have not configured the load balancer
plug-in to decide where to send the request, the web connector forwards the
request to the iPlanet Application Server machine you specify.

To specify the iPlanet Application Server machine to which the web server
connects, perform the following steps:

1. Start iPlanet Registry Editor.

The editor opens and displays the keys and values that apply to the iPlanet
Application Server instance.

2. Open the following key:

SOFTWARE\iPlanet\Aplication Server\6.5\CCSO\HTTPAPI\

3. Double-click the GXIP String value.

Multiple web servers
supporting multiple
iPlanet Application Server
machines with load
balancing

The load balancing plug-in forwards application requests
to the appropriate iPlanet Application Server machine.

As a default, configure the web connector plug-ins to
forward requests to each iPlanet Application Server
machine, or to the iPlanet Application Server machine that
either performs the best or hosts the application
components that process the initial web browser requests.

Table 12-1 Configure the Web Connector for Multiple Servers

Configuration scenarios What to do
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The Modify Value dialog box appears.

4. For the value data, enter the host IP address for the default iPlanet Application
Server machine.

5. Double-click the GXportNum DWORD value.

6. For the value data, enter the port number of the executive server process of the
same application server > click OK.

Specifying the Application Server Responsible
for Logging
In a multiple-server enterprise, you can specify the application server used for web
server logging.

In a single-server enterprise, the single server is the iPlanet Application Server
machine where the web connector forwards application requests by default. For
single-server enterprises, this value should not be changed.

In a multiple-server enterprise, the logging application server is the same server
where the web connector sends application requests by default

To specify the iPlanet Application Server machine responsible for logging, perform
the following steps:

1. Start iPlanet Registry Editor.

The editor displays the keys and values that apply to the application server.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCSO\HTTPLOG\

3. Double-click the Host String value.

The Modify Value dialog box appears.

4. For the value data, enter the host IP address for the application server you
want to perform web server logging and click OK.

5. Double-click the Port DWORD value.

6. For the value data, enter the port number for the Executive Server process of
the same application server and click OK.

7. Close iPlanet Registry Editor.
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Distributed Data Synchronization and Load
Balancing

When you create a multiple application server enterprise, you must decide if you
want to enable load balancing across those servers. Applications that are
distributed for load balancing might have dependencies on the distributed
synchronization service of the application server if those applications require state
and session management.

Distributed data synchronization is configured when you install iPlanet
Application Server. The installation script asks whether the server will participate
in distributed data synchronization, as well as the host name and port number of
the primary server.

Configuring a Distributed Data Synchronization
Environment
Once you install iPlanet Application Server on multiple machines, you must
update the cluster keys of the servers participating in distributed data
synchronization. This is done using the iPlanet Registry Editor.

Updating the keys of servers in a cluster ensures that each server has the same
information about the primary server, the immediate backups, and the priority in
which other servers might become a primary server in the event of a server failure.

Multicast Communication
In a multiple-server enterprise, application servers communicate with each other,
for purposes of load balancing and administration, using a multicast wide area
network (WAN) service. The multicast service provides a virtual server to which
all messages can be posted and distributed. The application servers use an N-Way
multicast configuration that allows each server to send or receive the broadcast
information. The following illustration shows how this network looks:
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Multicast services are handled by the network hardware for all servers within a
local area network (LAN). For these servers, you do not have to register or change
the default multicast address. When you are implementing an enterprise in a wide
area network, you should use a publicly registered multicast address that allows
only your iPlanet Application Server machines to communicate with each other.

How Multicast Services Apply to Load Balancing
For load balancing, you can have all servers communicate with each other, or you
can create islands of servers that only balance application loads between
themselves. For example, an application in New York does not need to load
balance with the same application in Los Angeles. However, an application in
Cupertino, Sunnyvale, and Santa Clara probably would share load responsibilities
for all the users in the San Jose area.

For load balancing, multicast communication is determined by the Executive
Server multicast address.

Local area network
multicast server

Wide area network
multicast server

iAS

Wide area network Local area network

iAS

iAS iAS
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Chapter 13

Administering Multi-Server
Applications

This chapter describes how to administer applications on multiple iPlanet
Application Server machines using iPlanet Application Server Administration Tool
(iASAT)

The following topics are included in this chapter:

• About iASAT

• Hosting Applications Locally on Multiple Servers

• Hosting Partitioned Applications on Multiple Servers

• Hosting and Deploying Applications for Load Balancing

• Changing Attributes of Distributed Application Components

About iASAT
iASAT allows you to simultaneously administer applications that are stored on
multiple servers. Settings made to application components, such as Enterprise Java
Beans (EJBs), distributed across multiple application servers are automatically
updated across those servers. In addition, settings made to one iPlanet Application
Server machine can be copied and applied to the other iPlanet Application Server
machines in a group or the entire enterprise.

Using the administration tool, you can view each iPlanet Application Server
machine in the enterprise and make changes to one or more servers at the same
time.

To host applications on multiple iPlanet Application Server machines, you can
perform either of the following tasks:
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• Distribute applications or parts of applications across two or more servers to
specialize request and application processing.

• Duplicate application components on two or more servers to increase
application performance with load balancing.

The more servers you have to work with, the greater your choice of application
hosting configurations.

The following table describes three common ways to host an application on
multiple iPlanet Application Server machines:

Hosting Applications Locally on Multiple Servers
Hosting applications locally on multiple servers is the simplest of the three most
common server configurations. In this configuration, you deploy the complete
application on each iPlanet Application Server machine. If the application is
already installed on an iPlanet Application Server machine, you can use the
Deployment Tool to deploy the application to other servers.

This configuration requires that you configure each web connector plug-in to
forward requests to the appropriate iPlanet Application Server machine.

Table 13-1 Ways to Host an Application on Multiple iPlanet Application Server Machines

Hosting configuration Description

Local The application is installed on each iPlanet Application
Server machine and uses multiple web servers to traffic
requests to each server. The iPlanet Application Server
machines do not communicate with each other.

Partitioned Parts of the application are hosted on different iPlanet
Application Server machines. Each server knows where the
application components of the application are hosted on
other servers and forwards requests to the appropriate
server.

Distributed for load
balancing

Parts or all of the application are duplicated on two or more
iPlanet Application Server machines. You can then
configure the servers to balance application-request loads.
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Alternatively, it is possible to deploy local applications across multiple iPlanet
Application Server instances while sharing a common web server and LDAP
server. This configuration functions much like the first example, except that there is
a single web server, and all iPlanet Application Server instances share a common
configuration through the same LDAP server. This configuration has the
advantage in that load balancing can be done across multiple iPlanet Application
Server instances whereas the prior example requires clients to access multiple
different web servers. While this scenario is possible, it may or may not be suitable
for your particular application.

Hosting Partitioned Applications on Multiple
Servers

To partition an application, you must divide up the application components that
make up an application. Application components are then hosted by separate
iPlanet Application Server machines. Partitioning applications allows you to
specialize the type of processing each iPlanet Application Server machine
performs.

Web servers iPlanet Application Server Database
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For example, servlets responsible primarily for data access are I/O-intensive, while
servlets responsible for performing calculations are CPU and active-memory
intensive. To maximize your application’s overall performance, you can partition
the application to host these different types of servlets on separate iPlanet
Application Server machines.

This section includes the following topics:

• Configuring a Partitioned Application

• Disabling and Enabling Application Components

Configuring a Partitioned Application
To configure a partitioned application, perform the following steps:

1. Deploy the complete application to all participating iPlanet Application Server
machines using the iPlanet Application Server Deployment Tool.

You can view the applications and associated modules deployed to each
registered iPlanet Application Server in the left pane of the Application
window. Expand a server to see the deployed applications and then expanding
an application folder to see the modules in an application.

For more information on application deployment, see the online help that is
provided with the Deployment Tool.

2. Enable load balancing, which will allow each server to find application
components hosted on other servers.

For more information on load balancing, see Chapter 14, “Balancing
User-Request Loads.

3. Disable specific application components on a server-by-server basis.

See Disabling and Enabling Application Components.

While partitioning application components, if you want to view the server(s)
where an application component is installed, perform the following steps:

1. Open the Application window of iASAT.

2. In the left pane of the Application window, expand the server whose
application components you want to partition.

3. Open an application folder and then highlight a servlet icon for J2EE
applications. For C++ applications, highlight an AppLogic icon .
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Deployed application components appear in the right pane of the Application
window.

a. Select an application component in the right pane of the Application
window.

b. Click the Servlet Component Properties (or Application Component
Properties).

A dialog box appears displaying the application servers where the
component is installed. If the selected iPlanet Application Server machine
is not listed, you must deploy the .ear file containing the necessary
application components to that machine.

c. Click OK to dismiss the dialog box.

Disabling and Enabling Application Components
Disabling a component of your application (such as a servlet) stops users from
accessing that component. Current requests are allowed to finish when a
component is disabled, but no new requests are accepted until the component is
re-enabled.

To disable an application component, perform the following steps:

1. On the iASAT toolbar, click Application to open the Application window.

2. In the left pane of the Application window, double-click the server where the
application component(s) to be disabled resides.

3. Expand the folder containing the application components to disable.

4. Expand the application folder to see the application modules.

5. Select the module that contains the application component(s) you want to
disable.

The right pane of the Application window shows each application component
within the module.

6. In the right pane of the Application window, locate the component to disable.

7. Locate the component(s) to disable and click the Enabled checkbox to clear the
checkbox.
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8. Click Toggle Enabled if you want to enable or disable (toggle) all the
application components in a group.

To enable application components, click their corresponding Enabled check
boxes to select them.
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7. Click Apply Changes to save your changes to your iPlanet Application Server
machine.

Hosting and Deploying Applications for Load
Balancing

Balancing application-request loads, or load balancing, differs from partitioning
applications. Load balancing requires you to place one or more copies of an
application component on multiple iPlanet Application Server machines rather
than simply dividing an application’s components among multiple servers (or
partitioning the application). You then configure each server, allowing it to find
application components on other servers.

CAUTION If the application is running in a clustered environment,
configured with a single directory server, disabling an
application component on one of the servers will disable it in all
the other servers also.

Follow these steps to disable application components running on
multiple servers in a cluster:

1. Click Application on the main menu of the Administration
Tool.

2. Select the application module from the left pane.

The application’s servlets will be displayed in the right pane.

3. Select the required servlet.

4. Click Servlet Component Properties.

The Application Component Properties window will
open with the list of servers the application is registered
with.

5. Select the server from which you want to disable the
component.

6. Click Remove.

The application component will now be removed from the
selected iPlanet Application Server.
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When you deploy an application, you must decide if you want to configure the
application for load balancing and, if so, how you will configure it. Choose among
the following load balancing configurations:

• Balancing loads only between the servers in a production environment, if
deploying to more than one iPlanet Application Server machine.

Example 1: You might have three iPlanet Application Server machines used for
testing applications. Your production environment, where users’ requests are
actually processed, also consists of three iPlanet Application Server machines.
Because the application components could be different between the two
groups of servers, you do not want to enable application load balancing.
Therefore, when you deploy an application from the test servers to the
production servers, you should choose only to balance the loads between the
destination servers.

• Balancing application loads between existing production servers and new
servers that you add to the enterprise.

Example 2: Suppose you scale the enterprise to include three more iPlanet
Application Server machines in the production group, you can join all the
servers in that group when deploying the applications from one of the existing
production servers to the new servers. The application loads are then balanced
between the existing servers and the new servers. (Scenario 2)

• Deploy the application locally to the server or servers (no load balancing).

The following illustration depicts a load-balancing distribution as discussed in the
Example 1:

iAS iAS iAS iAS iAS iAS

Test group Runtime group

Initial deployment from
iPlanet Application Builder
to test servers

Deployment from test
servers to runtime servers

Load balancing occurs discretely
within the test group

Load balancing occurs discretely
within the runtime group

Developer’s
Pack
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The next illustration depicts a joining of servers when adding new servers to a
group and deploying an application to those servers with the join option as
discussed in Example 2.

If you choose a local distribution during deployment, no application-request load
balancing occurs between any of the servers.

Changing Attributes of Distributed Application
Components

When you change such attributes as enabled sticky load balancing for an
application component that is distributed across multiple servers, those changes
replicate themselves on the servers where that component is hosted. Changing the
distribution level (local, distributed, and global) of installed application
components is useful if you previously installed an application locally, but now
want to distribute the application for load balancing. You can also disable load
balancing by changing a distributed application to a local configuration on the
specified server.

If you change a component from a distributed or global state to a local state on one
server, each server that hosts that component ceases to balance loads with the
server where the distribution was set to local.

Original servers

When deploying and joining the servers, load balancing occurs between the original
and the new servers

New servers

Deployment to new servers

iAS iAS iAS iAS iAS iAS
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For example, an application component called ShopCart is distributed across
servers A, B, and C. Should you decide to run ShopCart locally on server A, but
continue to allow it to run in a distributed state across servers B and C, each server
(A, B, and C) is automatically updated so that requests for ShopCart are no longer
passed to server A from servers B and C. Instead, requests for ShopCart made to
servers B or C are passed only between those two servers. All requests for
ShopCart made to server A are processed only by server A.

To change the distribution level for an application component, perform the
following steps:

1. Open the Application window of iASAT.

2. In the left pane of the Application window, expand the server for which you
want to change application settings.

3. Expand the application folder and select the servlet or AppLogic icon that
contains the application components you want to modify.

4. In the right pane of the Application window, select each application
component for which you want to change the distribution level as follows:

a. Local--The servlet or AppLogic runs on one iPlanet Application Server
machine only

b. Distributed--The servlet or AppLogic runs on specified iPlanet Application
Server machines

c. Global--The servlet or AppLogic runs anywhere in the enterprise.

5. In the Mode column, change the distribution level.
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❍ If you are changing the distribution level for all components in the selected
group, click Toggle Mode. All application components are updated
simultaneously.

❍ If you are modifying the Mode from Local to Distributed or Global, you
must modify the application properties to specify across which iPlanet
Application Server machines load balancing is to occur.

❍ If you are modifying the Mode from Distributed or Global to Local, there is
nothing more you need to do.

When you change an application component’s Mode to Distributed all
registered servers appearing in the left pane of the Application window
are added to that application component’s server list. You can access the
server list by clicking Application Component Properties.

6. In the left pane, under Registered Servers, choose which iPlanet Application
Server machines will participate in load balancing of the selected application
component. The application component must be installed on each iPlanet
Application Server machine participating in load balancing.

7. If you need to register additional application servers, go to the File menu and
choose New, then choose Server.

8. Repeat these steps for each application component.

9. Click Apply Changes to save your changes to the iPlanet Application Server
machine.
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Chapter 14

Balancing User-Request Loads

This chapter describes load balancing, which optimizes the ability of each iPlanet
Application Server to process users’ requests by keeping those requests balanced
among several iPlanet Application Server machines.

This chapter contains the following topics:

• How Load Balancing Works

• Requirements for Load Balancing

• What Is Sticky Load Balancing?

• Selecting a Load Balancing Method

• Per Component Response Time Load Balancing

• Per Server Response Time Load Balancing

• Round Robin Load Balancing

• User-Defined Criteria Load Balancing

How Load Balancing Works
The goal of load balancing is to evenly distribute the workload between multiple
iPlanet Application Server machines. When you use the iASAT to configure load
balancing, you want distribute user requests as optimally as possible.
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For example, if you find that many users access an application during peak usage
hours, you can duplicate the application’s components, such as AppLogics and
servlets, on several iPlanet Application Server machines and enable load balancing.
As one iPlanet Application Server machine reaches its optimal handling capacity,
subsequent requests are sent to another iPlanet Application Server machine with
duplicate application components. With requests evenly distributed between your
servers, you can decrease response time.

You can specify the load balancing method for an iPlanet Application Server
machine. The load balancing method you choose is either Web Connector Plug-in
driven or iPlanet Application Server driven.

• Web Connector Plug-in driven: The Web Connector Plug-in chooses which
iPlanet Application Server instance in which to send the request.

• iPlanet Application Server driven: Load balancing decisions are left to iPlanet
Application Server. Server and request statistics are collected and
communicated from one iPlanet Application Server machine to another in a
cluster via multicasting. For more information about multicasting, see Chapter
12, “Configuring Multiple Servers.

Requirements for Load Balancing
Before your application is load balanced, the following requirements must be met:

• The application’s components must be duplicated on at least two iPlanet
Application Server machines or on every iPlanet Application Server machine
that is to participate in load balancing.

• The distribution levels for the application components must be distributed for
either specific iPlanet Application Server machines or globally to all iPlanet
Application Server machines in the enterprise.

For information about enabling load balancing, see Hosting and Deploying
Applications for Load Balancing.
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What Is Sticky Load Balancing?
If requests within the same session are processed by more than one iPlanet
Application Server machine or process, session information that is not configured
to be distributed is lost. Therefore, certain application components are marked for
session or “sticky” load balancing and processed on the same server, thereby
eliminating the loss of session information.

When an application component is marked for sticky load balancing, it is
processed by the same iPlanet Application Server machine or processed where it is
initially invoked. For example, an application component called ShopCart is
duplicated on two application servers for load balancing, Server A and Server B. If
ShopCart is invoked by Client 1 on Server B, all subsequent sticky requests for that
ShopCart from Client 1 are processed on Server B only. In other words, ShopCart
“sticks” to Server B for the duration of Client 1’s session. However, at the same
time, Client 2 may access ShopCart on Server A without affecting Client 1’s use of
ShopCart on Server B. This maintains the integrity of state and session information
for an application component that does not distribute session information.

This section describes the following topics:

• When to Use Sticky Load Balancing

• Enabling Sticky Load Balancing

When to Use Sticky Load Balancing
Sticky load balancing is necessary for application components that have
interdependencies, but are running in a distributed environment. Such application
components typically have the following characteristics:

• Originally written to run on one machine

• Depends on session information to run properly

• Wrapped, not rewritten, to run in an iPlanet Application Server environment

For example, a heavily used, pre-existing application is ported to run on iPlanet
Application Server. Because the application is heavily used, it is distributed across
several iPlanet Application Server machines to increase availability. When a user
makes a request that invokes a sticky application component, the load-balancing
service determines which iPlanet Application Server machine should handle that
request. Once that server is chosen, all subsequent requests that use sticky
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application components are handled by that server. If that server becomes
burdened with many users’ requests, the load balancer forwards new requests to
another iPlanet Application Server machine and that server processes all new
session requests. This maintains an effective degree of load balancing.

Since session management in iPlanet Application Server 6.5 is optimized to work
well with stick applications, you must enable sticky load balancing with
distributed sessions:

• Improves performance by avoiding unnecessary session migration.

• Code optimized to handle concurrent requests on the same session, and on the
same JVM.

• Session failover is not affected by enabling the sticky flag.

Enabling Sticky Load Balancing
Enable sticky load balancing if there are multiple iPlanet Application Server
machines and certain application components cannot distribute session and state
information.

To enable sticky load balancing, perform the following steps:

1. On the iASAT toolbar, click Application to open the Application window.

2. In the left pane of the Application window, select the server where you want to
enable sticky load balancing.

3. Open the application group that contains the application component or
components for which you want to enable sticky load balancing.
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4. In the right pane of the Application window, select the application component
for which you want to enable sticky load balancing.

5. In the Sticky LB column, click the checkbox for the selected application
component.

Sticky load balancing is turned on for the selected component.

6. Repeat steps 4 and 5 for each application component where you want to enable
sticky load balancing.

7. Click Toggle Sticky LB to select or deselect all Sticky LB checkboxes.
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Sticky Load Balancing and Foreign Sticky
Cookies
Normally, a web connector can only dispatch requests to iPlanet Application
Server instances that are positioned specifically in iPlanet Registry.  For example,
requests for application components which are configured LOCAL will be
dispatched to the instance configured in the following iPlanet Registry key:

Software/iPlanet/Application Server/6.5/CCSO/HTTPAPI/GXIP

Requests for application components which are configured DISTRIBUTED can be
dispatched to any iPlanet Application Server instance that is delineated for the
target component, in the following iPlanet Registry key:

Software/iPlanet/Application Server/6.5/GDS/subtreemaps

In other words, potential instances must be deciphered from the web connector's
registry. However, there is a less obvious alternative for the web connector when
requests arrive with sticky cookies set.  When a web connector processes a request
with a sticky cookie, it dispatches the request based on the sticky targeting value.
It is possible, when configured correctly and intentionally, for a web connector to
properly dispatch requests for sticky targets of which it would unfamiliar.  For
instance, when a separate load balancing tier is in front of a set of application
servers, it is possible for a web connector to receive a sticky request for a target
application server which it has never had a connection to previously.  It is also
possible for the web connector to ignore the sticky targeting for instances of which
the web connector is not aware. The set of instances in which a web connector will
allow sticky targeting is decided depending on the instances that are part of the
same multicast group.

Selecting a Load Balancing Method
When configuring your server for load balancing, you must choose a load
balancing method. Each method provides a different way to decide “who” makes
the load balancing decisions. In other words, are load balancing decisions left to
the server itself or does the web connector plug-in make the decisions?

This section describes the following topics:

• Load Balancing with the Web Connector Plug-in

• Load Balancing with iPlanet Application Server
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Load Balancing with the Web Connector Plug-in
If load balancing is left to the web connector plug-in you can choose to load
balance:

• Per Component Response Time (Default)

The Web Connector Plug-in measures application component response time to
determine where to forward an application request. This is the default load
balancing choice.

• Per Server Response Time

The Web Connector Plug-in measures server response time to determine
where to forward an application request. This choice offers lower overhead
than Per Component Response Time.

• Round Robin

Requests distributed across servers based on a weighting scheme you specify

The plug-in distributes requests across iPlanet Application Server machines
according to the weights you specify. This load balancing option does not incur
overhead since it is based solely on the weights that you specify and data
collection regarding component or server response time is not required.

Load Balancing with iPlanet Application Server
If load balancing decisions are left to iPlanet Application Server, the application
server uses a combination of hardware resource profiles (including CPU load and
disk I/O) and Request Execution profiles (including result caching and servlet
execution rate) to load balance individual requests. Server and request statistics are
communicated from one iPlanet Application Server machine to another in a cluster
via multicasting. Multicasting gives more control to the administrator, and is
suitable for sophisticated scenarios.

NOTE You must restart the Web server (in addition to the application
server), after making any changes to the Web Connector Plug-in.

NOTE This is the most difficult load balancing method to setup and may or
may not result in increased performance. You should use this
method only after trying the Web Connector Plug-in driven
methods.
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Per Component Response Time Load Balancing
Per-component response time is based on a measure of an iPlanet Application
Server machine’s average response time for a specific application component.

The per-component method enables richer, more detailed load balancing decisions
by the Web Connector Plug-in. Keep in mind that this scenario involves a little
more overhead than the per-server method. The per-component method is best
suited to situations where one application component has a response time that
differs widely from server to server due to varying performance characteristics.

To enable per component response time load balancing, perform the following
steps:

1. On the iASAT toolbar, click Load Balancing to open the Load Balancing
window.

2. In the left pane, select the server for which you want to specify the load
balancing method.

3. In the Load Balancing drop-down box, choose Per Component Response Time
(Web Connector Plug-in Driven) to specify the web connector plug-in will
make load balancing decisions based on component response time statistics.
This is the default.

4. Click Apply Changes to save the settings.
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Per Server Response Time Load Balancing
Per-server response time is based on a measure of an iPlanet Application Server
machine’s average response time across all the application components that
machine processes.

The per-server method is best in situations where an application component has a
similar response time from server to server.

To enable per server response time load balancing, perform the following steps:

1. On the iASAT toolbar, click Load Balancing to open the Load Balancing
window.

2. In the left pane, select the server for which you want to specify the load
balancing method.

3. In the Load Balancing drop-down box, choose Per Server Response Time (Web
Connector Plug-in Driven) to specify the Web Connector Plug-in will make
load balancing decisions based on server response time statistics.

4. Click Apply Changes to save the settings.
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Round Robin Load Balancing
When you choose round robin load balancing method, you need to specify how
each iPlanet Application Server machine participating in round robin load
balancing is weighted. By default, this value is one (1) unless otherwise changed.
When all servers have equal weights, round robin load balancing will send equal
numbers of requests to each server. You should use a weighted system when you
have servers of unequal capacity. For example, if you have four machines of
differing performance characteristics participating round robin, you would
probably want to route more requests to the fastest machines. You do this by
assigning each iPlanet Application Server machine a weight. If you assign four
iPlanet Application Server machines weights of:

Machine 1 = 4

Machine 2 = 2

Machine 3 = 1

Machine 4 = 1

for every 8 requests, 4 requests will be routed to machine 1, 2 requests routed to
machine 2 and so on. For a fine-grain control over the number of requests, you may
want to think in terms of “how many requests out of 1000 should go to this server.
For example, specifying weights of 135, 270, and 595 would offer fine-grain
precision over the number of requests being sent to a server.

To setup round robin load balancing, perform the following steps.

1. Start iPlanet Registry Editor.

The editor opens and displays the keys and values that apply to iPlanet
Application Server.

2. Set the following key to 1.

SOFTWARE\iPlanet\Application Server\6.5\CCSO\Loadb\RoundRobin
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3. Highlight the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCSO\Loadb\ServerWeights

4. Choose Edit, then Add Value.

The Add Value dialog box opens

5. Enter the name (IP Address and port number), Value (weight) for each iPlanet
Application Server machines participating in round robin load balancing and
set the Type to Integer.
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For example, for three IPLANET APPLICATION SERVER machines with IP
addresses (of KXS) of:

a. 204.211.222.54:10818

b. 204.211.222.56:10819

c. 204.211.222.59:10820

assign the following values:

SOFTWARE\iPlanet\Application Server\6.5\CCSO\LoadB\ServerWeights

204.211.222.54:10818=3

204.211.222.56:10819=2

204.211.222.59:10820=1
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Under this weighting scheme, for every 6 requests the Web Connector Plug-in
will route three requests to port 10818, two requests to port 10819, and one
request to port 10820.

6. Save and close the editor.
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User-Defined Criteria Load Balancing
If you decide that iPlanet Application Server and not the web connector plug-in
will make the load-balancing decisions for your enterprise, the load-balancing
service then decides which iPlanet Application Server machine should process a
request based on the weight factors you specify for the Server Load and
Application Component Performance criteria. You set these factors using the
iASAT’s Load Balancing window. When determining weight factors, you must
decide how important each criteria is for keeping your applications running
optimally.

The weight factors in iASAT are initially set to default values based on the most
typical applications that run on an iPlanet Application Server machine. You can
adjust these factors for either Server Load criteria or Application Component
criteria to optimize your specific application.

This section describes the following topics:

• Adjusting Weight Factors for Server Load Criteria

• Adjusting Weight Factors for Application Component Performance Criteria

• Adjusting Update and Broadcast Intervals

• Changing the Multicast Host Address for Load Balancing

Adjusting Weight Factors for Server Load
Criteria
The Server Load value quantifies the load on an iPlanet Application Server
machine while the server is processing users’ requests. This value is calculated for
each iPlanet Application Server machine by the load-balancing service within the
respective server. You can adjust the weight factors for Server Load criteria to
optimize how application requests are distributed across multiple iPlanet
Application Server machines based on system resources.

The Server Load value is used as one of the criterion for calculating the Application
Component Performance value. The Server Load criteria are described in the
following table:
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Each Server Load criterion is multiplied with a weight factor you set. That value is
averaged with the other values to determine the final Server Load value. This value
is then used as one of the Application Component Performance criteria.

To adjust the weight factors for Server Load criteria, perform the following steps:

1. On the iASAT toolbar, click Load Balancing to open the Load Balancing
window.

2. In the left pane, select the server for which you want to adjust the weight
factors.

3. In the Load Balancing drop-down box, choose User Defined Criteria (iPlanet
Application Server Driven) to specify the server will make load balancing
decisions.

You can then adjust the weight factors as your enterprise requires. With the
Server LoadCriteria tab active, the following window appears:

Table 14-1 Server Load Balancing Criteria

Server load criteria Description

CPU Load The average percentage of time all processors in a
computer are in use.

Disk Input/Output The rate at which the system is issuing Read and Write
operations to the hard disk drive.

Memory Thrash The number of pages read from or written to the hard
disk drive to resolve memory references to pages that
were not in memory at the time of the reference.

Number of Requests Queued The number of user and application requests a server is
currently processing.

Server Response Time Average response time from a specific server for all
application components.
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4. In the right pane of the Load Balancing window, use the sliding scale markers
to adjust the weight factor for each criterion. For a description of the criterion
see,Adjusting Weight Factors for Server Load Criteria.

 The grand total of all weight factors must equal 100.

5. When finished, click Apply Changes to save the settings.

Adjusting Weight Factors for Application
Component Performance Criteria
The Application Component Performance value represents the performance of the
application components running on an iPlanet Application Server machine. This
value is calculated for each application component participating in load balancing.
Load balancing then occurs on an application component basis and increases
distribution.
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The Application Component Performance value includes five application criteria.
The load-balancing service compares iPlanet Application Server machines based
on the weight factor you assign for each application criterion. The server with the
highest total value is chosen to process requests for that application component.
The Application Component Performance criteria are described in the following
table:

Each application criterion is multiplied by a weight factor you set. Each value is
then averaged to determine the final Application Component Performance value.
The final value is used by the load-balancing service to determine which iPlanet
Application Server machine is best able to handle new users’ requests.

To adjust the weight factors for Application Component Performance criteria,
perform the following steps:

Table 14-2 Application Component Load Balancing Criteria

Application Component
Performance Criteria

Description

Server Load The value calculated for all Server Load criteria.

Cached Results Available A flag that signals whether the results of the
application component are cached. A user’s request is
typically processed faster when the application
component’s results are cached.

Lowest Average Execution Time The time with which an application component takes
to run on each iPlanet Application Server machine.

Most Recently Executed The server that most recently ran an application
component. The system on which the server is
running might have cached application data,
resulting in a faster execution time if that component
were to be run again soon.

Fewest Executions The number of times the application component ran
on an iPlanet Application Server machine. The goal of
load balancing is to equally distribute requests among
all servers in the enterprise. Therefore, the server that
has run the application component the least number
of times is most preferred.

Application Component
Response Time

Average response time from a specific server for a
specific application component.
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1. On the iASAT toolbar, click Load Balancing to open the Load Balancing
window.

2. In the left pane, select the server for which you want to adjust the weight
factors.

3. In the Load Balancing drop-down box, choose User Defined Criteria (iPlanet
Application Server Driven) to specify the server will make load balancing
decisions.

You can then adjust the weight factors as your enterprise requires.

4. Click the Application Component Criteria tab.

The following window appears:

5. In the right pane of the Load Balancing window, use the sliding scale markers
to adjust the weight factor for each criterion.
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 The grand total of all weight factors must equal 100.

6. When finished, click Apply Changes to save the settings.

Adjusting Update and Broadcast Intervals
You can set the time at which an iPlanet Application Server machine updates the
Server Load and Application Component Performance criteria. If these values
change frequently and drastically, it is useful to update the values often.
Unfortunately, you increase the amount of work the iPlanet Application Server
machine is doing by updating values frequently. You can save server resources by
increasing the time between updates if the criteria values do not change often.

This theory applies to setting the broadcast intervals, as well; if values are changing
often and drastically, the broadcast intervals should be short, updating servers
often. This increases network traffic load, so it is important to find an optimal
balance.

Broadcast and update intervals are relative to the Base Broadcast/Update Interval.
This is the interval at which the load-balancing service “wakes up” and performs
any updates, checks to see if any updates were received, and broadcasts any new
values.

Broadcast and update intervals that are even multiples of the base interval are
invoked when the load-balancing service “wakes up.” In other words, if the base
value is 300 seconds, and the Server Load and Application Component Criteria
broadcast intervals are at 900 seconds each, these values are broadcast every third
time the load-balancing service “wakes up.” The other two times the
load-balancing service awakens, it reevaluates the distribution order based on
whether it received any updates from other iPlanet Application Server machines.

You can set update and broadcast intervals for several entities, as described in the
following table:

Table 14-3 Broadcast Intervals

Set interval for Description

Base Broadcast/Update Interval The interval at which the load-balancing
service “wakes up.”

Application Component Criteria The interval at which the load-balancing
service broadcasts the Application
Component Performance value.
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To adjust the update and broadcast intervals, perform the following steps:

1. Click the Load Balancing on the iASAT toolbar to open Load Balancing
window.

2. In the left pane of the Load Balancing window, select the server for which you
want to adjust the advanced settings.

3. In the Load Balancing drop-down box, choose User Defined Criteria (iPlanet
Application Server Driven) to specify the server will make load balancing
decisions.

4. Click the Advanced Settings tab.

The following window appears:

Server Load Criteria The interval at which the load-balancing
service broadcasts the Server Load value.

Server Load The interval at which the load-balancing
service updates the Server Load value.

CPU Load The interval at which the load-balancing
service updates the CPU Load value.

Disk Input/Output The interval at which the load-balancing
service updates the Disk I/O value.

Memory Thrash The interval at which the load-balancing
service updates the Memory Thrash value.

Number of Requests Queued The interval at which the load-balancing
service updates the Number of Requests
Queued value.

Max Hops The maximum number of times a request is
allowed to be passed between servers.

Table 14-3 Broadcast Intervals (Continued)

Set interval for Description
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5. In the right pane of the Load Balancing window, under each interval
parameter, set the time as a multiple of the base time for that parameter.

6. In the Max Hops text area, specify the maximum number of times an
application component is passed between servers.

7. When finished, click Apply Changes to save your changes.

Changing the Multicast Host Address for Load
Balancing
Change the multicast server host address and port number to balance application
loads across networks, such as across cities. Within a network, the default address
does not need to be changed unless you are experiencing a conflict.

To change the multicast host address, perform the following steps:

1. Start iPlanet Registry Editor
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2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\GMS\KES

3. Double-click the MCastHost String value.

The String editor dialog box appears.

4. For the value data, specify the IP address for the new host and click OK.

5. Double-click the MCastPort DWORD value.

The DWORD editor dialog box appears.

6. For the value data, specify the port number for the new host and click OK.

7. Close the editor.

The new multicast address is in effect.
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Chapter 15

Managing Distributed Data
Synchronization

This chapter describes how to group iPlanet Application Server instances into
clusters that participate in data synchronization.

The following subjects are described in this chapter:

• About Distributed Data Synchronization

• How Failover Keeps Data Accessible

• What Is a Cluster?

• How a Cluster Communicates

• Configuring Clusters

• How Sync Server Prioritization Improves Coordination

About Distributed Data Synchronization
Distributed data synchronization maintains the integrity of shared state and
session information across multiple iPlanet Application Server instances. This is
crucial for partitioned and distributed applications that are hosted on multiple
iPlanet Application Server instances.

In most enterprises, several iPlanet Application Server instances support one or
more distributed applications. For such distributed applications to run
successfully, each server must have access to the relevant information for that
application, such as state and session information.
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Support for this distribution of information is provided through a system-level
distributed data synchronization service that is built into iPlanet Application
Server.

How Failover Keeps Data Accessible
The distributed data synchronizer is a system-level service that controls how
distributed data, such as application session information, is maintained and made
accessible across multiple iPlanet Application Server instances.

Each iPlanet Application Server instance is made up of the following four
“engines:”

• Administrative Server (KAS) – The Administrative Server brings up and
monitors the other engines and makes sure that any engines that fail are
brought up again.

• Executive Server (KXS) – Only an Executive Server can be the primary
synchronization engine (the synchronizer) for an iPlanet Application Server
cluster.

In a cluster of iPlanet Application Server instances, one of the Executive
Servers maintains the distributed (synchronized) information and sets up
server roles for all the other servers participating in the cluster. All engines in a
cluster know how to access this primary engine and the information that is on
this primary engine.

• Zero or more Java Servers (KJS)

• Zero or more C++ Servers (KCS)

If KJS or KCS fails, KAS simply restarts the failed engine. However, if KXS
fails, KAS performs the following actions:

❍ Brings KXS back up in the currently appropriate role. This role is
determined in synchronization with KXS engines in the cluster, and may
not necessarily be the role previously occupied.

❍ Brings down the KJS and KCS engines.

❍ Brings the KJS and KCS engines back up.
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What Is a Cluster?
A cluster is a group of iPlanet Application Server instances that share information
related to the state of individual user sessions. The primary benefit of using
clusters is to improve reliability, to continue user sessions even after process and
hardware failures. The secondary benefit is improved load distribution across all
available resources.

Servers in a cluster can belong to the same network or to different networks, or to
different subnets within the same network. While keeping the servers in a cluster
on a common subnet enhances performance, this is not necessary. Members in a
cluster communicate through TCP/IP, which uses the IP Addresses and port
numbers of the servers in the cluster, to access the KAS and the KXS engines of
each instance. As long as this communication takes place, the cluster will be
operable. See “Using Firewalls for Security,” on page 118, for more information on
how this communication takes place.

In a cluster, the state/session data is stored in the memory of the KXS process for
the Primary Sync Server. The configuration data of the cluster is stored in Directory
Server. All the iPlanet Application Server instances in your cluster can share a
single Directory Server; if the iPlanet Application Server instances in your cluster
do not share a single Directory Server, cluster settings must be copied from one
Directory Server to another so each server has access to identical cluster
information.

This section describes the following topics:

• Setting Up Data Synchronization

• Server Roles Within Clusters

Setting Up Data Synchronization
To set up data synchronization between servers, you need to decide the role that
you want a server to perform in the cluster. You can then edit each cluster entry to
set up the server roles and register the cluster with the synchronizer service.
Finally, you need to start each iPlanet Application Server in the order that is
determined by server roles.
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Server Roles Within Clusters
You can configure a server’s role within a cluster as either a Sync Alternate or a
Sync Local. The server that you start first becomes your Primary Sync Server and
the server that you start next becomes your Backup Sync Server. This goes on till
the number of backup servers you have defined have been started. If you have
defined 2 backup servers, then the 2 servers that you start after the Primary Sync
Server is started play the role of backup Sync Servers.

The next server that is started (once the defined number of backup servers have
been started), is your Sync Alternate. This server takes over if the Primary and the
backups fail.

See “Example: Coordination Within a Seven-Server Cluster, to learn more about
how servers in a cluster coordinate with each other, while performing the roles that
they have been assigned.

The roles that the servers in a cluster can perform are described in the following
table.

Table 15-1 Roles for Data Synchronization in a Cluster

Server role Description

Sync Server Any iPlanet Application Server instance can be identified as Sync
Primary. The Sync Server category contains the Sync Primary, Sync
Backups and Sync Alternates.

All Sync Servers are listed in the SyncServers key of iPlanet Registry.

Sync
Primary

The server that is the primary data store, with which all other cluster
members communicate for the latest distributed data information.

The first iPlanet Application Server to be started in a cluster must be a
Sync Server, and that Sync Server becomes the Sync Primary for the
cluster simply because it is started first.

Sync
Backup

Any number of Sync Servers, up to a maximum number (MaxBackups)
set by you, that mirrors the information on the Sync Primary. Because
each Sync Backup increases the load on the cluster, weigh safety against
performance impacts when deciding how many backups to assign.

If the Sync Primary becomes inaccessible, the Sync Backup with the
highest priority (which is the lowest integer value) relative to other Sync
Backups becomes the next Sync Primary.
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How a Cluster Communicates
Servers in a cluster need to communicate with each other. To enable this
communication, it is necessary that each server identifies with the cluster to which
it belongs. An iPlanet Application Server instance becomes an active part of a
cluster when you map its synchronizer to the cluster. This procedure is described
in Mapping the Synchronizer to the Cluster.

When an application component requests “write” access to a distributed data
source, the write occurs first on the Sync Primary. When the data changes on the
Sync Primary, the Sync Primary immediately updates the Sync Backups.

You can map the synchronizer for each iPlanet Application Server instance to only
one cluster at a time.

Sync
Alternate

A server listed in the SyncServers key in iPlanet Registry that is eligible
to become a Sync Backup. If the number of Sync Backups falls below the
set maximum, the Sync Alternate with the highest priority relative to
other Sync Alternates is promoted to Sync Backup.

Each Sync Alternate performs work similar to that of a Sync Local until
the Sync Alternate is promoted to Sync Backup.

Sync Local A server that uses data synchronization services, but is not eligible to
become a Sync Primary, Sync Backup, or Sync Alternate. Sync Locals can
use, create, and destroy all distributed data, but are never responsible for
maintaining that data.

Sync Locals are not listed in the SyncServers key in iPlanet Registry.
However, the SyncServers list in every registry in the cluster contains
identification and priority information for each of the Sync Servers in the
cluster.

Each Sync Local contacts each of the servers listed in its SyncServers
key in iPlanet Registry until the Sync Local finds the Sync Primary, at
which time the Sync Local becomes active in the cluster. If the Sync Local
goes through its entire SyncServers key in iPlanet Registry without
finding the Sync Primary, the Sync Local assumes that the cluster is
down, and acts as a local server.

Sync Locals communicate only with the Sync Primary, and the other
servers in the cluster are not aware of them.

Table 15-1 Roles for Data Synchronization in a Cluster

Server role Description
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Information Flow Within a Cluster
Sync Backups, Sync Alternates, and Sync Locals communicate with the Sync
Primary in a star configuration, as shown in the following illustration:

In this illustration, notice that all servers are communicating with the Sync
Primary. Also note that no Sync Local is assigned a priority number.

Note also that this illustration is an ideal representation of a cluster that has
probably just started and has not experienced failover, as the priority numbers
correspond gracefully to the currently assigned roles.

Configuring Clusters
You can set up and manage clusters using the iPlanet Application Server
Administration Tool (iASAT). iASAT is a stand-alone graphical user interface tool,
using which you can manage all the administrative aspects of iPlanet Application
Server. When you configure clusters using iASAT, the relevant back-end entries
are created in iPlanet Registry, which you can verify and edit.

You can also configure clusters directly in iPlanet Registry, using iPlanet Registry
Editor. However, it is recommended that iASAT be used to create and manage
clusters.

The following sections describe how to create and manage clusters, using both
iASAT and iPlanet Registry Editor.

Key

P = Sync Primary
B = Sync Backup

L

L

L
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L =  Sync Local
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A = Sync Alternate

1, 2, 3... = Priority
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• Configuring Clusters Using iASAT

• Configuring Clusters Using iPlanet Registry Editor

• Determining Sync Server Priority

• Setting Cluster Parameters

• Mapping the Synchronizer to the Cluster

Configuring Clusters Using iASAT
When you install iPlanet Application Server on your instance, your host server is
automatically taken as the default cluster, with a single node. You can add other
registered iPlanet Application Server instances to the existing cluster (your host
server), or create a new cluster, or create a completely new cluster.

This section describes the following topics:

• To Create a New Cluster

• To Add a Server to a Cluster

• To Remove a Server From a Cluster

To Create a New Cluster
To create a new cluster using iASAT, perform the following tasks:

1. In the iASAT toolbar, click General to open the General window.

2. From the left pane of the General window, select the iPlanet Application Server
instance with which you want to create a new cluster.

3. In the right pane of the General window, click the Cluster tab, as shown in the
following figure:

NOTE In iASAT, when you select and stop a particular server, the Stop
Server button apppears greyed out for all other servers too.
However, this does not mean that the other servers have stopped;
they will continue to run.

To stop any of the other servers in the cluster, go to the General tab,
select the server in the left pane, and click Stop Server.
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4. In the Cluster Name drop-down list, delete the default cluster name entry,
using either the Backspace or the Delete key.

5. Provide the name of the new cluster and press Enter. You can choose any
unique name for the new cluster.

6. Click Apply Changes. You need to start the server again for the new cluster
configuration to take effect.

When you restart the server, you can add other iPlanet Application Server
instances to the new cluster as described in the following section.

To Add a Server to a Cluster
To add an unassigned server to a cluster or to reassign a server to a different cluster
using iASAT, perform the following steps:

1. From the iASAT toolbar, click General to open the General window.

2. Click the Cluster tab.

The following window appears:
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A list of all registered servers is displayed in the left pane of the General
window. A list of the server(s) belonging to the existing cluster(s) is displayed
in the Priority List of Servers box, in the right pane of the General window.
These servers are sorted by their priority in a cluster.

The Priority List of Servers box also shows the cluster status of a server. Server
conditions can be Normal, Dual Primary or No Primary. Click the Refresh List
button to immediately update the Priority List of Servers box. By default, this
box is updated every 15 seconds.

3. In the left pane of the General window, click the name of the server you want
to add to a cluster.

4. From the Cluster Name drop-down box, select the name of the cluster to which
you want to add the server.

The Cluster Name drop-down list is populated with the cluster names to
which all registered servers belong.

5. Click Apply Changes.
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6. Stop and start every server in the cluster, including the server you just added.

To Remove a Server From a Cluster
To remove a server from a cluster, perform the following steps:

1. From the iASAT toolbar, click General to open the General window.

2. From the left pane of the General window, select an iPlanet Application Server
that is a member of the cluster from which you want to remove a server.

3. Click the Clusters tab in the right pane of the General window.

A list of all registered servers is displayed in the left pane of the General
window. A list of the server(s) belonging to the existing cluster(s) is displayed
in the Priority List of Servers box, in the right pane of the General window.

4. In the Cluster Name drop-down list, select the cluster from which you want to
remove a server. The Priority List of Servers box shows all the servers
belonging to the selected cluster.

5. In the Priority List of Servers box, select the server you want to delete and click
Remove from Cluster.

6. Click Apply Changes.

7. Stop and restart every server in the cluster, including the server you just
removed.

NOTE If you remove a server from a cluster and add it to another, you
need to restart all the servers in both clusters, for the change in
configuration to take effect.

NOTE • A server that is not a member of a cluster, hence not
participating in data synchronization, will be listed under
<hostname>-NoDsync, in the cluster list. You cannot remove
a server from the <hostname>-NoDsync list.

• If you want to rename a cluster, delete the cluster name in
the Clusters tab, in the General window of iASAT. Type a
new name for the cluster and click Apply Changes.
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Configuring Clusters Using iPlanet Registry
Editor
When you configure clusters using iASAT, the necessary back-end entries are
created in iPlanet Registry. You can directly create these entries in iPlanet Registry
and configure clusters, without using iASAT. Although this facility is available, it
is strongly recommended that you use iASAT to set up and manage your clusters.

This section describes the following topics:

• To Create a New Cluster

• To Add a Server to a Cluster

• To Remove a Server From a Cluster

To Create a New Cluster
When you install iPlanet Application Server, a default cluster is automatically
created, using the host server. The easiest way to set up and configure clusters is to
modify the back-end entries created in iPlanet Registry for this default cluster.

The default cluster bears the name <hostname>-NoDsync, where hostname is the
name of your local instance. For instance, if you install iPlanet Application Server
on a machine named Bozo, the default cluster entry will be named Bozo-NoDysnc.
The default values for this cluster are configured during iPlanet Application Server
installation. You can configure the existing default cluster, or configure a
completely new cluster, as described in the sections that follow.

To create a new cluster, perform the following tasks:

1. Start iPlanet Registry.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\Clusters\

3. From the Edit menu, choose Add Key. The Add Key dialog box appears, as
shown in the following figure:

NOTE Note that you can have multiple instances of iPlanet Application
Server on UNIX systems, each with its own iPlanet Registry. Ensure
that you edit the iPlanet Registry that belongs to the server instance
for you want to map the synchronizer.
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4. In the Key field, provide a name for the new cluster and press OK. A new
cluster is created. You now need to configure the cluster, as described in the
ensuing steps.

5. Select the new cluster that you created, and choose Add Value from the Edit
menu. The Add Value dialog box appears, as shown in the following figure:

When you add the required values to your cluster, make sure that the type for each
value is set to Integer. You can do this by selecting Integer from the Type
drop-down list, in the Add Value dialog box.

When you finish adding a value, click OK to confirm. To add another value, select
the new cluster you have created and choose Add Value from the Edit menu.

6. You need to add the following values to the new cluster:

❍ MaxBackups

This value indicates the maximum number of servers that can be assigned
as backup servers. The default value for this key is 0, however, when
configuring a cluster the value for MaxBackups should always be equal to
or greater than 1. If you do not specify a number for backup, your session
data will not be backed up. While not having a backup increases
performance, there is a trade-off with respect to reliability. We recommend
that you specify at least one backup server.

The maximum number of backup servers that you can specify is the total
number of servers in your cluster, minus one.
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❍ MaxSyncHeartBeat

This value specifies the maximum number of heartbeat messages that an
engine will send to any other engine. The heart-beat mechanism is used to
detect an abnormal cluster condition. The default value for this key is 10.

❍ SyncHeartBeatInterval

This value specifies the number of seconds between two heartbeat
messages sent from one server to another. The default value is 30.

❍ SyncTimerInterval

This key specifies the intervals, in seconds, at which the synchronization
service wakes up and checks to see whether any data has expired. This key
specifies how often the timer thread goes through the node list and
removes all the nodes that have expired. The default value is 30.

See Setting Cluster Parameters, for more information on configuring these
values for best results.

7. When you finish adding these values, select the new cluster key and choose
Add Key from the Edit menu.

8. In the AddKey dialog box that appears, type SyncServers.

This creates a folder called SyncServers under the new cluster key that you
have created. When you add servers to your cluster, you will need to add them
under this key.

Your new cluster is created and configured. You can now add servers to your
cluster, as described in the next section.

Adding a Server to a Cluster
To add servers to a cluster, perform the following tasks:

1. Start iPlanet Registry.

NOTE A key named MaxHops is automatically configured below the
MaxBackups key when you create a new cluster using
iASAT. This key relates to an unsupported feature. If you
create clusters using iPlanet Registry Editor, you need not
create an entry for this key.
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2. Open the following key:

SOFTWARE\iPlanet\Application
Server\Clusters\<clustername>\SyncServers

3. From the Edit menu, choose Add Value. The Add Value dialog box appears, as
shown in the following figure:

4. In the Name text field, provide the IP Address of the instance which you want
to add to the cluster. Type a colon (:) after the IP Address and enter the KXS
port number, as shown in the following example:

host IP address:KXS port number

Your entry should look like this.

129.158.228.63:10800

5. In the Value text field, provide a value that indicates server priority in the
cluster. For example, 0 indicates the highest priority and 1 indicates the next
level of priority. The lowest priority value is 65,535.

6. Select Integer from the Type drop-down list and click OK to register your entry
in iPlanet Registry.

You can now continue to add more servers to your cluster. When you finish adding
servers to your cluster, you need to map the servers to the cluster to which they
belong. See Mapping the Synchronizer to the Cluster.

NOTE Note that you can have multiple instances of iPlanet Application
Server on UNIX systems, each with its own iPlanet Registry.
Ensure that you edit the iPlanet Registry that belongs to the
server instance for which you want to map the synchronizer.
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To Remove a Server From a Cluster
You can remove a server from a cluster that you have added, by deleting the
server’s IP Address entry from the SyncServers key.

To remove a server from a cluster using iPlanet Registry Editor, perform the
following tasks:

1. Start iPlanet Registry.

2. Open the following key:

SOFTWARE\iPlanet\Application
Server\Clusters\<clustername>\SyncServers

You will see the IP Address and port number entries of the servers that have
been added to the cluster.

3. To remove a server, select the required IP Address entry and choose Delete
from the Edit menu. Alternatively, you can select the required entry and press
the Delete key.

4. You will be prompted to confirm the action. Click Yes to confirm. The server is
removed from the cluster.

NOTE Note that you can have multiple instances of iPlanet Application
Server on Solaris systems, each with its own iPlanet Registry.
Ensure that you edit the iPlanet Registry that belongs to the
server instance for you want to map the synchronizer.

NOTE • Note that you can add the server that you removed, again to
the same cluster, or to a different cluster. See To Add a
Server to a Cluster for more information.

• You can’t rename a cluster in iPlanet Registry. You will have
to delete the cluster name entry and create a new cluster
configuration. See To Create a New Cluster for more
information.
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Determining Sync Server Priority
You can set priority values to sync servers in a cluster. Priority values are used to
select between Sync Servers in the same status (either between a group of Sync
Backups or between a group of Sync Alternates). Only the order in which instances
of iPlanet Application Server are started, not priority, determines which server
should be the Sync Primary and which Sync Servers will start out as Sync Backups
or Sync Alternates.

You can set the sync server priority using either iASAT or iPlanet Registry Editor.

The following sections describe how you can assign or change priority to a sync
server:

• To Change Sync Server Priority Using iASAT

• To Change Sync Server Priority Using iPlanet Registry Editor

To Change Sync Server Priority Using iASAT
To assign a new Sync Server priority to a server that is in a cluster, perform the
following tasks:

1. From the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, click a server that is a member of the
cluster whose Sync Server priority you want to change.

3. In the right pane of the General window, click the Clusters tab. The following
window appears:
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A list of registered servers is displayed in the left pane of the General window.
Another list of servers, sorted by priority in a cluster, is displayed in the right
pane.

The list also shows the status of each server in the cluster. The status should
always be Normal. If an abnormal cluster condition exists, the status could be
Dual Primary or No Primary. To ensure that these conditions are corrected, see
Setting Cluster Parameters. To check for status, click the Refresh List button.
By default, server status is updated every 15 seconds.

4. In the Priority List of Servers box, click the name of the server whose Sync
Server priority you want to change.

5. To change the Sync Server priority of the server, click one of the following
buttons next to the Priority List of Servers box:

❍ Increase to assign a higher priority.

❍ Decrease to assign a lower priority.
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6. For example, if a server has a Sync Server priority of third in line to take over
for the Sync Primary, clicking Increase once changes the priority from third to
second. A lower number indicates higher priority. For example, 0 indicates the
highest priority and 1 indicates the next level of priority. The lowest priority
value is 65,535.

7. Click Apply Changes, when you complete reassigning priorities for the
server(s).

8. For changes in Sync Server priority to apply across a cluster, you must restart
each server so that all servers are aware of their new priority sequence, relative
to one another.

The changes you made in iASAT will be reflected in iPlanet Registry. You can
also change the sync server priority directly in iPlanet Registry. The next
section describes how you can do this.

To Change Sync Server Priority Using iPlanet Registry Editor
To change the sync server priority directly in iPlanet Registry using iPlanet
Registry Editor, perform the following tasks:

1. Start iPlanet Registry.

2. Open the following key:

SOFTWARE\iPlanet\Application
Server\Clusters\<clustername>\SyncServers

3. You will see the IP Address and port number entries of the servers that are
added to the cluster. Select the sync server whose priority you want to change.

4. Double-click the entry to open it, or, choose Modify
Value from the Edit menu. The Modify Value dialog box appears.

5. Change the value as required. Note that a lower value indicates higher
priority. For example, 0 indicates the highest priority and 1 indicates the next
level of priority. The lowest priority value is 65,535.

NOTE You can have multiple instances of iPlanet Application Server on
UNIX systems, each with its own iPlanet Registry. Ensure that
you edit the iPlanet Registry that belongs to the server instance
for you want to map the synchronizer.
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6. Restart every server in the cluster, including the one whose priority you just
changed. For changes in Sync Server priority to apply across a cluster, you
must restart each server so that all servers are aware of their new priority
sequence, relative to one another.

Setting Cluster Parameters
For a cluster to function efficiently, you need to set specific parameters that will
affect its performance. You can set these parameters using either iASAT or iPlanet
Registry Editor. The following sections describe how you can set cluster
parameters using either tool:

• To Set Cluster Parameters Using iASAT

• To Set Cluster Parameters Using iPlanet Registry Editor

To Set Cluster Parameters Using iASAT
You can set the following parameters for each cluster, using iASAT:

• Maximum Number of Sync Backups

You can specify the maximum number of Sync Backups the Sync Primary will
use. In clusters that have many servers, specifying the maximum number of
Sync Backups allows you to control how many servers are used as backups.

• Restart in case of abnormal cluster

You can also enable the process to restart if an abnormal cluster condition is
detected. An abnormal cluster condition is either a cluster that has more than
one iPlanet Application Server instances with the Sync Primary (dual-primary)
role or no iPlanet Application Server instances with the Sync Primary role.

To set cluster parameters using iASAT, perform the following steps:

1. From the iASAT toolbar, click General to open the General window.

2. In the left pane of the General window, select the iPlanet Application Server
that is a member of the cluster you want to modify.

3. In the right pane of the General window, click the Clusters tab. The following
window appears
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:

4. In the right pane of the General window, enter the maximum number of Sync
Backups allowed during a single cluster session in the Maximum Number of
Sync Backups text field.

5. Mark the Restart in case of abnormal cluster checkbox to correct any abnormal
cluster conditions that are detected.

Restart every server in the cluster. For changes to apply across a cluster, you must
restart each instance in the cluster, so that all the instances are aware of the
changes.

To Set Cluster Parameters Using iPlanet Registry Editor
To set cluster parameters using iPlanet Registry Editor, perform the following
steps:

1. Stop the server whose iPlanet Registry you want to edit.

NOTE You need to first register a server with iASAT, before you add the
server to a cluster.
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2. Start iPlanet Registry.

3. Open the following folder:

SOFTWARE\iPlanet\Application Server\Clusters\<clustername>\

In the given example, the default cluster is named bozo-NoDysnc and contains
one Sync Server with a priority of 1, as shown in the following figure:

4. Modify the following values under the <clustername> key, as required:

NOTE Editing the server registry while the server is running can cause
serious problems. Also, some changes take effect only after the
engine is recycled. It is strongly recommended that you stop all
application servers that belong to a cluster, before editing that
cluster’s settings.

NOTE You can have multiple instances of iPlanet Application Server on
UNIX systems, each with its own iPlanet Registry. Ensure that you
edit the iPlanet Registry that belongs to the server instance for you
want to map the synchronizer.
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• MaxBackups

The maximum number of backup data synchronization servers determines
how many Sync Backups are updated with data from the Sync Primary at the
same time. The default value for this key is 0, however, when configuring a
cluster the value for MaxBackups should always be equal to or greater than 1.
For more information about backup data synchronization servers, see What Is
a Cluster?.

As all Sync Backups are updated at the same time, an extra load is created for
each additional backup server when you increase the MaxBackups value.
Consider the performance impact when you set the number of backup servers,
and choose a number that is high enough to provide safety, while not so high
as to negatively affect performance. The default value of 1 is usually sufficient.

• MaxSyncHeartBeat

Check and modify the MaxSyncHeartBeat value as required.

This value specifies the maximum number of heartbeat messages that an
engine will send to any other engine. The heart-beat mechanism is used to
detect an abnormal cluster condition. The default value is 10.

Each heartbeat message consists of the:

❍ Host ID and port of the engine that sends the messages

❍ Role of the sender in the cluster

Whenever a heartbeat message is received, an iPlanet Application Server
engine will send back a response identifying its role in the cluster.

TIP To modify a value in iPlanet Registry, perform the following steps:

a. Double-click the key name or select the key and choose
Modify Value from the Edit menu, to bring up the Modify
Value dialog box.

b. Enter the new value in the dialog box.

c. Click OK to register the change in iPlanet Registry.

NOTE The next entry is the MaxHops key. This key relates to an
unsupported feature. You do not need to modify the value of this
key.
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A heartbeat starts when a Sync Backup server is promoted to a Sync Primary.
The new Sync Primary starts to send heart-beat messages to the original Sync
Primary engine. In the case of a temporary network failure, the two engines
will become Sync Primaries, thus creating a double-primary (split-primary)
abnormal condition. This condition can be automatically corrected.

• SyncHeartBeatInterval

Check and modify the SyncHeartBeatInteveral value as required.

This value specifies the number of seconds between two heartbeat messages
sent from one server to another. The default value is 30 seconds.

• SyncTimerInterval

Check and modify the SyncTimerInterval value as required.

This key specifies the intervals, in seconds, at which the synchronization
service wakes up and checks to see whether any data has expired. This key
specifies how often the timer thread goes through the node list and removes all
the nodes that have expired.

If this value is too large, expired data will still be accessible. If this value is too
small, the frequent waking up and checking can degrade system performance.
The default value of 60 seconds is good for most clusters.

5. Close iPlanet Registry Editor when you finish setting the values you want.

6. Restart all the servers that will be affected by the modifications.

After correctly completing these steps, you have redefined the default cluster.
Now, follow the procedure in “Mapping the Synchronizer to the Cluster” to enable
communication between the servers in the cluster

Mapping the Synchronizer to the Cluster
Each iPlanet Application Server has an inbuilt data synchronizer, which helps
synchronize the data within the server and also the server’s communication with
other servers.

NOTE You can also set cluster parameters using iASAT. See To Set Cluster
Parameters Using iASAT for more information.
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For a cluster to communicate, the synchronizer in each server must know to which
cluster the server belongs. If you create clusters using iASAT, the server
synchronizer is mapped automatically. If you create clusters manually, using
iPlanet Registry Editor, you need to perform the following tasks, to map the
synchronizer to its cluster:

1. Stop the server whose iPlanet Registry you want to edit.

2. Start iPlanet Registry.

3. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\CCS0\ClusterName\

The following window appears:

NOTE Please be noted that editing the server registry while the server is
running can cause serious problems. Also, some changes take
effect only after the engine is recycled. It is strongly
recommended that you stop all application servers that belong
to a cluster, before editing that cluster’s settings.

NOTE Note that you can have multiple instances of iPlanet Application
Server on UNIX systems, each with its own iPlanet Registry.
Ensure that you edit the iPlanet Registry that belongs to the
server instance for you want to map the synchronizer.
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4. The default cluster name will be listed. You can delete the default cluster name
and specify a new cluster name for the cluster.

5. Close iPlanet Registry.

6. Start the server whose synchronizer you just mapped.

The synchronizer is now be mapped to the cluster.

How Sync Server Prioritization Improves
Coordination

This section discusses general priority issues and gives a comprehensive example
of cluster coordination.

Priority values are used only to select between Sync Servers in the same status
(either between a group of Sync Backups or between a group of Sync Alternates).
Only the order in which instances of iPlanet Application Server are started, not
priority, determines which server should be the Sync Primary and which Sync
Servers will start out as Sync Backups or Sync Alternates.
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A Sync Local is not assigned a priority because it is not eligible to become a Sync
Server, so a Sync Local cannot become a Sync Primary, Sync Backup, or Sync
Alternate.

Which Sync Server becomes the Sync Primary in a cluster is determined simply by
which Sync Server is started first. The next Sync Servers that start, up to the value
in MaxBackups, become Sync Backups. When the Sync Primary fails, the Sync
Backup with the highest priority, which is the lowest integer value, becomes the
new Sync Primary.

When a Sync Backup becomes a Sync Primary, the number of Sync Backups falls
below the value of MaxBackups. To restore the number of Sync Backups, the Sync
Alternate with the highest priority becomes a Sync Backup.

Example: Coordination Within a Seven-Server
Cluster
The following example illustrates cluster coordination through server roles, and
the part that priority plays in determining those roles. As you trace the role
changes through the example, keep in mind that server fallibility has been
purposely exaggerated to provide many scenarios.

Although not required, you can ease cluster maintenance by assigning the highest
priority to the iPlanet Application Server instance that you will start as the Sync
Primary, and the next highest priorities (in descending order) to the Sync Backups.
Be aware that the cluster in this example does not do this. Also, notice that this
cluster does not follow the recommended practice of starting the servers in priority
order.

Assume a seven-server cluster with iPlanet Application Server instances that are
numbered 0 to 6. Servers 0 through 4 are Sync Servers that are assigned the same
priorities as their server numbers (for example, server 0 has a priority of zero).
Servers 5 and 6 are Sync Locals. MaxBackups for the cluster is set to 2.

• Server 3 is brought up first, so it becomes the Sync Primary.

• Server 4 is started next, and it becomes a Sync Backup.

• Server 6 is started next, and it is a Sync Local.

• Server 1 is started next, and it becomes a Sync Backup.

• Server 2 is started next, and it becomes a Sync Alternate.

• Server 5 is started next, and it is a Sync Local.
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• Server 0 is started next, and it becomes a Sync Alternate.

Server 3 fails and goes down. Between the two Sync Backups, server 4 and server 1,
server 1 has the higher priority (lower integer value) and it becomes the new Sync
Primary. This leaves server 4 as the only Sync Backup.

Because MaxBackups is set to 2, one of the Sync Alternates is converted to a Sync
Backup. Server 0 becomes the new Sync Backup because it has a higher priority
than the other remaining Sync Alternate, server 2. At this point:

• Server 1 is the Sync Primary.

• Servers 0 and 4 are Sync Backups.

• Server 2 is a Sync Alternate.

• Servers 5 and 6 are Sync Locals.

• Server 3 is off-line.

Server 3 comes back online. It becomes a Sync Alternate. Even though it was
originally a Sync Primary, the synchronizer now sees it as just another Sync Server,
so the server does not resume its Sync Primary role. At this point:

• Server 1 is the Sync Primary.

• Servers 0 and 4 are Sync Backups.

• Servers 2 and 3 are Sync Alternates.

• Servers 5 and 6 are Sync Locals.

Server 0 fails. Server 2 becomes a Sync Backup because it has the higher priority
(lower integer value) among the Sync Alternates. At this point:

• Server 1 is the Sync Primary.

• Servers 2 and 4 are Sync Backups.

• Server 3 is a Sync Alternate.

• Servers 5 and 6 are Sync Local servers.

• Server 0 is off-line.

Server 0 comes back online and becomes a Sync Alternate. Server 1, the Sync
Primary, fails. Among the Sync Backups, server 2 has a higher priority than server
4, so server 2 becomes the new Sync Primary. Server 0 becomes a Sync Backup. At
this point:

• Server 2 is the Sync Primary.
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• Servers 0 and 4 are Sync Backups.

• Server 3 is a Sync Alternate.

• Servers 5 and 6 are Sync Locals.

• Server 1 is off-line.

Server 2 fails. Server 0 becomes the Sync Primary and server 3 becomes a Sync
Backup. At this point:

• Server 0 is the Sync Primary.

• Servers 3 and 4 are Sync Backups.

• Servers 5 and 6 are Sync Locals.

• Servers 1 and 2 are off-line.

Server 3 fails. Even though only one Sync Backup remains, neither server 5 nor
server 6 is considered because neither is a Sync Server. At this point:

• Server 0 is the Sync Primary.

• Server 4 is a Sync Backup.

• Servers 5 and 6 are Sync Locals.

• Servers 1 and 2 and 3 are off-line.
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Chapter 16

Setting Up iPlanet Application Server
for Development

This chapter describes the tasks you need to perform, to set up iPlanet Application
Server for development purposes.

The following subjects are described in this chapter:

• Setting Up Class Paths

• Changing Heap Size For Java Engines

• Changing The Default Application Path

• Enabling Dynamic Class Reloading

• Specifying Session And Cache Timeout Values For J2EE Components

• Enabling RMI/IIOP Support

• Setting Environment Variables for Databases

Setting Up Class Paths
You may need to manually set up the iPlanet Application Server class path when
you want to do one of the following:

• when you enable RMI/IIOP access to EJBs.

• when you make a set of helper or framework classes available to all
applications deployed to a server.

To change the iPlanet Application Server class path, perform the following tasks:
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On Solaris
1. Navigate to the <iasinstall>/ias/env path and edit the Common

Environment script, iasenv.ksh. You can use a text editor to edit this file.

2. Search for and locate the ClassPath entry. You can either change the default
classpath or add a new classpath.

3. Restart the server for the change to take effect.

On Windows
1. Open iPlanet Registry Editor.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\Java\

3. Modify the class path and restart the server for the change to take effect.

Changing Heap Size For Java Engines
Default heap size for KJS is specified in the KJS script. If you want to enable KJS to
store more objects, you can change the heap size manually. For detailed description
on tuning Java heap, see iPlanet Application Server Performance and
Tuning Guide.

On Solaris
1. Go to <iasinstall>/ias/env and edit the KJS (Java Engine) startup script,

iasenv.ksh.

Locate the JAVA_ARGS entry and modify the existing minimum(-Xms) and
maximum (-Xmx) heap size specifications, as required.

2. Close all KJS processes and restart them, for the change in heap size to take
effect.

On Windows
1. Start iPlanet Registry Editor.
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2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\Java\

3. Modify the JavaArgs value and set the minimum heap size (-Xms <number>m)
and the maximum heap size (-Xmx<number>m) for Java engines.

Your heap size specification must look like this:

JavaArgs=-Xms16m -Xmx32m

4. Restart all kjs processes for the change to take effect.

Note that on Windows, the heap size for Java engines does not exist by default.

Changing The Default Application Path
Your applications are stored in the default application path, from where they are
picked up by DeployTool, to be deployed. You may want to change this path if, for
example, you want to store your applications in your server’s home directory. You
can change the default application through kregedit.

Before changing the default application path, you need to:

• create the new path on your machine or network and

• manually copy your application’s class files to this location.

After you create the path, you need to change the default class path in Iplanet
Registry. To do so, perform the following tasks:

1. Start iPlanet Registry Editor.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\

3. Edit the AppPath value and change the default application class path. See
“Setting Up Class Paths,” on page 319.

4. Restart the server for the change to take effect.

Enabling Dynamic Class Reloading
By default, dynamic class reloading is disabled in iPlanet Application Server. There
are two methods to enable dynamic class reloading.
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You can enable it by performing any one of the following tasks:

• Using iASAT

• Using Registry Editor

Using iASAT
1. Start iASAT.

2. Select the application server instance.

3. In the right pane, under Server, select Enable Dynamic Class Reloading.

Using Registry Editor
1. Start iPlanet Registry Editor.

2. Open the following key:

SOFTWARE\iPlanet\Application
Server\6.5\CCSO\SYSTEM_JAVA\Versioning

3. Set Disable=0. The default value is 1 which indicates that dynamic servlet
reloading has not been enabled.

4. Restart iPlanet Application Server for the change to take effect.

This change will enable dynamic reloading of servlet classes and registered JSPs
(those JSPs that have been assigned GUIDs and are listed as servlets in web.xml
files), and EJB implementation classes.

Specifying Session And Cache Timeout Values
For J2EE Components

When you deploy an application, session timeout values are set for the
applications’s J2EE components, such as JSPs, servlets and EJBs. These values
apply to all the J2EE components that run on your Web Server and Application
Servers.

You can specify session timeout values for individual J2EE components for each
application, on a need-basis. The value that you specify for an individual J2EE
component will override the default value set during deployment.
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Cache timeout values can be specified for servlets and JSPs. These are set to 0 by
default when an application is deployed.

You can use Deployment Tool to set these values too. See the Online Help
provided with Deployment Tool.

This section describes the following topics:

• To Set Session Timeout Value For JSPs And Servlets

• To Set Session Timeout Value For EJBs

• To Set Cache Timeout Settings For JSPs And Servlets

To Set Session Timeout Value For JSPs And
Servlets
For JSPs and Servlets, session timeout value can be set for each application. These
values are set by default during deployment. You can modify the session timeout
value, by performing the following tasks:

1. Start iPlanet Registry Editor.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\J2EE-Module\<module
name>\

If session timeout value has been specified already, you will see a key that
looks like this: session-timeout=(). If session timeout value has not been
specified, you can add it to the module.

3. Select the module for which you want to specify session timeout value.

4. Click Edit>Add Value.

5. In the Name field, specify a name, for example, Session-timeout.

6. In the Value field, specify a value, for example, 10. Note that the timeout value
is specified in minutes.

7. Set the type of the value to Integer.

8. Click OK to save your changes.

The session timeout value is set for the Servlets and JSPs that belong to your
application.
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To Set Session Timeout Value For EJBs
For EJBs, session timeout value is globally set using iASAT. See “To Specify EJB
Container Parameters for Run Time,” on page 139 for more information. The value
that is set through iASAT is applicable to all the EJBs that are deployed.

However, you can customize the session timeout value for each individual EJB, in
iPlanet Registry. To specify the session timeout value for an EJB, perform the
following tasks:

1. Start iPlanet Registry Editor.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\J2EE-Module\<module
name>\ejbs

You will see a string that looks like this:

<Beanhomename>=(18c06cf0-21dd-11d2094b6-0060083a5082)

The string within brackets is the GUID (Global Unique Identifier) that
identifies the EJB used in the selected application module. Make a note of this
GUID.

3. Navigate to SOFTWARE\iPlanet\Application Server\ClassDef\

This folder lists all the GUIDS that are attached to deployed applications.
Locate the GUID you want.

4. Expand the GUID key into its hierarchal tree.

5. Open the SessionDescriptor key. This key contains session timeout,
passivation timeout and other values that have been set for the EJB.

6. Modify the session timeout value and restart the server for the change to take
effect.

To Set Cache Timeout Settings For JSPs And
Servlets
The default cache timeout is the period for which servlets and JSPs are kept in the
cache before they are purged by the Web Server. The default cache time is set at the
time of deployment.

You can change the default cache timeout settings for JSPs and Servlets, per GUID.
To do so, perform the following tasks:
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1. Start iPlanet Registry Editor.

2. Open the following key:

SOFTWARE\iPlanet\Application Server\6.5\J2EE-Module\<module
name>\servlets\

You will see a GUID, which looks like this:

<module name>servlet=(1a488137-7510-1941-bae5-080020b90148)

Make a note of this GUID.

3. Navigate to SOFTWARE\iPlanet\Application Server\ClassDef\

This folder lists all the GUIDS that are attached to deployed applications.
Locate the GUID you want.

4. Select the GUID and click Edit>Add Key.

5. In the Name field, type Caching.

6. Create the following values under this key:

❍ Cache-Size (value in KB, type Integer)

❍ Cache-Timeout (value in seconds, type Integer)

❍ Cache-Option (value can be set as either Timeout-Create or
Timeout-Lastaccess, type String).

❍ Cache-Criteria (value that specifies appropriate cache criteria, type
String). See the Java Developer’s Guide for more information on cache
criteria.

7. Restart the server for the changes to take effect.

If your application uses JSPs, you will find the relevant GUID in the path described
in Step 2.

Enabling RMI/IIOP Support
iPlanet Application Server does not enable support for RMI/IIOP access to EJBs,
during installation. However, you can add an RMI/IIOP bridge process to the
iPlanet Application Server environment through iASAT.

To add an RMI/IIOP bridge process to the iPlanet Application Server environment
through iASAT, perform the following tasks:
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1. Start iASAT.

❍ On Solaris, go to <iASinstall>/ias/bin/ and type ksvradmin.

❍ On Windows, from the Start menu, choose Programs>iPlanet
Application Server and choose iAS Administration Tool.

2. Select the server for which you want to add a new RMI/IIOP process. Expand
the server to view the processes under it.

You should see at least one kjs and one kxs process. You need to now add a cxs
process, to enable RMI/IIOP process.

3. Click File>New. Choose Process.

4. Select cxs from the Process drop down list.

5. In the Port text field, enter a port number that is different from the port
numbers being used by the other processes.

6. In the IIOP Port text field, specify a port number for the IIOP bridge process.
The default IIOP port number is 9010. You can retain this port number if it does
not conflict with the other port numbers already in your system environment.

7. Click OK to register the cxs process. The cxs process is added to the iPlanet
Application Server machine.

8. Restart the server to activate the cxs process.

On Solaris, you can also check for the existence of the IIOP bridge process from the
command line. For example:

ps - ef |grep iiop

root 1153 1 0 17:00:15 ? 0:00 /bin/sh/usr/iPlanet/iAS6/bin/kjs -cset
CCSO - eng 3 - iiop - DORBinsPOrt=9010

Setting Environment Variables for Databases
Although system environment variables for databases are set during installation,
verify that they have not changed.

On Solaris, you can type env at the prompt, to verify the environment variables.
Review the list of environment variables. If a any variable in the system
environment is not set according to the guidelines provided here, change it to the
proper setting.
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Sybase
• For Bourne Shell:

DSQUERY=<sybase servername>; export DSQUERY

• For C Shell:

setenv DSQUERY <sybase servername>

Replace sybase servername with the name of the user’s Sybase server.

Oracle
• For Bourne Shell:

ORACLE_HOME=<oracle install directory>; export ORACLE_HOME

• For C Shell

setenv ORACLE_SID <oracle SID>

setenv ORACLE_HOME <oracle install directory>

DB2
• For Bourne Shell:

DB2INSTANCE=<db2instance>; export DB2INSTANCE

• For C Shell

setenv DB2INSTANCE <db2instance>

INFORMIX
• For Bourne Shell:

INFORMIXSERVER=<informixserver>; export INFORMIXSERVER

• For C Shell

setenv INFORMIXSERVER <informixserver>
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Adjusting Environment Size
After installation, if you notice any Administrative Server processes consuming
100% of your system resources, increase the size of the environment space on your
NT machine.  Edit the file Config.nt, found in the System32 directory of your
system root (normally C:\Winnt or C:\Winnt4) by adding the following line, and
then restart your machine:

SHELL=%systemroot%\system32\command.com /e:2048

If you still experience the problem after restarting your machine, try increasing the
environment size further by specifying /e:4096, instead of /e:2048, in the line
above.
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Appendix A

Troubleshooting

This appendix contains the following information about troubleshooting iPlanet
Application Server:

• Configuring the Class Path

• How Do I Configure the Number of Server-Side Connections?

Configuring the Class Path
When running applications, if the iPlanet Application Server Class Loader is
unable to find the AppLogic class file through the SYSTEM_JAVA parameter (the
registry parameter that contains both the CLASSPATH and GX_CLASSPATH
settings) in the registry, iPlanet Application Server hands the request over to the
Java Class Loader, which in turn reads the CLASSPATH environment variable to find
the class file. This allows AppLogics and servlets to execute even if the user class
path is not specified.

How Do I Configure the Number of Server-Side
Connections?
Once a global transaction is started on a thread, a connection is tied to that thread.
Therefore, when configuring the number of server-side connections, use the total
number of Java Server (KJS) threads in your enterprise.

For example, for Oracle databases, change the value of processes in the
initinstancename.ora file in the pfile directory of the Oracle server installation.



330 iPlanet Application Server Administrator’s Guide • October 2002



331

Glossary

Access Control Entries (ACEs) A hierarchy of rules which the web server uses to
evaluate incoming access requests.

Access Control List (ACL) A collection of ACEs. An ACL is a mechanism for
defining which users have access to your server. You can define ACL rules that are
specific to a particular file or directory, granting or denying access to one or more
users and groups.

admpw The username and password file for the Enterprise Administrator Server
superuser.

agent Software that runs the network-management software in a network device,
such as a router, host, or X terminal. See also intelligent agents.

authentication Allows client to verify that they are connected to an SSL-enabled
server, preventing another computer from impersonating the server or attempting
to appear SSL-enabled when it isn’t.

authorization The granting of access to an entire server or particular files and
directories on it. Authorization can be restricted by criteria including hostnames
and IP addresses.

browser See client.

cache A copy of original data that is stored locally. Cached data doesn’t have to
be retrieved from a remote server again when requested.

certification authority (CA) A third-party organization that issues digital files
used for encrypted transactions.
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certificate A nontransferable, nonforgeable, digital file issued from a third party
that both communicating parties already trust.

Certificate revocation list (CRL) CA list, provided by the CA, of all revoked
certificates.

Compromised key list (CKL) A list of key information about users who have
compromised keys. The CA also provides this list.

CGI Common Gateway Interface. An interface by which external programs
communicate with the HTTP server. Programs that are written to use CGI are
called CGI programs or CGI scripts. CGI programs handle forms or parse output
the server does not normally handle or parse.

chroot An additional root directory ypu can create to limit the server to
specific directories. You’d use this feature to safeguard an unprotected server.

cipher A cipher is a cryptographic algorithm (a mathematical function), used for
encryption or decryption.

ciphertext Information disguised by encryption, which only the intended
recipient can decrypt.

client Software, such as Netscape Navigator, used to request and view World
Wide Web material. Also known as a browser program.

client auth Client authentication.

collection A database that contains information about documents, such as word
list and file properties. Collections are used by the search function to retrieve
documents matching specified search criteria.

Common LogFile Format The format used by the server for entering information
into the access logs. The format is the same among all major servers, including the
iPlanet FastTrack and Enterprise servers.

connection group.

DHCP Dynamic Host Configuration Protocol. An Internet Proposed Standard
Protocol that allows a system to dynamically assign an IP address to individual
computers on a network.

daemon (Unix) A background process responsible for a particular system task.
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DNS Domain Name System. The system that machines on a network use to
associate standard IP addresses (such as 198.93.93.10) with hostnames (such as
www.netscape.com). Machines normally get this translated information from a
DNS server, or they look it up in tables maintained on their systems.

DNS alias A hostname that the DNS server knows points to a different
host—specifically a DNS CNAME record. Machines always have one real name,
but they can have one or more aliases. For example, an alias such as
www.yourdomain.domain might point to a real machine called
realthing.yourdomain.domain where the server currently exists.

document root A directory on the server machine that contains the files, images,
and data you want to present to users accessing the server.

drop word See stop word.

encryption The process of transforming information so it can’t be decrypted or
read by anyone but the intended recipient.

Administration Server A web-based server that contains the forms you use to
configure all of your iPlanet Web Servers.

expires header The expiration time of the returned document, specified by the
remote server.

extranet An extension of a company’s intranet onto the Internet, to allow
customers, suppliers, and remote workers access to the data.

fancy indexing A method of indexing that provides more information than
simple indexing. Fancy indexing displays a list of contents by name with file size,
last modification date, and an icon reflecting file type. Because of this, fancy
indexes might take longer than simple indexes for the client to load.

file extension The last part of a filename that typically defines the type of file. For
example, in the filename index.html the file extension is html.

file type The format of a given file. For example, a graphics file doesn’t have the
same file type as a text file. File types are usually identified by the file extension
(.gif or .html).
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firewall A network configuration, usually both hardware and software, that
protects networked computers within an organization from outside access.
Firewalls are commonly used to protect information such as a network’s email and
data files within a physical building or organization site.

flexible log format A format used by the server for entering information into the
access logs.

FORTEZZA An encryption system used by U.S. government agencies to manage
sensitive but unclassified information.

FTP File Transfer Protocol. An Internet protocol that allows files to be transferred
from one computer to another over a network.

GIF Graphics Interchange Format. A cross-platform image format originally
created by CompuServe. GIF files are usually much smaller in size than other
graphic file types (BMP, TIFF). GIF is one of the most common interchange
formats. GIF images are readily viewable on Unix, Microsoft Windows, and Apple
Macintosh systems.

hard restart The termination of a process or service and its subsequent restart.
See also soft restart.

home page A document that exists on the server and acts as a catalog or entry
point for the server’s contents. The location of this document is defined within the
server’s configuration files.

hostname A name for a machine in the form machine.domain.dom, which is
translated into an IP address. For example, www.iplanet.com is the machine www
in the subdomain iplanet and com domain.

HTML Hypertext Markup Language. A formatting language used for documents
on the World Wide Web. HTML files are plain text files with formatting codes that
tell browsers such as the Netscape Navigator how to display text, position graphics
and form items, and display links to other pages.

HTTP HyperText Transfer Protocol. The method for exchanging information
between HTTP servers and clients.

HTTP-NG The next generation of HyperText Transfer Protocol.
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HTTPD An abbreviation for the HTTP daemon or service, a program that serves
information using the HTTP protocol. The Netscape Enterprise Server is often
called an HTTPD.

HTTPS A secure version of HTTP, implemented using the Secure Sockets Layer,
SSL.

imagemap A process that makes areas of an image active, letting users navigate
and obtain information by clicking the different regions of the image with a mouse.
Imagemap can also refer to a CGI program called “imagemap,” which is used to
handle imagemap functionality in other HTTPD implementations.

inittab (Unix) A Unix file listing programs that need to be restarted if they stop
for any reason It ensures that a program runs continuously. Because of its location,
it is also called /etc/inittab. This file isn’t available on all Unix systems.

intelligent agent An object within a server that performs various requests (such
as HTTP, NNTP, SMTP, and FTP requests) on behalf of the user. In a sense, the
intelligent agent acts as a client to the server, making requests that the server
fulfills.

IP address Internet Protocol address. A set of numbers, separated by dots, that
specifies the actual location of a machine on the Internet (for example,
198.93.93.10).

ISDN Integrated Services Digital Network.

ISINDEX An HTML tag that turns on searching in the client. Documents can use
a network navigator’s capabilities to accept a search string and send it to the server
to access a searchable index without using forms. In order to use <ISINDEX>, you
must create a query handler.

ISMAP ISMAP is an extension to the IMG SRC tag used in an HTML document
to tell the server that the named image is an imagemap.

ISP Internet Service Provider. An organization that provides Internet
connectivity.

Java An object-oriented programming language created by Sun Microsystems
used to create real-time, interactive programs called applets.

JavaScript A compact, object-based scripting language for developing client and
server Internet applications.
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JavaServer Pages Extensions that enable all JavaServer page metafunctions,
including instantiation, initialization, destruction, access from other components,
and configuration management. JavaServer pages, are reusable Java applications
that run on a web server rather than in a web browser.

Java Servlets Extensions that enable all Java servlet metafunctions, including
instantiation, initialization, destruction, access from other components, and
configuration management. Java servlets are reusable Java applications that run on
a web server rather than in a web browser.

last-modified header The last modification time of the document file, returned in
the HTTP response from the server.

magnus.conf The main Enterprise Server configuration file. This file contains
global server configuration information (such as, port, security, and so on). This file
sets the values for variables that configure the server during initialization.
Enterprise Sever reads this file and executes the variable settings on startup. The
server does not read this file again until it is restarted, so you must restart the
server every time you make changes to this file.

MD5 A message digest algorithm by RSA Data Security. MD5 can be used to
produce a short digest of data that is unique with high probability. It is
mathematically extremely hard to produce a piece of data that produces the same
message digest email.

MD5 signature A message digest produced by the MD5 algorithm.

MIB Management Information Base.

MIME Multi-Purpose Internet Mail Extensions. An emerging standard for
multimedia email and messaging.

mime.types The MIME (Multi-purpose Internet Mail Extension) type
configuration file. This file maps file extensions to MIME types, to enable the server
to determine the type of content being requested. For example, requests for
resources with .html extensions indicate that the client is requesting an HTML file,
while requests for resources with .gif extensions indicate that the client is
requesting an image file in GIF format.

MTA Message Transfer Agent. You must define your server’s MTA Host to use
agent services on your server.
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iPlanet Console A Java application that provides server administrators with a
graphical interface for managing all iPlanet servers from one central location
anywhere within your enterprise network. From any installed instance of iPlanet
Console, you can see and access all the Netscape servers on your enterprise’s
network to which you have been granted access rights.

NIS (Unix) Network Information Service. A system of programs and data files
that Unix machines use to collect, collate, and share specific information about
machines, users, file systems, and network parameters throughout a network of
computers.

network management station (NMS) A machine users can use to remotely
manage a network. A managed device is anything that runs SNMP such as hosts,
routers, and iPlanet servers. An NMS is usually a powerful workstation with one
or more network management applications installed.

NNTP Network News Transfer Protocol for newsgroups. You must define your
news server host to use agent services on your server.

NSAPI See Server Plug-in API.

obj.conf The server’s object configuration file. This file contains additional
initialization information, settings for server customization, and instructions that
the server uses to process requests from clients (such as browsers). Enterprise
Server reads this file every time it processes a client request.

password file (Unix) A file on Unix machines that stores Unix user login names,
passwords, and user ID numbers. It is also known as /etc/passwd, because of
where it is kept.

primary document directory See document root.

protocol A set of rules that describes how devices on a network exchange
information.

private key The decryption key used in public-key encryption.

public key The encryption key used in public-key encryption.

public information directories (Unix) Directories not inside the document root
that are in a Unix user’s home directory, or directories that are under the user’s
control.
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Quality Feedback Agent An error-handling mechanism that enables you to
automatically send error information (stack and register dump) to iPlanet.

RAM Random access memory. The physical semiconductor-based memory in a
computer.

rc.2.d (Unix) A file on Unix machines that describes programs that are run when
the machine starts. This file is also called /etc/rc.2.d because of its location.

redirection A system by which clients accessing a particular URL are sent to a
different location, either on the same server or on a different server. This system is
useful if a resource has moved and you want the clients to use the new location
transparently. It’s also used to maintain the integrity of relative links when
directories are accessed without a trailing slash.

resource Any document (URL), directory, or program that the server can access
and send to a client that requests it.

RFC Request For Comments. Usually, procedures or standards documents
submitted to the Internet community. People can send comments on the
technologies before they become accepted standards.

root (Unix) The most privileged user on Unix machines. The root user has
complete access privileges to all files on the machine.

server daemon A process that, once running, listens for and accepts requests
from clients.

Server Plug-in API An extension that allows you to extend and/or customize the
core functionality of iPlanet servers and provide a scalable, efficient mechanism for
building interfaces between the HTTP server and back-end applications. Also
known as NSAPI.

server root A directory on the server machine dedicated to holding the server
program, configuration, maintenance, and information files.

simple index The opposite of fancy indexing—this type of directory listing
displays only the names of the files without any graphical elements.

SNMP Simple Network Management Protocol.
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SOCKS Firewall software that establishes a connection from inside a firewall to
the outside when direct connection would otherwise be prevented by the firewall
software or hardware (for example, the router configuration).

soft restart A way to restart the server that causes the server to internally restart,
that is, reread its configuration files. A soft restart sends the process the HUP signal
(signal number one). The process itself does not die, as it does in a hard restart.

SSL Secure Sockets Layer. A software library establishing a secure connection
between two parties (client and server) used to implement HTTPS, the secure
version of HTTP.

stop word A word identified to the search function as a word not to search on.
This typically includes such words as the, a, an, and. Also referred to as drop words.

strftime A function that converts a date and a time to a string. It’s used by the
server when appending trailers. strftime has a special format language for the
date and time that the server can use in a trailer to illustrate a file’s last-modified
date.

superuser (Unix) The most privileged user available on Unix machines (also
called root). The superuser has complete access privileges to all files on the
machine.

Sym-links (Unix) Abbreviation for symbolic links, which is a type of redirection
used by the Unix operating system. Sym-links let you create a pointer from one
part of your file system to an existing file or directory on another part of the file
system.

TCP/IP Transmission Control Protocol/Internet Protocol. The main network
protocol for the Internet and for enterprise (company) networks.

telnet A protocol where two machines on the network are connected to each
other and support terminal emulation for remote login.

timeout A specified time after which the server should give up trying to finish a
service routine that appears hung.

TLS Secure Sockets Layer. A software library establishing a secure connection
between two parties (client and server) used to implement HTTPS, the secure
version of HTTP.
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top (Unix) A program on some Unix systems that shows the current state of
system resource usage.

top-level domain authority The highest category of hostname classification,
usually signifying either the type of organization the domain is (for example, .com
is a company, .edu is an educational institution) or the country of its origin (for
example, .us is the United States, .jp is Japan, .au is Australia, .fi is Finland).

uid (Unix) A unique number associated with each user on a Unix system.

URI Uniform Resource Identifier. A file identifier that provides an additional
layer of security by using an abbreviated URL. The first part of the URL is
substituted with a URL mapping that hides the file’s full physical pathname from
the user. See also URL mapping.

URL Uniform Resource Locator. The addressing system used by the server and
the client to request documents. A URL is often called a location. The format of a
URL is protocol://machine:port/document.

A sample URL is http://www.netscape.com/index.html.

URL database repair A process that repairs and updates a URL database that has
been damaged by a software failure, a system crash, a disk breakdown, or a full file
system.

URL mapping The process of mapping a document directory’s physical
pathname to a user-defined alias so that files within the directory need only refer to
the directory’s alias instead of the file’s full physical pathname. Thus, instead of
identifying a file as usr/Netscape/SuiteSpot/docs/index.html, you could
identify the file as /myDocs/index.html. This provides additional security for a
server by eliminating the need for users to know the physical location of server
files.

web publishing The capability of server clients to access and manipulate server
files, editing and publishing documents remotely. Web publishing provides
document version control, link management, search, access control, and agent
services to server users.

web application A collection of servlets, JavaServer Pages, HTML documents,
and other web resources which might include image files, compressed archives,
and other data. A web application may be packaged into an archive (a WAR file) or exist
in an open directory structure.
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Web Application Archive (WAR) An archive file that contains a complete web
application in compressed form. iPlanet Web Server cannot access an application in
a WAR file. You must uncompress a web application (deploy it using the wdeploy
utility) before iPlanet Web Server can serve it.

Windows CGI (Windows NT) CGI programs written in a Windows-based
programming language such as Visual Basic.
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